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П Р Е Д Г О В О Р 

Ръководството за лабораторни упражнения по „Компютърно проектиране и симу-

лиране в електрониката“ е предназначено  за студенти обучаващи се в образователно-

квалификационната степен "Бакалавър” от специалност „Промишлена и  автомобилна 

електроника“ по дисциплината  „Компютърно проектиране и моделиране в електрони-

ката“ в ІІІ семестър, както и за дисциплината “Автоматизация на проектирането в елект-

рониката” за студенти от специалност "Електроника" в VІ семестър.  

В Ръководството са включени 10 лабораторни упражнения, като теоретичните 

части са разширени с цел обхващане на част от лекционния материал. Лабораторните 

упражнения са ориентирани изцяло към програмния продукт /ПП/ Altium 

Designer/Protel/ с цел овладяване на основните етапи и стъпки при проектирането на 

електронни устройства с помощта на персонални компютри и специализиран ECAD 

софтуер. Обхващат голяма част от курса лекции и са свързани със следната тематика:  

➢ Схемотехнично проектиране, симулация и експортиране на файлове в среда 

Altium Designer /AD/. Създаване на йерархични структури в AD.  

➢ Създаване на схемотехнични и конструктивни библиотечни елементи и библио-

теки. Особено внимание се отделя на конструктивните елементи за проектиране на пе-

чатни платки /PCB/ в 2D и 3D изглед с пълното използване на възможностите на AD. 

➢ Конструктивно проектиране на печатни платки с различна сложност с цел овла-

дяване на основните стъпки при проектиране на двуслойни и еднослойни печатни плат-

ки, ориентирани към машинна изработка и изработка чрез ситопечат. 

➢ Конструктивно документиране на електронно устройство в AD. 

➢ Проектиране и симулиране на електронни схеми с използване на SPICE модели. 

➢ Импорт и проектиране на печатни платки от други ECAD програми. 

Структурата на всяко лабораторно упражнение включва: теоретичен материал; цел 

на лабораторното упражнение; задачи на лабораторното упражнение; указания за из-

пълнение на задачите; схеми на проектираното електронно устройство и размерите на 

проектираната печатна платка. 

Ръководството за лабораторни упражнения  “Компютърно проектиране и симули-

ране в електрониката” може да бъде полезно и за студенти по сродни специалности от 

ТУ-Габрово и други технически университети, както и на специалисти и любители в об-

ластта на електрониката, проектиращи или произвеждащи електронни устройства с пе-

чатни платки. 

Допълнителни материали свързани с тематиката на лабораторните упражнения по 

дисциплината са систематизирани и достъпни за свободно ползване на адрес: 

http://dmoodle.tugab.bg/course/view.php?id=415  
Ръководството за лабораторни упражнения е част от разпространение на резулта-

тите по  проект BG05M2OP001-1.002-0023 - Център за компетентност „Интелигентни 

мехатронни, еко- и енергоспестяващи системи и технологии“.
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МЕТОДИЧЕСКИ УКАЗАНИЯ   

Всяка лабораторно упражнение се състои от четири етапа: 

- запознаване с теоретичната част – основни менюта, функции, команди, икони, 

горещи клавиши на използвания софтуерен продукт за постигане целта на лабораторно-

то упражнение и овладяване работата с продукта; 

- детайлно запознаване със схемата на проектираното електронно устройство с цел 

отразяване на конструктивните му особености при етапа на конструктивното проектира-

не и изготвянето на конструкторската документация; 

- самостоятелна работа при проектирането на електронното устройство с използва-

нето на персонален компютър, с предварително инсталиран и работещ софтуер с доста-

тъчна оперативна памет и дисково пространство. Особено внимание да се отдели на 

местоположението на отделните файлове на проекта, като се препоръчва да се работи в 

предварително създадена за целта директория; 

- проверка на изготвения конструктивен проект с цел откриване на евентуални 

грешки при отделните етапи на проектиране – схемотехнично, конструкционно и тех-

нологично. 

За Първият етап се препоръчва: 

1. Да се прегледа раздела от лекциите, който се отнася до даденото упражнение. 

2. Внимателно да се прочете теоретичната част, задачите за изпълнение и указани-

ята за последователността на изпълняваните операции на съответното лабораторно уп-

ражнение, особеностите на използвания програмен продукт и начина за работа. 

Подготовката за изпълнение на лабораторното упражнение може да се счита за-

вършена ако студентите са получили ясна представа за това което има да се извършва, 

как да се работи и какви резултати се очакват.  

За Вторият етап е необходимо: 

1. Да се провери за правилното разчитане на дадената схема за въвеждане, с разпоз-

наване на графичните символи за обозначение на отделните електронни елементи. При 

възникнали въпроси, ръководителят на упражнението е длъжен да даде недвусмислени 

разяснения за правилните означения на отделните елементи, особено когато те са нес-

тандартни. 

2. Предварително да се уточнят размерите на проектирана печатна платка, а така 

също специфични изисквания, като вътрешни и външни изрязвания за механично зак-

репване или поради наличието на обемни конструктивни елементи. 

3. Използвани са следните съкращения: ЛБМ – ляв бутон на мишката, ДБМ – де-

сен бутон на мишката, TAB – клавиш за табулация, Space bar - клавиш за интервал. 
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РЕЧНИК НА ИЗПОЛЗВАНИТЕ ТЕРМИНИ 
 

Компонент 

/Component/  

Компонент е физически електронен елемент, който се разполага на печатната платка, като 

например интегрална схема или резистор. В самия компонент може да имаме един или няколко 

елемента, които са в един корпус. 

3D модел 

/3D body / 

3D модела е обект с полигонална форма, който се добавя към компонентния отлечатък на 

корпуса /footprint/ в някой от механичните слоеве. Той може да се използва за дефиниране на 

физическите размери и форма на компонента в хоризонтална и вертикална проекция, като поз-

волява по-добро проверяване на разтоянията между компонента и останалите компоненти на 

печатната платка и по добра 3D визуализация. 3D модела играе ролята на референтна точка при 

импортиране на STEP модел в библиотечния отпечатък на корпуса или е обект който не се мон-

тира на печатната платка, например кутия или конструктивен възел. 

Означения 

/Designators/ 

Уникални идентификатори, които се използват за връзка между схемотехническия символ и 

корпуса на един и същ компонент в PCB. Те могат да са букви, цифри или комбинации от тях, 

но трябва да отговарят на стандартите. Печатните площадки /pads/ също имат уникални означе-

ния, които да отговарят на номера на изводите /pins/ на компонента. 

Компонентен 

отпечатък – 

„корпус“ 

/Footprint/ 

Компонентния отпечатък дефинира (или моделира) пространство за монтаж на компонента 

върху PCB. Моделите на „корпусите“ се съхраняват в PCB библиотеките. „Корпуса“ на компо-

нента може да съдържа контактни площадки за контактуване и запояване на изводите на ком-

понента и физическите му очертания, създадени от пътечки и/или дъги в слоя за т.нар. „бял 

печат“ - silkscreen (overlay). Присъединителните  части на компонента също се включват в не-

говите очертания върху печатната платка за да се резервира подходящо място.  

„Корпусите“ в PCB библиотеките нямат нито означения, нито коментари. Те се появяват до 

компонента след разполагането му на PCB. 

Скрити 

изводи 

/Hidden pins/ 

Изводи, които съществуват в компонента но няма нужда да се показват. Обикновено това са 

захранващите изводи, които се свързват към маса и захранващото положително напрежение 

автоматично при положение, че са зададени с подходящи етикети. 

Библиотека 

/Library/ 

Схемотехническата библиотека съдържа означения на компоненти или техни части съхране-

ни поотделно за поставяне в схемотехническия редактор. PCB библиотеката съдържа корпуси 

на компоненти за разполагане върху печатната платка. Всеки вид библиотека има повходящ 

редактор за създаване или модифициране на елементи от библиотеките. Интегрираните библи-

отеки се представят като отделен проект и съдържат елементи от двата вида, които се отнасят 

за един и същ компоненти, като го представят едновременно по отношение на схемотехничес-

кото му означение и корпуса му. 

Обект 

/Object/ 

Всяка индивидуална част която се разполата в простаранството на библиотечния редактор от 

набора с инструменти за чертане, за създаване на библиотечния елемент. 

Контактни 

площадки 

/Pads/ 

Контактните площадки се използват при компонентните отпечатъци – корпусите, като предс-

тавляват части от метализацията на печатната платка към които се запояват изводите на компо-

нентите. При дискретните елементи обикновено те са в два или повече слоя при многослойните 

платки, докато при SMD компонентите обикновено са само в един слой.  

Част 

/Part/ 

Колекция от графични обекти пресъздаващи една част от мулти-елементен компонент. Частта 

се съхранява в отделен лист в рамките на компонента в схемотехническата библиотека.  

Изводи 

/Pins/ 

Изводите на компонента определят електрическите му присъединявания в PCB редактора и 

определят точките на контакт към останалата част на схемата при схемотехническия редактор. 

Проходни от-

вори /Vias/ 

Метализирани отвори, които свързват отделните слоеве. Могат да бъдат директни – от горния 

до долния слой или разклонени – с помощта на междинен слой метализация.  
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №1 

СХЕМОТЕХНИЧНО ПРОЕКТИРАНЕ НА ЕЛЕКТРОННО УСТРОЙСТВО С 

НИСКА СТЕПЕН НА СЛОЖНОСТ С ДИСКРЕТНИ ЕЛЕМЕНТИ В СРЕДА 

ALTIUM DESIGNER. 

 

1. Теоретична обосновка.  
1.1. Въведение към Altium Designer. 

 Модерната инженерна практика предлага много и разнообразен специализиран 

софтуер за проектиране на електронни възли и устройства. Фирми производители на такъв 

софтуер са например: Altium Ltd., Cadence corp., Mentor Graphics, Design Spark, Labcenter 

Electronics (Proteus) и др.  

Продуктите разработени от тези фирми обединяват в себе си както функции за изгот-

вяне на електронни възли, устройства, печатни платки, така и за тяхната симулация. Също 

така дават добра възможност за триизмерно (3D) изготвяне и визуализиране на разработва-

ното от потребителя електронно изделие. Триизмерното изготвяне на електронни възли 

дава нов поглед при изготвянето им, защото разработчика може да добие реална и пълна 

представа за крайният вид на разработката. 

За овладяване на основните етапи при проектиране на електронен възел е избран 

специализираният софтуер на фирмата Altium Ltd. – Altium Designer /AD/17. Избрана е 

точно тази среда поради няколко причини: 

• Обединената среда на Altium дава всички необходими инструменти, с които можете 

да се възползвате за съвременните конструкторски решения; 

• Използваните средства за проектиране в средата са напълно интуитивни и лесни; 

• Голяма гъвкавост и насоченост към креативни средства и инструменти; 

• 15 дневен пробен период напълно безплатно. 

Минимални системни изисквания за работа с Altium Designer  са: 

• Windows 10 (64-bit only); Windows 8.1 (64-bit only) и Windows 7 SP1 (64-bit only) се 

поддържат, но не се препоръчват. 

• Intel® Core™ i5 processor или еквивалентен процесор; 

• 4 GByte RAM; 

• 10 GByte място на твърдия диск (Install + User Files); 

• Основен монитор с резолюция 2560x1440; 

• Препоръчително: втори монитор с резолюция 11280×1024 

• GeForce 200 series/Radeon HD 5000 series/Intel HD 4600 видео карта. 

 

1.2. Методика за схемотехнично проектиране на електронен възел. 

Проектирането на електронен възел се състои в няколко основни стъпки. Те са свър-

зани с избор на схема, нейното изчертаване, реализиране с компоненти и т.н., както под-

робно ще бъде разгледано в следващите точки. 
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1.2.1. Стартиране на Altium Designer. 

Софтуерът Altium Designer може да бъде стартиран по два различни начина. 

Първият е като се стартира от иконата намираща се на работният плот . Вторият 

начин е като се избере от меню Start → Programs → Altium → Altium Designer Release XX 

(фигура 3.1). 

1.2.2 Начален прозорец на 

Altium Designer. 

След стартирането на Altium 

Designer на екрана се отваря начал-

ният работен прозорец, представен 

на фигура 1.2. Той съдържа в себе 

си менюта за създаване или отва-

ряне на съществуващи документи, 

работа с библиотеките – разглеж-

дане, добавяне и премахване както 

и други функции. 

1.2.3 Обща методика за ра-

бота с електрически принципни 

схеми. 

Въвеждането на принципни схеми в AD е много повече от просто изчертаване на 

електрическите вериги. Принципните схеми съдържат информация за връзките между еле-

ментите и проводниците в една верига. 

Основата за изработване на схеми в AD се нарича чертожна страница (Design sheet). 

Електрическите и чертожни обекти се разполагат върху тази страница, за да се изработи 

работния чертеж на електрическата схема. При това, чертежът на цялата схема може да се 

изработи само на една страница, а може и да се състои от няколко отделни чертожни стра-

ници. 

За да започне изработката на принципна схема в нов чертожен проект, е необходимо 

първо да се създаде икона на проекта. За целта, от главното меню се избира File>New > 

Project, при което се отваря прозореца на новия проект. 

След като вече сте дефинирали проекта, можете да пристъпите към създаване на пър-

вия документ от него - електрическата схема на бъдещото устройство. Чрез използване на 

една от възможностите за създаване на нов документ може да се избере типът на документа, 

който ще се създава (в случая Schematic Document). След двукратно щракване върху избра-

ния тип, новият чертожен документ ще се появи като икона в навигационното дърво на 

Design Explorer. Изборът на новосъздадения документ води до отварянето му в чертожното 

поле със съответната рамка. Следва уточняване на параметрите на чертожната страница, 

разполагане на елементите в схемата, опроводяване, означаване на елементите, проверка за 

грешки, синхронизиране със частта за печатните платки и/или документиране. 

 

 
Фиг. 1.1 Стартиране на Altium Designer. 
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1.2.4 Създаване на нов проект. 

За да се реализира електронен модул трябва да бъде създаден проект, в който ще бъ-

дат въведени електрическата схема на възела и реализирането му в PCB вариант – платка. 

Създаването на проект става като от дясната колона с менюта на началният прозорец се из-

бере раздел „Projects” (Проекти) – фиг. 1.3. След като се отвори раздел „Projects” се отваря 

менюто, в което са визуализирани всички съществуващи проекти, ако има такива. 
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От бутон  се избира Add New Project → PCB Project – фигура 1.4. 

 

   
                     Фиг. 1.3 Меню „Projects”                         Фиг. 1.4a Създаване на PCB Project в AD. 

 

Фиг. 1.4б Създаване на PCB Project в AD. 

След създаването на проект в него трябва да се добавят файловете, с които ще бъде 

реализиран електронният възел. Това става като от бутон  се избере Add New To 

Project → Schematic и PCB – фигура 1.5. 
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След като са добавени нужните два 

файла към проекта, той трябва да бъде за-

паметен. Запаметяването става посредством 

натискане с десният бутон на мишката върху 

проекта и от падащото меню се избира Save 

Project – фигура 1.6. 

При първият избор за запаметяване 

Altium Designer отваря интерактивен прозо-

рец, в който се посочва папката където ще 

се съхранява проекта.  

Съответно след избора на папка в нея 

трябва да бъдат запаметени и останалите до-

кументи съдържащи се в проекта. Желател-

но е след започване на работа периодично 

да бъдат запаметявани всички работни фай-

лове. 

1.3. Електрически схемни чертожни обекти. 

Свързващ проводник - Wire 

Избор чрез инструментното меню Wiring Tools. Избор чрез главно меню:Place > Wire 

W'ire е обект, който формира електрическа връзка между точките в схемата. С този 

чертожен обект трябва да се изпълняват само електрически връзки. Във всички други слу-

чаи се използва чертожния обект Line. 

След избиране на Wire от инструментното меню или от главното меню, се влиза в ре-

жим на разполагане на електрическия обект. Курсорът се позиционира и посредством 

щракване с левия бутон на мишката 

или натискане на Enter се поставя 

началото на желаната връзка. С мес-

тене на мишката и натискане на ляв 

бутон или Enter се задава серия от 

последователни точки, които опис-

ват формата на свързващата линия. 

Валидни са няколко различни 

режима при разполагане на връзки: 

наклонена връзка, перпендикулярна 

връзка. 45-градусово начало и 45-

градусов край на линията. Режимът 

на изчертаване може да се сменя в процеса на разполагане на връзката, посредством еднок-

ратно натискане на Space bar. За да завършите с разполагането на връзката, можете да изпол-

звате ДБМ или клавиша Esc на клавиатурата. Натискането на клавиша TAB по време на 

разполагането дава достъп до характеристиките на разполагания обект. Характеристиките 

на вече разположен обект могат да се редактират след двукратно щракване върху него с 

ЛБМ. 

 
Фиг. 1.5. Добавяне на файлове към проекта. 

 
Фиг. 1.6. Съхранение на проект. 
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Фиг. 1.7 Свързващ проводник. Символ от инструменталното меню и разполагане на обекта в схемата. 

Всяка, вече създадена връзка, може да се редактира, след като бъде избрана с еднок-

ратно щракване с ЛБМ. 

В режим на редактиране могат да се изместват крайните точки на линията, както и да 

се премества цялата линия, без да се променя формата й. Ако щракването с ЛБМ е напра-

вено в крайна точка на линията, при преместване на курсора се променя положението само 

на тази точка, а ако щракването е в средна точка на линията - при преместване на курсора 

се премества цялата линия. 

Пресечна точка - Junction 

Избор чрез инструментното меню Wiring Tools 

Избор чрез главно меню: Place > Junction 

            
Фиг. 1.8 Пресечна точка. Символ от инструменталното меню и разполагане на обекта. 

Този електрически чертожен обект служи за обозначаване на наличието на физичес-

ки контакт между два или повече пресичащи се проводника. Пресечната точка се поставя 

автоматично, когато свързващ проводник (Wire) започва или завършва някъде по протеже-

нието на друг свързващ проводник. При пресичане на два свързващи проводника обаче 

пресечна точка не се поставя автоматично и трябва да се добави като отделен обект. 

При влизане в режим на разполагане чрез избор от инструментното меню или от 

главното меню, курсорът се позиционира и с щракване с ЛБМ или Enter, обектът се разпо-

лага на желаното място. Чрез щракване с ДБМ или натискане на клавиша Esc от клавиату-

рата, може да се излезе от режима на разполагане. Характеристиките на обекта могат да се 

редактират по време на разполагането с натискане на клавиша TAB от клавиатурата. Харак-

теристиките на вече разположена пресечна гочка могат да се редактират след двукратно 

щракване върху нея с ЛБМ. 

Елемент - Part 

Избор чрез инструментното меню Wiring Tools 

Избор чрез главно меню: Place > Part 
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Фиг. 1.9 Елемент. Символ от инструменталното меню и разполагане на обекта в схемата. 

Елементите са схемни символи, които изобразяват електронни компоненти каго ре-

зистори, интегрални схеми, транзистори и др. Техните характеристики са запазени в раз-

лични библиотеки за компоненти, работата с които ще бъде подробно разгледана в едно 

от следващите упражнения. 

След влизане в режим на разполагане на елемент, се появява диалогов прозорец за из-

бор на елемента и уточняване на характеристиките му. 

След уточняване на типа и означението на елемента, въведените настройки се пот-

върждават с ОК и курсорът се позиционира на желаното място в схемата. Ориентацията на 

елемента може да се сменя в процеса на разполагане с натискане на Space bar, а поставянето 

му в схемата става посредством щрак-

ване с ЛБМ или Enter. 

Поставянето на означение още 

при разполагането е особено удобно, 

когато многократно ще бъдат разпола-

гани елементи ог един и същ тип. При 

този случай, след като сте поставили 

означение на първия от тях (напр. R1), 

при всички останали елементи от съ-

щия тип. цифрата в означението авто-

матично ще се увеличава с единица 

(R2, R3, R4 и т. н.). Чрез щракване с 

ДБМ или натискане на клавиша Esc от 

клавиатурата, може да се излезе от ре-

жима на разполагане. 

Когато желаете да редактирате 

вече разположен елемент от схемата 

можете да го изберете чрез еднократно щракване върху него с ЛБМ. При това, около еле-

мента се появява ограждаща рамка, която включва неговото означение и текста за коментар. 

Последният може да се редактира като се променят неговата позиция спрямо тялото на 

елемента, големината и цвета на шрифта. За целта трябва да се щракне два пъти с ЛБМ 

върху означението или поясняващия текст, при което се отваря съответният диалогов про-

зорец за редактиране. 

Извод на захранващ източник - Power Port 

Избор чрез инструментното меню Wiring Tools  

 
Фиг. 1.10 Диалогов прозорец за избор на елемента и 

уточняване на характеристиките му. 
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Избор чрез главно меню: Place > Power Port 

                             

Фиг. 1.11 Извод на захранващ източник. Символ от инструментното меню и седемте достъпни 

схеми и означения. 

Това е електрически обект, който позволява лесно дефиниране на захранващите вери-

ги. За него са достъпни 11 различни схемни означения. При влизане в режим на разпола-

гане, обектът се движи заедно с курсора. С натискане на клавиша Space bar, в процеса на 

разполагане може да се променя ориентацията на порта, а посредством щракване с ЛБМ 

или Enter се фиксира положението му в схемата. С натискане на клавиша TAB по време на 

разполагането или с двукратно щракване на левия бутон върху вече разположен обект, мо-

гат да се редактират характеристиките му. Чрез щракване с десен бутон на мишката или на-

тискане на клавиша Esc от клавиатурата, може да се излезе от режима на разполагане. Вече 

разположен извод може да се премести с “влачене”, след избиране с еднократно щракване 

с левия бутон на мишката върху обекта. 

Достъп до различните схемни означения на този електрически чертожен обект може 

да се осигури и чрез менюто Power Objects. За целта е необходимо от главното меню да се 

избере: View > Toolbars > Power Objects. 

Забележка: Схемното означение, избрано за извод на захранващия източник, не опре-

деля типа на веригата, за която е предназначено. За да бъде определен този тип, е необхо-

димо да се зададе името на обекта в полето Net. 

1.4. Неелектрически схемни чертожни обекти. 

Освен електрически схемни обекти, в AD се използват и неелектрически обекти, кои-

то служат за добавяне на текст или графики към схемите. Те нямат електрически характе-

ристики и се игнорират при автоматичния преход към печатна платка на конструираното 

изделие. Неелектрическите чертожни обекти са включени в инструментното меню Drawing 

Tools. 

Коментар - Annotation 

Избор чрез инструментното меню Drawing Tools 

Избор чрез главно меню: Place > Annotation 

Този инструмент позволява разполагането на един ред свободен текст върху чертож-

ния лист. След като се влезе в режим на разполагане, е необходимо да се натисне клавиша 

TAB от клавиатурата, за да се активира диалоговият прозорец Properties, осигуряваш въз-

можност за редактиране характеристиките на обекта. В полето Text се въвежда желаният 

текст, а изборът на шрифта, неговият цвят, стил и големина може да се направи с натиска-

не на бутона Change, при което се появява нов диалогов прозорец - Font. 

Потвърждението на избора се осъществява с натискане на ОК. След като се затвори 

диалоговият прозорец Properties, курсорът се позиционира и коментарът се разполага в схе-

мата посредством щракване с ляв бутон или натискане на клавиша Enter от клавиатурата. 
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Чрез щракване с ДБМ или натискане на клавиша Esc може да се излезе от режима на раз-

полагане. 

                
Фиг. 1.12. Коментар. Символ от инструменталното меню и разполагане на обекта в схемата. 

Линия - Line 

Избор чрез инструмен гното меню Drawing Tools 

Избор чрез главно меню: Place > Drawing Tools > Line 

Този чертожен обект позволява изчертаването на начупена линия. 

След влизане в режим на разполагане, с ЛБМ или Еnter се разполага началната точка 

на линията. След това, премествайки курсора и потвърждавайки с ляво щракване, се разпо-

лагат последователно върховете на начупената линия. След като се постави и последната 

точка, линията се завършва с дясно щракване или Esc. 

               
Фиг. 1.13. Линия. Символ от инструменталното меню и разполагане на обекта в схемата. 

2. Цел на лабораторното упражнение. 

Запознаване с възможностите на Altium Designer за схемотехнично проекти-

ране на електронни схеми с дискретни елементи. Използване на основните елект-

рически схемни чертожни обекти. Работа с библиотеките Miscellaneous Device и 

Miscellaneous Connectors. 

 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципа на работа и елементите на унифицирана схема за 

контрол. 

3.2. Въвеждане на елементите от библиотеките в чертожното поле. Начини за 

разполагането им – въртене на 90 градуса и огледален образ. 

3.3. Опроводяване на елементите и проверка за изпълнение на чертожните пра-

вила. 

3.4. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 
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4. Указания. 
4.1. Въвеждане на електрическата схема на електронният възел.  

За примерна реализация на електронен възел е избрана унифицирана схема за конт-

рол [1], съдържаща дискретни елементи: 2 типа биполярни транзистори с различна мощ-

ност, резистори, неполярни и  електролитни кондензатори, светодиод, фотодиод и изпра-

вителен диод, както и четириизводен куплунг. Схемата за контрол е представена на фигура 

1.13. Тъй като транзисторите, българско производство, не са представени в библиотеките 

на AD, можем да използваме аналогични транзистори, представени с библиотеките или да 

изпорзваме универсалните означения за NPN и PNP биполярни транзистори, като конкре-

тизираме съответния корпус впоследствие, като имаме предвид разсейваната мощност от 

транзистора. Маломощните NPN транзистори заменяме с транзистор тип 2N3904, а PNP 

съответно с 2N3906, които са достъпни в библиотеката с дискретни елементи Miscellaneous 

Device.IntLib.  

Въвеждането на електрическата схема става във файла „Sheet1.SchDoc”. Въвеждането 

става като се изберат участващите елементи в електрическата схема от библиотеката с еле-

менти. Библиотеката с елементи се намира в дясната част на екрана (фигура 1.2).  

 
Фиг. 1.14. Схема на унифицирана схема за контрол. 

Списъкът с елементи, които ще бъдат използвани за реализирането на унифицирана 

схема за контрол са посочени в таблица 1 с наименованията в използваната библиотека на 

дискретни елементи с общо предназначение Miscellaneous Device, която по подразбиране се 

зарежда непосредствено след инсталирането на AD. 

Първо ще бъдат поставени транзисторите в схемата. Това става като в полето за тър-

сене се зададе типа на търсеният елемент. 

След като бъде открит се маркира с мишката и от бутона  елемент се 

поставя в работното поле. Това е представено на фигура 1.15. 
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Таблица 1.  Елементи използвани за реализиране на електронният възел. 

Означение на елемента Тип в библиотеката Брой елементи 

V3, V4, V5, V7, V10 2N3904 5 

V6 2N3906 1 

R1-R16 Res2 16 

C4 Cap 1 

V1 LED1 1 

V2 Photo Sen 1 

V12 Diode 1N4001 1 

V11 D Zener 1 

C2, C3, C5, C6, C7, C8, C9, C10 Cap Pol 2 1 

 

         
Фиг. 1.15. Поставяне на елемент в работното 

поле. 
Фиг. 1.16. Поставяне на куплунг в 

работното поле. 
Стъпките за поставяне на елемент са: 

1 – търсене на елемент;  

2 – избор на елемента от намерените резултати;  

3 – бутон за поставяне; поставяне в работното поле; 

4 – поставяне на елемента в работното поле. 

По тези стъпки се поставят останалите елементи от схемата.  

Поставянето на куплунг или присъединителни елементи се извършва по същия на-

чин, но се използва библиотеката Miscellaneous Connectors, която също е заредена по подраз-

биране. За да се смени библиотеката Miscellaneous Device.IntLib е необходимо да се щракне с 

мишката вдясно от библиотеката на бутона , който дава списъка от текущи библиотеки 

и да се избере новата библиотека Miscellaneous Connectors.IntLib. На фигура 1.18 е представено 

работното поле съдържащо всички елементи от схемата. Както се вижда от фигурата еле-
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ментите са разположени в правилната си подредба, но не са именувани и не са зададени 

техните стойности. Задаването на параметрите става с двукратно бързо щракване с ЛБМ 

върху елемента след което се отваря диалогов прозорец – фигура 1.19. За пример нека бъде 

взет единият от резисторите. След двукратно щракане и появяване на диалоговият прозо-

рец, в полето „Designator” (Обозначение) се задава обозначението на елемента. В полето 

„Value” се задава стойността на елемента. В случая трябва като обозначение да бъде дадено 

R1 и като стойност 82. Интерес представлява въртенето на елементите на 90 градуса по по-

сока на часовниковата стрелка. Това става възможно когато в режим на разполагане на еле-

мент натиснем клавиша Spacebar. 

 
Фиг. 1.17. Настройки на параметрите на елемент. 

Понякога това не е достатъчно – например при разполагането на транзистора V8 е 

необходимо той да се обърне огледално. Това става като в режим на разполагане на еле-

мента натиснем клавищ TAB от клавиатурата или при вече поставен елемент, щракаме с 

ДБМ върху него и избираме меню Properties. Там в секцията Graphical трябва да изберем 

Mirrored, както е показано на фиг.1.17. 

 
Фиг. 1.18. Разположение на елементите върху работното поле. 
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Аналогично се номерират останалите елементи и се задават техните стойности. Тряб-

ва да се съобрази да не се припокриват номерата на елементите, защото част от тях са с ед-

накви параметри. На фиг.1.18 е показан изглед на чертожното пространство с елементите 

от схемата. 

Следва означение и въвеждане на стойностите на елементите, които се извършват в 

екранния прозорец Properties на различните елементи, като означението на елемента в схе-

мата се въвежда в частта Designator, а стойността в часта Value, както е показано на фиг.1.19. 

 
Фиг. 1.19. Диалогов прозорец за въвеждане на означението и стойността на пасивен елемент. 

 

 
Фиг. 1.20. Разположение на означените елементи със стойности върху работното поле. 
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4.2. Опроводяване на елементите. 

След като елементите са разположени, именувани и са зададени стойности им се 

пристъпва към тяхното опроводяване. Опроводяването може да бъде започнато по два на-

чина. Първият е чрез щракане с левият бутон на мишката върху бутона  - „Place wire”. 

Вторият е като в работното поле се щракне с десния бутон на мишката и от падащото ме-

ню се избере Place → Wire. След като се избере единият от двата начина се преминава към 

опроводяването.  

                         
Фиг. 1.21. Опроводяване.                                    Фиг. 1.22. Опроводени елементи. 

След избирането на функцията „Place wire” маркера от стрелка се променя в кръст 

(фиг. 1.21), с който се извършва оп-

роводяването. Това се прави като се 

маркира извода на елемента, щрака 

се върху него с левият бутон на 

мишката или се натиска бутон 

„Enter” от клавиатурата за да започне 

опроводяването. След като започне 

проводника се разтегля до извода на 

елемента, с който ще бъде свързан – 

фиг. 1.21. След като бъде направена 

връзката „линията” свързваща еле-

ментите става солидна – фигура 1.22. 

По този начин се опроводяват всич-

ки елементи и се създава връзка 

между тях. Крайната опроводена 

схема е представена на фигура 1.26. 

1.2.6. Поставяне на надписи и допълнителни графични елементи. 

В схемата на устройството от фиг.1.14. фигурират указателни надписи на изводите на 

куплунга, с който платката трябва да се присъедини електрически към другите елементи в 

устройството. Начина на поставянето им в AD е чрез използването на набора елементи за 

                     
Фиг. 1.23. Начини за поставяне на кратка текстова 

информация в схемата. 
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чертане Drawing Tools, който е достъпен  чрез иконата   и от там  или от меню 

Place>Text String - фиг.1.23. 

След изпълнение на командата поставяме модифицирания маркер на мястото на кое-

то желаем и с еднократно щракване с ляв бутон на мишката или натискане на Enter поста-

вяме надписите фиг.1.24. Следва да ги модифицираме съгласно схемата от фиг.1.14. Пре-

къснатата линия, която показва екранировката на платката, се поставя като се използва инс-

трумента чертожна линия   от Drawing Tools или от Place> Drawing Tools>Line. Преди 

поставянето на линията правим настройки чрез бутона TAB, като избираме прекъсната ли-

ния, както е показано на фиг.1.25. Окончателния вид на изчертаната схема е показан на 

фиг.1.26. Изводите в екранировката се поставят чрез модификация на инструмента Пре-

сечна точка – Place>Manual Junction, като се избира Size – Small и Color – 3 (черен цвят). 

Номерацията на изводите се прави като се използва пак директивата Text String. 

 

                              
Фиг. 1.24. Поставяне на надписите на изходния куплунг. 

 

 
Фиг. 1.25. Поставяне на прекъсната линия. 
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Фиг. 1.26. Опроводена схема. 

4.3. Проверка на електронният възел (схемата) за грешки. 

След завършване на опроводяването между отделните елементи на електронният въ-

зел трябва да се направи проверка за тяхното правилно свързване, правилно наименование 

на елементите и други липси и пропуски, които би могло да бъдат пропуснати по време на 

изчертаването. По време на въвеждането на схемата по подразбиране е включена и действа 

функцията Online DRC (Design rules check), която следи за нарушаване на чертожните правила. 

Една от най-честите грешки които се допускат е дублиране в означенията на елементите, 

което е допуснато в схемата по отношение на С7. Както се вижда и двете означения на два-

та кондензатора в схемата от фиг.1.26 са подчертани от AD с червена вълнообразна линия 

за заостряне на вниманието. 

 
Фиг. 1.27. Прозорец със системни съобщения за грешки. 

Проверяването за грешки също се извършва от Project → Compile PCB Project. След 

избиране на проверката за грешки в системният прозорец за съобщения (фиг. 1.27) се из-

писва дали схемата има грешки и дали може да се продължи с изграждането и в платка 
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(PCB). Ако прозореца за системни съобщения не е на екрана, той се стартира като в долни-

ят десен ъгъл на работният екран се натисне бутон System → Messages. 

От прозореца се разбира кои са дублираните означения на елементи и кои са техните 

координати, както и дублиране по отношение на сварващите им проводници, което пречи 

за правилното опроводяване на печатната платка (PCB – Printed circuit board). За отстраняване 

на грешките преозначаваме по-близкия кондензатор до куплунга като С9. 

 
Фиг. 1.28. Опроводена схема с корекции. 

Окончателния вид на схемата с корекциите се вижда на фиг. 1.28. Както се вижда от 

прозореца със системни съобщения няма открити грешки, което позволява завършването 

на електронният възел. 

 
Фиг. 1.29. Прозорец със системни съобщения. 

 

4.4. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

След като сме въвели принципната схема в AD следващата стъпка е прехвърлянето на 

информация за изготвяне на печатната платка. За целта трябва да се създаде документ съ-

държащ PCB, както е показано на фиг.1.30. След създаването на документа, за да е достъпен 

от AD, трябва първо да се запише, както е показано на фиг.1.31. При това положение във 

файловата структура на проекта ще фигурират 2 файла - тип *.schdoc и *.pcbdoc. Това е 

условието за да се премине към прехвърлянето на информация от схемотехническата към 

конструкторската част на програмния продукт, чрез изпълнението на  Design>Update 

PCB Document – фиг.1.32. 
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Фиг. 1.30. Създаване на документ съдържащ печатна платка. 

    
         Фиг. 1.31. Съхранение на PCB документ.                     Фиг. 1.32. Прехвърляне на информация.                  

 

След изпълнението на командата се получава екранния прозорец от фиг.1.33, след ко-

ето се натиска бутона Validate Changes и се получава прозорец, подобен на този от фиг.1.34. 

Ако статусът на всички елементи и връзки е в зелено, т.е. нямаме грешки, натискаме бутона 

Execute Changes и на екрана до очертанията на печатната платка в черно се получават изоб-

ражения на корпусите на елементите от схемата и връзките между тях – фиг.1.35. Очерта-

нието в червено е т.н. Room – пространство което обединява елементите от една схема, така 

че чрез преместването му лесно да преместваме елементите от схемата. Тъй като в този 

проект тази функция няма да се използва, го изтриваме чрез еднократно щракване на миш-

ката върху него и натискане на бутона Delete от клавиатурата.  

 
Фиг. 1.33. Екранен прозорец с елементите на схемата. 
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Фиг. 1.34 Екранен прозорец с проверени елементи от схемата. 

 
Фиг. 1.35 PCB с очертанията на корпусите на елементите на схемата. 

   
Фиг. 1.36 PCB с очертанията на корпусите на елементите на схемата. 
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Следващата стъпка е ръчно разполагане на компонентите в очертанията на печатната 
платка. Важно е да няма компоненти, разположени на или много близо до ръбовете на 
платката, а така също да няма застъпващи се или много близо разположени компоненти. 
Начинът на разполагане на компонентите е много важен за конструирането и правилното 
функциониране на печатната платка.   

Важно е куплунгите да бъдат разположени близо до външните очертания на PCB, за 
да могат лесно да се опроводят, а светодиода и фотодиода трябва да са достъпни през кути-
ята на устройството – фиг.1.36. 

Има вариант те да се изведат на самата конструкция на кутията или на специален пулт 
и тогава, вместо самите компоненти, могат да се поставят двуизводни куплунги. При това 
положение трябва да се сменят моделите на отпечатъците на корпусите /footprint/ в частта 
Models на настройките /Properties/ от фиг.1.19, за съответните оптични компоненти.  

 
Фиг. 1.37. Настройки при автоматично опроводяване на PCB. 

След разполагане на елементите пристъпваме към опроводяване на печатната платка. 
Използваме режим на автоматично опроводяване, т.е. автоматично разполагане на печат-
ните проводници от частта на AD за автоматично трасиране /опроводяване/ наречена 
Situs.  

 
Фиг. 1.38. Екранен прозорец с информация при автоматично опроводяване. 

За да се извърши споменатото действие изпълняваме командата Route>Auto 
Route>All при което се появява екранния прозорец от фиг. 1.37. От там избираме Default 2 
Layer Board и натискаме бутона Route All. Екранния прозорец от фиг.1.38 изобразява меж-
динната информация, която се появява в процеса на автоматично опроводяване. Процесът 
завършва след като се получи съобщение за 100 процентово опроводяване – например 59 
of 59 connections routed (100,00 %) in 3 Seconds. 
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На фиг. 1.39 е представена опроводената печатна платка на разработваната схема като 

на монитора ще се изобразят в червено печатните проводници на горния слой /Top layer/, 

а в синьо печатните проводници от долния слой /Bottom layer/. В жълто ще са очертания-

та на компонентите и означенията им /Top overlay/, което представлява слоя на т.н. „бял“ 

или сервизен печат на печатната платка. Ако отделните компоненти имат 3D модели, гото-

вата печатна платка може да се разгледа и в 3D режим на изображение, достъпен чрез ко-

мандата View>3D Layout Mode. 

В заключение се препоръчва разработения проект да се съхрани като се щракне с ле-

вия бутон на мишката върху името на проекта в панела Projects и от контекстното меню се 

избере Save Project. За по голяма прегледност и улеснение в по-новите версии на AD може да 

се генерира архивен ZIP файл с използването на командата Projects Package от същото кон-

текстно меню. Тази функция е особено полезна при работа с флаш дискове или запис на 

сървър за облачни услуги, тъй като обединява всичките файлове на проекта в един архивен 

файл. 

 
Фиг. 1.39 Опроводена PCB на унифицираната схема за контрол.
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №2 

СХЕМОТЕХНИЧНО ПРОЕКТИРАНЕ НА ЕЛЕКТРОННО УСТРОЙСТВО С 

ВИСОКА СТЕПЕН НА СЛОЖНОСТ. РАБОТА СЪС СХЕМНИ БИБЛИОТЕКИ В 

ALTIUM DESIGNER 

 

1. Теоретична обосновка.  

 Схемните елемента се съхраняват в схемни библиотеки, които могат да бъдат за-

пазени или в чертожната база данни, или като външни файлове, наименувани с разширение 

.LIB. Доставените с AD схемни библиотеки са запазени в серия бази данни, разположени в 

директорията C:\Users\Public\Documents\Altium\ADХХ\Library. 

Елементните библиотеки можете периодично да се обновяват на адрес 

https://designcontent.live.altium.com/. 

Всеки схемен елемент съдържа една или повече съставни части, които представляват 

функционално завършено устройство. Интегралната схема 74LS00 например съдържа чети-

ри логически елемента, а кондензаторът има само една съставна част. 

Елементите са записани и модифицирани в Schematic Library Editor, независим докумен-

тен редактор, включващ инструменти за управление и редактиране на библиотеките. При 

работа с програмата е възможно да се отворят едновременно схемната страница и схемният 

библиотечен редактор. При това. елементът може да се премести директно в страницата, и да 

се редактира неговата информация в самия библиотечен източник. 

1.1. Добавяне или изтриване на библиотека от списъка на валидните библиотеки. 

За да се осигури достъп до елементите от дадена схемна библиотека, тя трябва първо 

да бъде добавена към списъка на валидните библиотеки в схемния редактор. 

Списъкът на валидните библиотеки може да се извика като се избере Browse Sch-

етикета на навигационното дърво, а в падащото меню Browse се посочи Libraries. (За да се 

осигури достъп до Browse Sch-етикета, е необходимо да има отворен схемен документ, не-

зависимо дали новосъздаден, или вече завършена принципна схема). Съдържанието на па-

нела ще се сменя в зависимост от съдържанието на текущия активен документ. Непосредст-

вено под падащото меню Browse се намира списъкът на достъпните библиотеки (фиг. 2.1). 

За да се добави дадена библиотека към списъка на валидните библиотеки, се натиска 

бутона Add/Remove разположен върху панела, или от главното меню се избира Design > 

Add/Remove Library. При това ще се о твори диалоговият прозорец Change Library File List, 

чрез който могат да се добавят или изтриват библиотеки от текущия файлов списък. 

За да се получи достъп до елементните библиотеки, е необходимо да се отвори под-

директорията Sch (Design Explorer/Library/Sch). 

От полето Files of Type могат да бъдат избрани два типа файлове - .LibPkg и .IntLib. 

Различието между двата типа се състои в това, че всеки файл с разширение . IntLib включ-

ва една единствена библиотека, докато файловете с разширение .LibPkg съдържат няколко 

библиотеки. 

https://designcontent.live.altium.com/
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С двукратно щракване с левия бутон на мишката или с еднократно щракване и натис-

кане на  бутона Libraries… към списъка на избраните библиотеки (полето Install) може да се 

включи произволна библиотека или база данни с електронни елементи – фиг.2.1. 

Изборът на посочените библиотеки се потвърждава с натискане на бутона Оpen, при 

което диалоговият прозорец Available Libraries се затваря, а избраните библиотеки се доба-

вят в списъка на достъпните. 

За да се изтрие библиотека от спи-

съка на валидните библиотеки, чрез бу-

тона Libraries… се отваря диалоговият 

прозорец Available Libraries. Oт полето 

Installed Libraries се избира излишната 

библиотека или база данни и се натиска 

бутона Remove. 

След като дадена библиотека бъде 

добавена, елементите от нея могат да се 

разполагат на схемния лист. Когато биб-

лиотеката се избере, в долната част на 

панела се появява списък на елементите, 

включени в нея, от който може да се по-

сочи и разположи желаният елемент. 

При това, графичният символ на избра-

ния елемент се появява под списъка на 

елементите. 

Елементът може да се разположи на чертожната страница по три разлпчни начина - 

посредством натискане на бутона Place, чрез избиране на Place > Part от главното меню 

или с натискане на иконата   /Place Part/ във Wiring Tools. 

Чрез бутона Tab може да се влезе в режим на редактиране на избрания елемент, преди 

неговото разполагане на чертожния лист. 

След като една или няколко библиотеки са добавени към активните библиотеки в 

списъчното поле, елементите включени в тези библиотеки, могат да се разглеждат в отде-

лен прозорец. За целта трябва да се натисне иконата  /Browse/ или от главното меню да 

се избере Design > Browse Library и да се отвори прозорецът Libraries. 

1.2. Търсене на компонент. 

AD включва възможност за претърсване на всички схемни библиотеки, с цел откри-

ването на определен елемент. За целта, при активирана схемна страница, се натиска буто-

нът Search в панела на схемните библиотеки или се избира Tools > Find Component, за да 

се отвори диалоговият прозорец Libraries Search(фиг. 2.2). В полето Value се задава означе-

нието на търсения елемент. В полето Operator е добре да се избере contains за да може да се 

търси в имена съдържащи написано във Value, тъй като различните производители изпол-

зват различни представки и наставки. При оператор equals, за да се елиминира това разли-

чие е добре при търсенето символът да бъде изписан по следния начин *4093*. 

 
Фиг. 2.1. В списъчното поле на панела Libraries се 

извежда списък на валидните библиотеки, както и 

на елементите от избраната библиотека. 
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В полето Scope, чрез избор 

от падащия прозорец, се задава 

обсегът на търсене. Достъпни са 

три възможности: Libraries on 

path (зададен път), Available 

Libraries (активирани библиоте-

ки), Path ( път на всички устройс-

тва). 

Ако търсенето не даде ре-

зултати, се проверява дали пътят 

(Path) е правилно зададен. (Опи-

тайте търсене на компонент, за 

който знаете, че съществува в да-

дена библиотека за да проверите 

дали всичко е настроено правил-

но.) 

След като се открие желаният компонент, съществува възможност за добавяне на биб-

лиотеката в която той се намира или ако е необходимо, елементът може първо да се редак-

тира и след това да се добави. 

1.3. Изтриване на компонент от схемна библиотека. 

За да се изтрие компонент от дадена библиотека, е необходимо файла на библиотека-
та да се отвори в Design Explorer, да се активира панела SCH Library, да се селектира ненуж-
ния компонент и с бутона Delete от панела да се изтрие. Друг начин е компонентът да се по-
сочи в списъчното меню с натискане на ляв бутон на мишката върху него и от главното 
меню се избира Tools > Remove Component. 

Обновяване на схемната страница след редактиране на библиотека 
След редактиране на компонент от дадена схемна библиотека, е необходимо ръчно да 

се обнови схемната страница, в която се използва редактираният компонент. Преди обно-
вяването е необходимо да се отворят всички схемни страници, в които е разположен редак-
тираният компонент. За да се осъществи обновяването, се натиска бутона Update Schematics 
Sheets в списъчното поле или се избира Tools > Update Schematics от главното меню. 

1.4. Доклади в режим на редактиране 

В режим на редактиране автоматично се изработват три доклада: 
При избор на Reports > Component се създава доклад, който съдържа описание на 

активния компонент - брой елементи, включени в неговата структура. номера на изводите и 
предназначение, име на групата към която принадлежи и т.н. Този доклад има разширение 
.СМР. При избор на Reports > Library List се създава доклад, който съдържа списък на 
компонентите в библиотеката и тяхното описание. Този доклад има разширение .REP. При 
избор на Reports > Library Report се създава доклад, който съдържа отново списък на 
компонентите в библиотеката и тяхното описание, но с разширение .Doc. При избор на 
Reports > Component Rule Check се отваря диалогов прозорец, който дава списък на въз-
можните сфери на компонентната проверка. Избират се атрибутите, за които да бъде нап-
равена проверка и се натиска бутонът ОК, в резултат на което ще се генерира доклад с раз-
ширение .ERR. извеждащ списък на компонентите, които нарушават зададените условия. 

Всички доклади се записват в същата директория, в която е съхранен проектът, по 
който работите в момента. 

 
Фиг. 2.2. Търсене на схемен компонент. 
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1.5. Добавяне на нови библиотеки в Altium Designer. 

От страницата на AD можете периодично да изтегляте и обновявате библиотеките. 
Обновяващите файлове са в ZIP-
формат и са дадени в списък, съгласно 
наименованието на фирмата произво-
дител на компонентите. След като из-
теглите и разархивирате съответния 
файл, с двукратно щракване върху 
иконата му можете да стартирате 
Design Explorer (фиг. 2.3). който ще 
ви позволи да разгледате новите ком-
поненти, включени в обновяващия 
файл. 

SchLib-файлът включва схемниге 
означения на новите компоненти. 
PcbLib-файлът съдържа новите ком-
понентни отпечатъци, които ще се до-
бавят към PCВ-библиотеката. SimLib-
файлът съдържа новите компоненти, 

които ще обогатят съществуващата симулационна библиотека. 
 

2. Цел на лабораторното упражнение. 
Усвояване на уменията за работа със схемотехничните библиотеки на Altium 

Designer за схемотехнично проектиране на електронни схеми с интегрални схеми. 
Търсене на схемотехничен библиотечен елемент. 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема и елементите на електронен 

метроном с цифрови интегрални схеми. 

3.2. Търсене на елементите от схемата в предварително заредените библиотеки.  

Работа със схемотехнични библиотеки. Търсене на елемент в директория със схемо-

технични библиотеки. 

 3.3. Опроводяване на елементите и ERC проверка. 

3.4. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

4. Указания. 
4.1. Запознаване с принципната електрическа схема и елементите на електронен 

метроном с цифрови интегрални схеми. 

Електронния възел с дискретни елементи и интегрални схеми, представен на фиг.2.4, 

представлява схема на електронен метроном, подробно описан в [2]. Схемата съдържа дис-

кретни елементи: 3  биполярни транзистора с различна мощност, 4 резистора, 4 неполярни 

и  2 електролитни кондензатора, 3 механични ключа и превключвателя. Използвани са 

цифрови интегрални схеми: 6 логически елемента тип NAND – ИС SN7400, брояч - ИС 

SN7490 и декодер – ИС SN7442. 

 
Фиг. 2.3. Компонентите от библиотечните фай-

лове могат да се разгледат в работния екран на Design 

Explorer. 
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Фиг. 2.4. Схема на електронен метроном. 

Тъй като превключвателите и ключа S1 не се монтират на печатна платка, то е умест-

но те да се заменят с куплунги с брой изводи, съответстващи на изводите им. Това важи и 

за високоговорителите ВА1 и ВА2. Тран-

зисторите VT2 и VТ3 са българско произ-

водство и липсват в библиотеките на AD. 

Поради тази причина се използват транзис-

торите от библиотеката с дискретни еле-

менти Miscellaneous Device.IntLib, като се 

преименуват. Пасивните елементи се нами-

рат в същата библиотека. Куплунгите за 

превключвателите и ключа се намират от 

библиотеката Miscellaneous 

Connectors.IntLib. Новия елемент се явява 

потенциометъра RP, който се поставя от 

библиотеката Miscellaneous Device.IntLib 

като библиотечен елемент RPot, независимо от факта, че не съответства на стандартното 

обозначение.  

4.2. Търсене на елементите от схемата в предварително заредените библиотеки.  

Работа със схемотехнични библиотеки. Търсене на елемент в директория със схе-

мотехнични библиотеки. 

 
Фиг. 2.5. Търсене ни схемен компонент SN7400. 
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Въвеждането на схемата става като първо се създаве нов проект. От главното меню се 

избира File → New → Project → PCB Project. В отворилия се екранен прозорец наречен 

New Project се въвежда името на проекта, в случая Upr.2.PrjPcb в частта Name и дестинаци-

ята на директорията в която е записан файла на проекта, в частта Location. След създаване-

то на проекта в него трябва да се добави 

файл съдържащ схема. Това става като от 

бутон  се избере Add New To 

Project → Schematic, както беше напра-

вено в първото упражнение или с коман-

дата от главното меню File → New → 

Shematic, чрез която автоматично се създава в създадения и записан файл на проекта, схе-

мотехничния файл Sheet1.SchDoc. Препоръчително е да се смени името на файла, напри-

мер с кликване на ДБМ върху името му, да се избере от падащото меню Save as 

Upr.2.SchDoc. 

Логическите елементи не са достъпни в досега използваните библиотеки и затова се 

налага да се търсят в библиотеките на AD. 

Търсенето става според описаното в т.1.2 като 

се има названието на всеки един от цифрови-

те интегрални схеми. При търсене на елемен-

тите от ИС D1 и D2, които са тип SN7400, за 

да намалим времето за изпълнение, конкрети-

зираме търсенето да се осъществи само в биб-

лиотеките на производителя Texas 

Instruments, както е показано на фиг. 2.5. След 

намирането на библиотечния компонент 

програмата извежда съобщение, че библиоте-

ката съдържаща търсения елемент не е дос-

тъпна, тъй като не е заредена в списъка с дос-

тъпни библиотеки. Съгласяваме се с инстали-

рането на библиотеката при което става въз-

можно разполагането на логическия елемент в 

чертожното пространство. Трябва да се отбе-

лежи, че библиотечния символ отговаря само 

на един логически елемент на ИС SN7400, т.е. 

търсената ИС е мнотоелементна и съдържа 4 

логически елемента с различна номерация на 

изводите. За да има съответствие със схемата 

от фиг.2.4 трябва да се обърне внимание на 

обозначението на логическите елементи. Мултивибраторът е изграден с помощта на пър-

вите два елемента на ИС D1, следователно трябва да използваме Part1 и Part2 от ИС от 

библиотечния компонент SN7400, който е показан на фиг.2.7. Друг подход който може да 

се използва при многоелементни библиотечни компоненти е след поставянето на отделни-

те елементи те да се редактират, като се промени от там използваната част. Това става с на-

Фиг. 2.6. Въпрос за инсталиране на библиотека. 

 
Фиг. 2.7. Символ ни схемен компонент 

SN7400 в библиотеката. 
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тискане на бутона Tab по време на поставянето на елемента или с двойно щракване на дес-

ния клавиш на мишката върху пос-

тавения елемент, за да се отвори 

екранния прозорец за настройки 

Properties. След отварянето му в 

горния ляв ъгъл след Comment са 

разположени надпис с текущата 

част на многоелементния компо-

нент, в случая това е 2 част от об-

що 4 части и стрелки за смяна на 

частта, както е показано на фиг.2.8, 

като началния и крайния елемент са достъпни с натискането на бутоните съответно << и 

>> , а чрез бутоните < и > може да сменяме текущия елемент с намаляваща или увелича-

ваща се номерация. 

Поставянето на куплунгите за превключвателите S1, S2 и S3, както и за изходите към 

високоговорителя ВА1 и към нискочестотен усилвател НЧУ се извършва, като се използва 

библиотеката Miscellaneous Connectors, която е заредена по подразбиране. Подходящите 

компоненти са Header 2 за S1, ВА1 и НЧУ, за S3 Header 5, а за S2 Header 10. Номера след 

Header показва броя на изводите на едноредовия куплунг за печатна платка, като той е под-

ходящ за непосредствено запояване на проводници към платката, особено за такива от лен-

тов кабел. След разполагането на компонентите в чертожното пространство се пристъпва 

към опроводяването им като се използва инструмента Wire. 

 

4.3 Опроводяване на елементите и ERC проверка. 

След завършване на опроводяването между отделните елементи на електронният въ-

зел трябва да се направи проверка за тяхното правилно свързване, правилно наименование 

на елементите и други липси и пропуски, които би могло да бъдат пропуснати по време на 

изчертаването. Задължително условие за да пристъпим към проверка е предварително да 

сме създали файл, съдържащ печатна платка, който да е включен в проекта. За целта мо-

жем да използваме командата File → New → PCB, като е желателно създадения файл 

PCB1.PcbDoc да бъде преименуван, например в Upr.2.PcbDoc.  

 Проверяването за грешки се извършва от Design → Update PCB Document 

Upr.2.PcbDoc при което се отваря прозореца Engineering Change Order. Натискаме бутона 

 и отметката на Only Show Errors от фиг. 2.9 и получаваме прозорец със съобще-

нията за грешки показан на фиг.2.10. Грешките са от типа Footprint Not Found и показват 

че съответстващите на схемотехнични компоненти отпечатъци на корпуси /footprint/ за 

PCB не са намерени в заредените в паметта PCB библиотеки.  

 
Фиг. 2.8. Смяна на номера на елемента. 
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Фиг. 2.9 Прозорец с информацията за елементите от схемата. 

 
Фиг. 2.10 Прозорец с информацията за възникналите грешки. 

За да отстраним възникналите грешки трябва да проверим какви корпуси притежават 

реалните елементи от техническата им документация и евентуално да подберем правилните 

корпуси от библиотеките с компоненти за PCB в директорията с библиотеки на AD. По 

отношение на първия компонент 

DD3 -DM7490, след търсене в 

Internet намираме в техническата 

документация [3], че ИС се про-

извежда от Fairchild с фирмено 

означение на корпуса N14A, кое-

то съответства на международно-

то означение PDIP-14. Проме-

няме корпуса на DD3 към съот-

ветстващия компонент DIP-14 от 

библиотеката Miscellaneous 

Device.IntLib. Това става като се 

кликне с ДБМ върху елемента от схемата, в случая DD3 и от падащото меню се избере 

Properties. Отваря се диалогов прозорец за настройки подобен на този от фиг. 1.18, но тук 

ни интересува частта Models, където натискаме Add и се отваря прозореца PCB Models, пока-

зан на фиг.2.11. С бутона Browse избираме библиотеката Miscellaneous Device.IntLib 

/Footprint View/, а от там компонента DIP-14, както е показано на фиг.2.12. Препоръчи-

 
Фиг. 2.11. Диалогов прозорец за смяна на корпус на компонент. 
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телно е да се сменят корпусите и 

на елементите DD1 и DD2, неза-

висимо че не се генерира съоб-

щение за грешка, тъй като фир-

мения библиотечен компонент 

не съдържа фирмения библио-

течен компонент не съдържа 3D 

изображение на корпуса на еле-

ментите от типа 7400. За  еле-

мента DD4 се процедира по съ-

щия начин като за DD3.  

След справка с техническа-

та документация на ИС [4] се 

вижда че корпусът е с фирмено 

обозначение N016D, което съответства с обозначението на компонента DIP-16 от библио-

теката Miscellaneous Device.IntLib. Заменяме корпуса на елемента DD4 по описания начин 

като за DD3. По отношение на останалите грешки, те се отнасят за корпусите на дискретни 

елементи – биполярните транзистори. От каталожната информация за тях намираме, че 

корпуса на VT1 BT159 е нестандартен, тъй като е старо полско производство, а VT2 2T3604 

и VT3 2T6551 са български транзистори, но са със стандартни корпуси, съответно ТО-92 и 

ТО-39. Първия корпус можем да заменим с компонента HDR1X3 от библиотеката 

Miscellaneous Connectors.IntLib /Footprint View/, съответстващ на куплунга Header 3, тъй 

като разтоянието между изводите е същото – 2,54 mm, което съответства на стандартната 

стъпка за PCB от 100 mil. Останалите корпуси намираме от библиотеката Miscellaneous 

Device.IntLib /Footprint View/. Окончателния вид на схемата е показан на фиг.2.13. 

 
Фиг. 2.13. Опроводена схема с корекции. 

 
Фиг. 2.12. Избор на корпус на компонент. 
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4.4. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

След замяната на корпусите на елементите с грешки отново изпълняваме командата 

Design → Update PCB Upr.2.PcbDoc. Ако няма предварително забелязани грешки натис-

каме бутона Validate Changes и ако статусът на всички елементи и връзки е в зелено в секция-

та Check финализираме прехвърлянето на информация с бутона Execute Changes.  

На екрана до очертанията на печатната платка в черно се получават изображения на 

корпусите на елементите от схемата и връзките между тях – фиг.2.14.  

 
Фиг. 2.14. PCB с очертанията на корпусите на елементите на схемата. 

По нататък се повтарят стъпките описани в първото упражнение по отношение на 
разполагането на компонентите върху очертанията на печатната платка, като се спазват 
правилата за разполагането на куплунгите. По отношение на ИС се предпочита те да се 
разполагат така, че да има достатъчно място около тях за множество печатни проводници, 
които свързат изводите им. 
  Следващата стъпка е ръчно разполагане на компонентите в очертанията на печатната 
платка. Важно е да няма компоненти, разположени на или много близо до ръбовете на 
платката, а така също да няма застъпващи се или много близо разположени компоненти. 
Начинът на разполагане на компонентите е много важен за конструирането и правилното 
функциониране на печатната платка.  

След разполагане на елементите пристъпваме към опроводяване на печатната платка. 
Използваме режим на автоматично опроводяване, като изпълняваме командата 
Route>Auto Route>All и от появяващия се екранен прозорец избираме Default 2 Layer Board 
и натискаме бутона Route All.  

На фиг. 2.15 е представена опроводената печатна платка на разработваната схема, като 
на монитора ще се изобразят в червено печатните проводници на горния слой /Top layer/, 
а в синьо печатните проводници от долния слой /Bottom layer/. В жълто ще са очертания-
та на компонентите и означенията им /Top overlay/, което представлява слоя на т.н. „бял“ 
или сервизен печат на печатната платка. Ако отделните компоненти имат 3D модели, гото-
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вата печатна платка може да се разгледа и в 3D режим на изображение, достъпен чрез ко-
мандата View>3D Layout Mode. 

 
Фиг. 2.15 Опроводена PCB на електронен метроном. 

 

 
Фиг. 2.16 PCB в 3D режим на изображение на електронен метроном. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №3 

СЪЗДАВАНЕ НА БИБЛИОТЕКИ СЪС СХЕМОТЕХНИЧНИ 

КОМПОНЕНТИ В ALTIUM DESIGNER. 

1. Теоретична обосновка.  

 За провеждане на това упражнение се предполага, че студентите имат позна-

ния за работа със схеми в среда на Schematic Editor и са компетентни относно търсенето 

на компоненти и тяхното поставяне. Примери за работа с компоненти и библиотеки мо-

гат да се разглеждат в папката Altium\Examples\Tutorials\Creating Components. 

В това упражнение, ще се разгледат следващите теми :  
 - Създаване на нови библиотеки;  
 - Създаване на компоненти на схема с единствени и многочислени части; 
 - Проверяване на компонентите, използвайки Schematic Library Editor reports.  
1.1. Създаване на компоненти за схема. 

Schematic Library Editor има възможност за създаване и променяне на компоненти и 
управление на компонентите на библиотеката. Той е подобен на Schematic Editor и спо-
деля същите графични обекти, с допълнение наречено Place Pin tool. Компонентите на 
схемата могат да бъдат изградени от части, които са отделно избираеми и са асоциирани 
с техните PCB корпуси, които са разположени в PCB библиотеките или интегрирани 
библиотеки, по време на синхронизацията. 

Компонентите могат да бъдат създавани в Schematic Editor и копирани и поставяни 
в отворената библиотека на схемата за създаване на нови компоненти или може да се из-
ползва drawing tools от Schematic Library Editor-а. 

1.2. Библиотеки. 

Библиотеките за схеми ( .SchLib ) са вкючени като съществена част от цялостните 
библиотеки ( .IntLib ) поставени в папката Altium\Library. 

За да създадете библиотека извън цялостната библиотека отворете integrated library 
и изберете Yes за да извлечете от библиотеката източник това, което трябва да бъде от-
ворено за въвеждане.  

Може да се създават библиотеки с всички компоненти, които са поставени в схема-
та за активният проект, като се използва командата Design » Make Project Library. 

1.3. Създаване на нова библиотека. 

Преди да започнете създаването на компоненти, нека направим нова библиотека в 
която да ги съхраняваме. За да създадете нова библиотека, изпълнете следните стъпки: 

1. Изберете File » New » Schematic Library. При по нови версии на AD се избира 
File » New » Library » Schematic Library. Създава се нова библиотека с име  
Schlib1.SchLib и се отваря празна страница за компонент, Component_1, показваща се в 
прозореца за дизайн. 

2. Препоръчва се преименуването на библиотечният файл например на Schematic 
Components.SchLib, с помощта на File » Save As. Отворете изисканата папка, преимену-
вайте файла с разширение .SchLib и натиснете Save. 

3. Натиснете SCH Library менюто за да отворите панелът на библиотеката на SCH в 
който се виждат компонентите в библиотеката в случая имаме един единствен компонент 
с името.  
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Фиг. 3.1. Създаване на нова библиотека. 

1.4. Създаване на нов компонент. 

За да създадете нов компонент във вече съществуваща 
библиотека трябва да изберете Tools » New Component, но от 
тогава новата библиотека винаги ще съдържа една празна стра-
ница за компонент, за пример преименувайте Component_1, за 
да започнете създаването на вашият първи компонент, NPN 
транзистор. 

1. Изберете Component_1 от листа с компоненти в SCH 
Library панела и изберете Tools » Rename Component. Напи-
шете новото име на компонента, което уникално го идентифи-
цира, т.е. транзисторът NPN, в прозореца за ново име.  

2. Ако е необходимо поставете източникът в средата на 
страницата, чрез избиране на Edit » Jump » Origin. 

Проверете редът за статус в най-долната лява част на екранът за да потвърдите, че 
вашият курсор е 
при източникът. 
Компоненти, които 
са предоставени от 
AD са създадени 
около тази точка, 
маркирана с пер-
пендикулярни ли-
нии през центърът 
на листа. 

3. Задайте 
стойности за при-
лепване към мре-
жата на 1 и за ви-
димата мрежа 10 в 
прозореца за наст-
ройка на работно-

 

 
Фиг. 3.2. Настройки на работното пространство на библиотечния  

редактор. 
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то пространство на Library Editor като изберете Tools » Document Options 
Ние ще приемем другите настройки по подразбиране като натиснем ОК. Ако мре-

жата не се вижда натискаме Page Up за да я покажем. 
4. За да създадем даденият като пример по – горе NPN трябва първо да дефинира-

ме тялото на компонента. Избираме Place » Line или натискаме Place Line „ / ” бутона от 
лентата с инструменти. Натиснете клавишът TAB за да определим свойствата в PolyLine 
прозореца и натискаме ОК. Кликвате за да започнете вертикалната линия от 0, -1 и край, 
от 0,-19 и кликвате с десният бутон за да поставите линията. Сега за да създадете другите 
две линии от 0,-7 до 10, 0 и 0,-13 до 10, -20 се използва Shift+SPACEBAR за да опреде-
лим ъгълът на тези линии. Кликване с десният бутон или натискане на ESC прекратява 
режима на поставяне на линии. 

5. Стрелата е създадена извън затворен многоъгълник. Избираме Place » Polygon 
или кликваме на Place Polygon бутона от менюто. Натискаме клавишът TAB за да зададем 
свойствата на многоъгълника в диалоговият прозорец и натискаме ОК. Кликваме с леви-
ят бутон за да оформим върховете на  триъгълника и с десният бутон за край. Кликване с 
десният бутон или натискане на ESC прекратява режима на поставяне на многоъгълника. 

6. Запазете компонента. 
 
1.5. Добавяне на извод към компоненти. 

Изводите/pin/ на компонента дават неговите електрически свойства и дефинират 
точките за връзка на компонента. Те също имат графични свойства. 

 За поставяне на извод на компонент в Schematic Library Editor : 
1. Избираме Place » Pin 

или кликваме на бутона от ме-
нюто. 

2. Преди поставяне на 
pin, натиснете клвиша TAB по 
време на поставянето за да се 
въведат свойствата на извода. 
Появява се диалогов прозорец 
със свойствата на  извода. Ако 
вие дефинирате атрибутите на 
извода преди да го поставите, 
настройките които дефинира-
те ще станат настройки по 
подразбиране и номерата на 
изводите и всички имена ще 
бъдат автоматично инкремен-
тирани когато вие го постави-
те. 

3. В диалоговият прозо-
рец за свойствата на извода, 
въведете типа му, в полето за 
име въведете името което ще 
се показва и уникалният номер 
на извода в полето Designator. 

Сложете отметката Visible, ако искате името на извода и designator-а да са видими когато 
поставяте компонента на страницата със схемата.  

4. Задайте Electrical Type за да изберете типа на електрическата връзка на извода, 
може да го изберете от падащото меню. Този тип може да бъде използван за проверка на 

 
Фиг. 3.3 Настройки характеристики на извод. 
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електрическите правила, когато завършите проекта или анализирате схемата за да откри-
ете грешки в електрическата част на схемата. В този примерен компонент всички изводи 
са от пасивен електрически тип. 

5. Задайте дължината на този извода в стотни от инч-а в полето дължина. За всич-
ки изводи в този компонент задайте 20 и натиснете ОК. 

6. Натиснете Spacebar за да завъртите извода на 90º. Запомнете, че само единият 
край на извода е електрически и този край трябва да бъде поставен извън тялото на ком-
понента. До неелектрическият край на извода е поставено неговото име. 

7. Продължете да поставяте изводи, това е задължително за да завършите компо-
нента. Бъдете сигурни, че имената, номерата, символите и електрическите типове са пра-
вилни.  

8. Вие завършихте вашият компонент, сега изберете File » Save за да го запазите.  
  

Бележки относно изводите 

- За да зададете свойствата на извода след поставянето му, кликвате два пъти върху 
него, или с двойно кликване върху съответният извод в списъка в панела SCH Library. 

- Ако искате да скриете захранването и заземяването на изводите на компонент, 
маркирайте Hide чек бокса. Когато те бъдат скрити, тези изводи ще бъдат свързани към 
специфични захранване и заземяване т.е. извода за VCC ще бъде свързан към net VCC 
когато се постави. 

- За да видите скритите изводи, изберете View » Show Hidden Pins. Всички скрити 
изводи ще бъдат показани в работният прозорец. 

- Вие можете да редактирате свойствата на извод директно в диалоговият прозорец 
Component Pin Editor, без да отваряте прозореца Pin Properties за всеки извод поотделно. 

Натиснете Edit 
Pins от диало-
говият прозо-
рец Library 
Component 
Properties за да 
отворите про-
зореца 
Component Pin 
Editor. 

- За компонен-
ти изградени 
от множество 
части съответ-
ните изводи за 
избрана част 
ще бъдат с 

подчертани с бял фон в прозореца на Component Pin Editor. Всички изводи от други части 
са сиви. Вие все още можете да редактирате пиновете от тези неизбрани части. Изберете 
пина и натиснете Edit за да се покаже прозорецът за редактиране Pin Properties за съот-
ветният пин. 

1.6. Настройка на свойствата на компонентите. 

Всеки компонент има свойства асоциирани в комплект с designator по подразбира-
не PCB корпуси и/или други модели и параметри на компонента. Така също можете да 

 
Фиг. 3.4. Настройки характеристики на извод. 
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попълните полета за различни части и библиотеки когато са  показани свойствата на 
компонента. За да зададете свойствата на компонентите: 

1. Изберете компонент от списъка с компоненти от панела SCH Library и натиснете 
бутона Edit. Появява се диалоговият прозорец Library Component Properties. 

2. Типа на Designator по подразбиране т.е. Q?  и коментара ще се появи когато 
компонентът е поставен на работната страница, т.е. NPN. Използването на въпросите-
лен знак ще позволи на номера на designator да се увеличава автоматично след поставя-
нето т.е. Q1, Q2. Бъдете сигурни, че отметката Visible е поставена. 

3. Оставете другите полета с техните стойности по подразбиране, докато добавяте 
модели и параметри както беше изискано. 

1.6.1. Добавяне на модели към компонентите на схемата                           
Могат да се добавят всякакви номера на PCB корпусните модели, асоциирани със 

схемните компоненти, като файловете на модела могат да се използвани за симулации и 
сигнален анализ. Тогава може да се избере подходящ модел от диалоговият прозорец 
Component Properties, като се постави компонента в документа на схемата. 

Има ня-
колко раз-
лични пътя за 
добавяне на 
модели към 
компонент. 
Можете да 
свалите готов 
модел от 
WEB или да 
добавите мо-
дел от същес-
твуваща 
Altium биб-
лиотека. PCB 
корпусните 
модели се на-
мират в пап-
ката: 
C:\Users\Publ

ic\Documents\Altium\ADХХ\Library\Pcb във формат на PCB библиотеки (. pcblib files). 
SPICE моделите се използват за симулация на схеми (. ckt and .mdl files) и се намират в 
интегрирана библиотека в папка: C:\Users\Public\Documents\Altium\ADХХ\Library. 

1.6.2. Търсене на местонахождението на файлове – модели. 
Когато модела е добавен към компонент в Schematic Library Editor, връзката от ком-

понента към информацията за модела е реше-
на от следващите валидни местоположения за 
търсене : 

1. Първо се търси в библиотеките вклю-
чени в текущият проект. 

2. Следващи са PCB библиотеките ( но 
не цялостните библиотеки ), тези които са на-
лични от текущо инсталираният списък с 
библиотеки.  

3. Най-накрая, всички библиотеки с мо-

 
Фиг. 3.5. Настройки характеристиките на компонент. 

 
Фиг. 3.6. Добавяне на корпус. 
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дели са намерени и пътищата в проекта са търсените. Тези пътища са дефинирани в ди-
алоговият прозорец опции на проекта ( Project » Project Options ). 

Компонентите, моделите и библиотеките - за повече информация относно пътя до 
тях търсете в Schematic Library Editor и Schematic Editor. 

В това ръководство сме използвали първият метод за свързване на компоненти и 
модели, а именно с добавяне на всички важни модели в библиотеката на проекта, заедно 
с библиотека на схемата, преди компилиране на библиотечният пакет в цялостната биб-
лиотека. 

1.6.3. Добавяне на корпуси към компоненти на схемата 
Първо трябва да добавим корпуса, 

който компонента на схемата ще изпол-
зва когато е синхронизиран с PCB до-
кумента. Корпусът изисква вашият ком-
понент да се казва BCY-W3. Обърнете 
внимание, че когато свързвате PCB 
корпуса с компонента на схемата в 
Schematic Library Editor, моделът трябва 
да съществува в PCB библиотеката, а не 
в интегрираната библиотека. 

1. Натиснете бутона Add секцията 
списък с модели от диалоговият прозо-

рец Component Properties. Появява се друг диалогов прозорец Add New Model. 
2. Изберете Footprint от па-

дащото меню за тип на модела. На-
тиснете ОК. Появява се диалогов 
прозорец PCB Model. 

3. Натиснете бутона Browse за 
да намерите вече съществуващ мо-
дел от прозореца Browse Libraries ( 
или задайте примерен тип на моде-
ла и име, и може да го създадете 
по-късно използвайки PCB Library 
Editor ). 

4. Когато в диалоговият про-
зорец Browse Libraries натиснете 
Find, се появява друг диалогов про-
зорец наречен Search Libraries. 

5. Изберете област на дейст-
вие Libraries on Path и посочете 
папката \Altium\Library\Pcb чрез 
кликване върху бутона Browse 
Folder от менюто и натиснете ОК. 

6. Бъдете сигурни, че в търсе-
нето се включват и поддиректориите в прозореца Search Libraries. В полето име напише-
те BCY-W3 и натиснете Search. 

7. Вие трябваше да получавате един резултат Index.PcbLib. Натиснете Select за да 
затворите прозореца за търсене Search Libraries, инсталирайте библиотеката и изберете 
BCY-W3 в прозореца Browse Libraries. Натиснете ОК и се върнете към прозореца PCB 
Model. 

 
Фиг. 3.7. Търсене на корпус. 

 
Фиг. 3.8. Общ вид на избрания корпус. 
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8. Натиснете ОК за да добавите модела. Името на модела е включено в списъка с 
модели в диалоговият прозорец Component Properties. 

 
1.6.4. Добавяне на модели за симулация на верига 

SPICE моде-
лите се използват 
за симулация на 
верига (. ckt and 
.mdl files), те се 
намират цялост-
ната библиотека в 
папката 
C:\Users\Public\D
ocuments\Altium\
ADХХ\Library. 
Добавете тези мо-
дели ако искате да 
анализирате ваша-
та схема. 

Препоръчва 
се ако използвате 
тези модели за 
симулация на ва-

шите компоненти да отворите файла .Intlib който съдържа необходимите модели (File » 
Open и потвърде-
те, че искате да ра-
зархивирате биб-
лиотеките източ-
ници ). После ко-
пирайте файла на 
модела от изходя-
щата ( резултант-
ната ) папка в пап-
ката където се на-
мират вашите 
библиотечни из-
точници. 

1. Натиснете 
бутона Add в сек-
цията където е 
списъка с модели в 
прозореца 
Component Properties. 
Появява се диало-
говият прозорец 

Add New Model. Изберете Simulation от падащото меню и натиснете ОК. Отваря се друг 
диалогов прозорец SIM Model – General / Generic Editor. 

2. За този пример изберете вид на модела ( Model Kind ) на транзистор от падащото 
меню. Отваря се диалоговият прозорец Sim Model – Transistor /BJT. 

 
Фиг. 3.9. Избор на вид модел. 

 

 
Фиг. 3.10. Избор на BJT модел. 
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4. Трябва да сте сигурни, че е избран BJT за подвид ( Model Sub-Kind ) на модела. Въ-
ведете валидно име на модела, т.е. NPN ( за файла на модела NPN.mdl ), и описание, т.е. 
NPN BJT , и натиснете ОК. Натискането на бутона ОК ви връща в диалоговият прозо-
рец Component Properties, където модела NPN вече е добавен в списъка с модели. 

 
1.6.5. Добавяне на Signal Integrity модели 
Симулаторът на сигнали използва модела на извода, вместо модела на компонента. 

За да конфигурирате компонента за симулация, вие трябва да определите типа и техно-
логичните възможности, като използвате модели на изводи, зададени по подразбиране 
или да импортирате IBIS модел. 

1. За да добавите Signal Integrity модел, натиснете бутона Add в секцията списък с 
модели от диалоговият прозорец Component Properties. Отваря се нов прозорец Add 
New Model. 

2. Избирате Signal Integrity от падащото меню с типовете модели и натискате буто-
на ОК. Отваря се прозореца Signal Integrity Model.  

3. Ако искате да импортирате IBIS файл, натиснете бутона Import IBIS и  достиг-
нете до нужният файл .ibs . За този пример въведете името на модела и описание NPN ( 
за пример ) и изберете тип  BJT. Натиснете бутона ОК за да се върнете в прозореца 
Component Properties, където модела е въведен в списъка с модели. 

 
Фиг. 3.11. Настройки на Signal Integrity модел. 

За повече информация относно въвеждането на Signal Integrity модели, се обърнете 
към раководството Performing Signal Integrity Analyses. 
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1.6.6. Добавяне на параметри на компонент 
Параметрите са средство за дефиниране на допълнителна информация за компо-

нентът. Параметрите, като низове, идентифицират данни като производителят на ком-
понентът или датата на производство, могат да бъдат прибавени към документът. Циф-
ров параметър ( низ ) също можеше да бъде добавен като стойност за компонентът (т.е. 
100 k – за резистор). 

Параметрите могат да бъдат показвани като специални низове, когато компонента 
бъде поставен на работната страниица. Други параметри са задължително стойности за 
симулацията или може да се използват PCB правилата създадени в  Schematic Editor. За 
да добавите параметър на схемен компонент: 

1. Натиснете бутона Add в секцията списък с параметри в диалоговият прозорец 
Component Properties за да се покаже прозореца Parameter Properties.  

2. Въведете името на параметъра и неговата стойност. Бъдете сигурни че избраният 
тип параметър е String, ако изсквате текстовият низ и стойностите да са видими, чекбокса 
Visible трябва да е маркиран, ако искате стойността да се показва когато компонента е 
поставен на работната страница. Натиснете ОК. Параметърът е добавен в списъка с па-
раметри в прозореца Component Properties. 

 
Фиг. 3.12. Настройки на параметри на компонент. 

Параметър за стойност. 
Параметърът за стойност може да бъде използван за каквато и да е обща информа-

ция за компонентът, но дискретните компоненти, като резистори и кондензатори, го из-
ползват при симулиране. 

Ние можем да зададем на компонентите коментар, използвайки индиректни стрин-
гове, които четат стойността от въведената стойност за параметър, това е записано като 
коментар в PCB Editor. Вместо да въвеждате стойността два пъти ( т.е. веднъж в параме-
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търа на име Value и отново в полето за коментар ), AD поддържа индиректно заместване 
на полето с кометар със стойността на параметъра стринг. 

1. Натиснете бутона Add в секцията списък с параметри в диалоговият прозорец 
Component Properties за да се покаже прозореца Parameter Properties. 

2. Въведете име Value и стойност 100к. Тази стойност ще бъде използвана когато се 
стартира симулацията на схемата. Бъдете сигурни, че е избрано String за тип на параме-
търа и отметката Visible е поставена. Избират се шрифт, цвят и ориентация и се натиска 
ОК, за да добавим новият параметър в списъка с параметри в прозореца Component 
Properties. 

3. В секцията Properties в прозореца Component Properties, натиснете върху полето 
Comment и изберете =Value от падащото меню и включете опцията Visible. 

 
4. Запишете направените промени в библиотеката като изберете File » Save. 
5. Когато видим специялният стринг в Schematic Editor, трябва да сме сигурни, че 

опцията Convert Special Strings е разрешена в мемюто Graphical Editing в диалоговият прозо-
рец Preferences ( Tools » Schematic Preferences ). Ако коментарът не се показва в PCB до-
кумента след обновяване можете да сте сигурни този коментар е видим в корпусите в 
прозореца Components. 

 
1.7. Създаване на нов схемен компонент от множество части. 
В тази част, ние ще създадем нов компонент изграден от четири части, Quad 2-IN 

AND gate, името му е 74F08SJX. 
1. Изберете Tools » New Component в Schematic Library Editor. Отваря се нов диало-

гов прозорец New Component Name. 

 
3. Въведете името на новият компонент т.е. 74F08SJX и натиснете бутона ОК. Име-

то на новият компонент се появява в списъка с компонентите в SCH Library панела и се 
показва празна страница за компонент с пресечени линии в центъра на страницата. 

4. Сега ние ще създадем първата част от новият компонент както беше казано по-
горе, включително неговите пинове, ще се спрем детайлно и на следващите части. Пър-
вата част ще бъде използвана като база за останалите части, само номерата на пиновете 
ще бъдат променени в този пример. 

1.7.1. Изграждане тялото на компонента 
Тялото на този компонент е конструирано от мултисегментни линии дъга. За да сте 

сигурни компонента е в центъра на работното пространство изберете Edit » Jump » 
Origin. Уверете се също, че мрежата е видима. 
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Поставяне на линиите 
1. Изберете Place » Line или натиснете бутона с наклонена на дясно черта от ме-

нюто с инструменти. Курсорът се променя и вие сте в на поставяне на мултисегментни 
линии. 

2. Натиснете клавиша TAB за да отворите свойствата на линиите. Задайте линията 
да бъде малка в Polyline диалоговият прозорец. 

3. Натиснете левият бутон на мишката или бутона ENTER за да 
определите стартовата точка на линията от 25, -5. Проверете X, Y ко-
ординатите в Status bar в долният ляв ъгъл на работният прозорец. 
След това позиционирайте мишката и с щракване на ляв бутон задай-
те серия от точки които дефинират сегментните линии ( съответно 0, 
-5 ; 0, -35 и 25, -35 ). 

4. Когато завършите изчертаването на линиите натиснете дес-
ният бутон на мишката или бутона ESC. С натискане на десният бутон на мишката или 
бутона ESC излизате от режима на поставяне на линии. Запишете компонента. 

 
1.7.2. Изчертаване на дъгата 
Поставянето на дъгата е четиристъпков процес, поставят се централна точка, ради-

ус, стартова и крайна точка на дъгата. Може да натиснете Enter вместо левият бутон на 
мишката за да поставите дъгата. 

1. Изберете Place » Arc. Последната дъга която е изчертавана се появява на курсо-
ра, вие сте в режим на поставяне на дъга. 

2. Натиснете клавиша TAB за да отворите диалоговият прозорец със свойствата на 
дъгата. Задайте радиус 15 мм и линията да е малка. 

 
 

3. Позиционирайте кур-
сора и натиснете левият бутон 
на мишката за да определите 
централната точка на дъгата ( 
25, -20 ). Тогава курсорът ще 
скочи на текущият радиус на 
дъгата по подразбиране ( 15 мм 
), който ние вече сме задали в 
диалоговият прозорец Arc. 

4. Кликнете за да зададете 
радиуса. Тогава курсорът ще 
прескочи на стартовата точка 
на дъгата. 

5. Местете курсора за да нагласите стартовата точка, когато сте готови натиснете 
левият бурон на мишката за да я зададете. След определянето на стартова точка курсорът 
прескача на крайната точка на дъгата. Местете курсора докато определите прайната точка 
и натиснете левият бутон на мишката за да я зададете и с това завършва създаването на 
дъгата. 

6. Натиснете десният бутон на мишката или бутона ESC, за да излезете от режима 
за поставяне на дъга. 

1.7.3. Добавяне на изводи 
Добавете изводи към първата част, като използвате същата техника описана в сек-

цията „Добавяне на изводи към схематични компоненти” по-нагоре. Изводи 1 и 2 са 
входове и са от електрически тип а 3 е изход. 

 

 
Фиг. 3.13. Изчертаване на дъга. 
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Захранващите изводи са скрити, т.е. GND ( 
пин номер 7 ) и VCC ( пин номер 14 ). Те ще оста-
нат постоянни за всички части и затова се задават 
само веднъж  и се причисляват към част нула. Част 
нула е хранилище на изводите които са общи за 
всички части на компонента. В менюто със свойства 
в прозореца Pin Properties трябва да проверите за да 
сте сигурни, че захранващите изводи са зададени да 
са част нула в полето за номер на част, захранването 
е електрически тип, отметката Hide е поставена и 

връзките на захранващите пинове са с коректни имена т.е  VCC ( пин номер 14 ). 
 
1.7.4. Създаване на нови части 
1. Изберете компонентите които ще използвате Edit » Select » All. 
2. Изберете Edit » Copy. Курсорът ще се промени. Щракнете в горният ляв ъгил на 

тялото на компонента за да зададем отправна точка на копието и копирайте избраният 
обект в клипборда. 

3. Изберете Tools » New Part. Показва се празна страница за компонент. Частта е 
разположена в панела на библиотеката SCH и е обновена, като са включени част А и 
част В, които ще видите ако кликнете на + в дясно от името на компонента в панела SCH 
Library. 

4. Изберете Edit » Paste. Курсорът се появява с очертание на частта на компонента 
прикачено към неговата отправна точка. Местете копираната част докато се позициони-
ра, както е била оригиналната. Кликнете за да поставите копираната част. 

5. Обновете информацията за новата част, част В, като с двойно кликване върху 
всеки пин променяте неговото име и номер в диалоговият прозорец Pin Properties. 

 
6. Повторете стъпки от 3 до 5 за да създадете останалите две части, част С и D. За-

пишете библиотеката. 

 
1.7.5. Създаване на алтернативен режим на изглед на част 
Вие можете да добавяте до 255 алтернативни изгледа на частта на компонент. Тези 

режими за изглед могат да съдържат каквото и да е различно графично представяне на 

 
Фиг. 3.14. Добавени изводи. 
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компонентът, като DeMorgan или IEEE символи. Библиотеката за IEEE символи е на-
лична от Sch Lib IEEE toolbar ( View » Toolbars » Utilities ). 

Ако бъдат добавени каквито и да било алтернативи, те ще бъдат показани в 
Schematic Library Editor за избиране на алтернативен режим от Mode бутона от падащият 
списък. Когато компонента е поставен на раборната страница режима на изглед е избран 

от падащото меню в графичната секция на 
прозореца Component Properties. 

За да добавите алтернативен изглед на 
компонентна част в прозореца на Schematic 
Library Editor: 

1. Натиснете бутона + или изберете Tools 
» Mode » Add. Показва се празна страница за 
алтернатива 1. 

2. Поставете подходящ IEEE символ, за 
пример, за тази част и запишете библиотеката. 

 
1.7.6. Настройка на свойствата на компонента. 
1. Задайте свойствата на компонента с натискане на бутона Edit в SCH Library па-

нела когато компонента е избран от списъкът с компоненти. Попълнета в Library 
Component Properties прозореца в полето designator U?, и описание Quad 2-Input AND Gate 
и добавете име на корпуса DIP14 от списъка с модели. Ние ще създадем DIP14 корпус 
използвайки PCB Component Wizard по – късно в това ръководство. 

2. Запишете компонента в библиотеката като изберете File » Save. 
1.7.7. Добавяне на компоненти от други библиотеки. 
Вие можете да добавяте компоненти в библиотеката на вашата схема от други отво-

рени библиотеки и след това да редактирате техните свойства както се изискваше по – 
горе. Ако компонентът е част от цялостна библиотека, ще трябва да отворите файла 
.IntLib ( File » Open ) и да изберете Yes за да разархивирате библиотеката източник. 
След това отворете генерираната библиотека ( .Schlib ) от панела Projects. 

1. Изберете компонента който искате да копирате от списъкът с компоненти в па-
нела на библиотеката SCH в прозореца който се показва. 

2. Изберете Tools » Copy Component за да копирате компонента от текущата биб-
лиотека в която и да е друга отворена библиотека. В прозореца Destination Library се по-
казват всички текущи отворени библиотеки. 

3. Изберете от кой документ искате да копирате компонент. Натиснете ОК и копи-
раният компонент ще бъде поставен в избраната библиотека. 

1.7.8. Копиране на multiple компоненти. 
Могат да се копират един или няколко компоненти от библиотеката в библиотеката 

на схемата или в друга отворена схемна библиотека използвайки SCH Library панела. 
1. Изберете един или няколко компонента от списъка с компоненти в SCH Library 

панела използвайки стандартната за Windows комбинация от клавиши ( SHIFT+Click and 
CTRL+Click). Натиснете десният бутон на мишката и изберете Copy . 

2. За да промените библиотеката в която да се поставят, натиснете десният бутон на 
мишката в списъкът с компоненти от SCH Library панела и изберете Paste за да ги доба-
вите в списъка. 

1.7.8. Проверяване на компонентите използвайки доклади за схематични 
библиотеки 

За да проверите дали новият компонент е създаден правилно, трябва да се генери-
рат три доклада след като схематичната библиотека се отвори. Всички доклади са в 
ASCII текстов формат. 
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Уверете се, че библиотечните файлове са записани преди да се генерират доклади-
те. Затворете файловете с докладите и се върнете в Schematic Library Editor. 

1.7.9. Доклади за компонент 
За да създадете такъв доклад трябва списъкът с цялата информация за активният 

компонент да е налична. 
1. Изберете Reports » Component. 
2. Доклада ‘ libraryname.cmp’ се по-

казва в текстов редактор и включва номе-
ра на частите и пиновете в компонента. 

1.7.10. Доклад за библиотеката  
За да създадете доклад със списъка 

компонентите в библиотеката и тяхното 
описание : 

1. Изберете Reports » Library. 
2. Името на доклада е 

libraryname.rep и се показва в текстов ре-
дактор. 

1.7.11. Component Rule Checker 
The Component Rule Checker тества за 

грешки като дубликати и липсващи изводи. 
1. Изберете Reports » Component Rule Check. Появява се диалоговият прозорец 

Library Component Rule Check. 
2. Задайте атрибутите които искате да проверите. Натиснете ОК. Името на доклада 

е libraryname.err, показва се в текстов редактор, описвайки всички компоненти които на-
рушават правилата по които се проверява. 

3. Направете всички нужни настройки на библиотеката и върнете доклада. 

2. Цел на лабораторното упражнение. 
Да се усвои създаването на компоненти за схемотехничните библиотеки на 

Altium Designer. Създаване на многоелементни компоненти. 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема и елементите на измерва-

телна система с АЦП /Аналогово-цифров преобразувател/ C520D. 

3.2. Създаване на схемотехнична библиотека. Създаване на компоненти. Пос-

тавяне на създадените компоненти в чертожната среда. 

3.3. Опроводяване на елементите и ERC проверка. 

3.4. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

4. Указания. 
4.1. Запознаване с принципната електрическа схема и елементите на измерва-

телна система с АЦП C520D. 

Схемата на измервателна система с АЦП C520D е представена на фиг.3.16. Схемата 

се състои от 2 цифрови интегрални схеми, производство на бившата Германска демок-

ратична република /ГДР/ C520D и D348D, които не фигурират в библиотеките на AD.  

 
Фиг. 3.15 Прозорец за проверка. 
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Фиг.3.16. Принципна електрическа схема на измервателна система с АЦП C520D. 

Първата ИС C520D е разработка на ГДР, аналог на N520D, която вече не се произ-

вежда, а втората D348D е аналог на ИС SN7448N производство на Texas Insruments  и 

представлява дешифратор за управление на 7-сегментна индикация. Транзисторите 

SC308 също са произведени в ГДР, но са еквивалентни на BC308, които се произвеждат 

от много фирми и до днес. 

Като се спазват правилата за търсене на компоненти в библиотеките на AD описани в 

т.1.2 на Лабораторно упражнение №2 може да се направи търсене на гореспоменатите елект-

ронни елементи, но резултатът би бил отрицателен.  

4.2. Създаване на схемотехнична библиотека. Създаване на компоненти. Пос-

тавяне на създадените компоненти в чертожната среда. 

Пристъпваме към създаването на схемотехнична 

библиотека, както е описано в точка 1.2. Променяме 

името на библиотеката, например Upr.3.SchLib. Пре-

поръчва се имената на файловете в AD да са на лати-

ница. 

Започваме създаването на библиотечен компо-

нент за транзисторите SC308, като се ръководим от т.1.4 за транзистор NPN. Все пак 

трябва да се има предвид, че схемотехничното изображение на транзистора трябва да от-

говаря на действащия стандарт за схемотехничните означения на 

полупроводникови елементи БДС 2.711:79 / IEC 617-4/ и евро-

пейския EN 60617-5:2000. Съгласно този стандарт означението 

на биполярен PNP транзистор като SC308 е показано на фиг.3.17. 

За да спазим точно изискванията за размерност, трябва да наст-

роим растерната мрежа да е в милиметри /mm/, т.е. да сме от-

метнали в Option » Document options » Units - Use Metric Unit 

System. Друг начин за да сменим мерните единици е чрез View » Toggle units. Растерна-

та мрежа/Grid/ променяме чрез натискане на G от клавиатурата до достигане на стой-

ност 1 mm. Трябва да чертаем около координати (0,0), тъй като при поставянето на ком-

понента в схемата, маркера на мишката ще се ориентира спрямо тези координати. Черта-

     
Фиг.3.17. Означение на PNP транзистор. 
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ем с инструмента Line от набора инструменти. Тъй като линията на 

базата е с дължина нечетно число, то е необходимо да изберем 

стъпка на Grid – 0,5 mm. Изчертаваме линия с координати (-4.5,0 

+4.5,0) mm, което ще е базата. Символът за база завършваме с хо-

ризонтална линия с координати (0,0 0,-4.5). Поставяме окръжност с 

център координати (0,1.5) и радиус по x и y от 6 mm. Поставяме 

колектора като линия (5,5 +1.5,0), респективно емитера (-5,5 -1.5,0). За да поста-

вим стрелката влизаме в настройките на поставената линия на емитера чрез 

двойно щракване на д. к. на мишката, и на End Line Shape избираме SolidArrow. 

Остава да се поставят изводите съгласно т.1.5, като в настройките им избираме 

дължина /Length/ 5 mm, с име /Display Name/ и означение /Designator/ на из-

вода съответно  E - 3, B – 2 и C – 1 съгласно каталожната информация [6]. С цел 

прегледност се препоръчва имената и означенията  на изводите на транзистора 

да не се виждат, като за целта се премахва отметката на Visible.  След създаване на 

графичното означение на транзистора по стандарта БДС, следва да се постави модел на 

отпечатъка на корпуса на транзистора върху PCB, съгласно т.1.6.3. Съгласно [6] корпусът 

на транзистора BC308 е ТО-92. За целта натискаме бутона Add Footprint и на Model 

Name попълваме ТО-92. Ако се появи надпис Model Name not found in project libraries or 

installed libraries в прозореца Selected Footprints, то това означава, че в достъпните биб-

лиотеки нямаме точно този корпус. Затова е подходящо да потърдим във всички библи-

отеки корпуси започ-

ващи с ТО-92. За 

целта натискаме бу-

тона Browse и от 

прозореца Browse 

Library натискаме бу-

тона Find и на Value 

попълваме ТО-92. 

Натискаме Search и 

от намерените корпу-

си избираме ТО-92А, 

тъй като той най-

много се доближава 

до каталожните дан-

ни в [6]. За означение 

на създадения символ 

на PNP биполярен транзистор попълваме в секцията Designator VT?, тъй като това е 

стандартното означение на транзистори по БДС. Окончателния вид на прозореца с нас-

тройки /Properties/ е показан на фиг. 3.18. За да поставим така създадения символ, тряб-

ва да създадем чертожна страница с размерност А3 и като се върнем в библиотеката да 

натиснем Place от панела SCH Library. Ако този панел не се вижда, то отиваме на наст-

ройките SCH на екранния прозорец долу в ляво и от там избираме SCH Library. Ориен-

 
Фиг.3.17. Properties на PNP транзистор SC308. 
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тираме транзисторите като ги завъртаме с помощта на бутона Spice от клавиатурата и 

последователно ги преозначаваме VT1-VT3. 

За да създадем символ на ИС C520D, трябва първо да създадем нов компонент в 

библиотеката с бутона Add от панела SCH Library и в отворения чертожен прозорец да 

започнем изчертаването около координати(0,0), както беше при изчертаването символа 

на транзистора. Подходящ е за използване инструмента Place Rectangle с който изчерта-

ваме правоъгълник с размери съобразени с броя крачета от всяка страна, съгласно 

фиг.3.16. Поставяме 

изводите съгласно т. 

1.7.3., като разделя-

ме изводи 6 и 7. 

Трябва да присъе-

диним подходящ 

модел на  корпуса. 

По описанието на 

ИС се ориентираме 

към пластмасов 

корпус с 16 извода 

двустранно разпо-

ложени около кор-

пуса. Това съответс-

тва на стандартен корпус DIP-16, достъпен от библиотеките на AD. По подобие на кор-

пуса на транзистора извършваме търсене на корпус DIP-16. Правим настройки на озна-

чението DD? В полето Default Designator, а в полето Default Comment попълваме 

C520D. Окончателния вид на настройките е показано на фиг.3.18. 

За пасивните елементи и ценеровите диоди можем да използваме стандартни озна-

чения, които са разположени в библиотеката BDS-ISO.Intlib, която трябва предварител-

но да инсталираме, за да можем да я използваме. Названията на елементите са на българ-

ски съответно Резистор, Резистор потенциометър, Кондензатор неполярен, Кондензатор 

полярен и Диод ценеров. ИС SN7448N търсим в библиотеките на AD и по точно в TI 

Interface Display Driver.IntLib. При неуспех при търсенето или при непълни библиотеки 

можем да създадем нов компонент в съществуващата библиотека, по описания начин 

както с C520D. Светодиодната индикация заменяме с куплунг, тъй като тя обикновено не 

се разполага на печатната платка. Използваме куплунг с 10 извода тип Header10, на който 

извеждаме трите сигнала за отделните разряди от транзисторите, посредством които се 

реализира динамична индикация и съответните сегменти от A до G на седемсегментната 

LED индикация. За да се свържат проводниците с входния сигнал Ue , захранването +Us 

и масата GND трябва да използваме куплунзи от типа Header2, като трябва да се поставят 

съответните Power port символи за захранване и маса, като се променя Net на съответния 

символ. Окончателния вид схемата в AD е показан на фиг.3.19. 

 
Фиг.3.18. Properties на ИС C520D. 
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Фиг.3.19. Принципна електрическа схема на измервателна система с АЦП C520D въведена в AD. 

 

4.3. Опроводяване на елементите и ERC проверка. 

След завършване на опроводяването между отделните елементи се прави проверка 

за тяхното правилно свързване, правилно наименование на елементите и други липси и 

пропуски, които би могло да бъдат пропуснати по време на изчертаването. Както беше 

споменато при предходното упражнение задължително условие за да пристъпим към 

проверка е предварително да сме създали файл, съдържащ печатна платка, който да е 

включен в проекта. За целта използваме командата File → New → PCB, като е желател-

но създадения файл PCB1.PcbDoc да бъде преименуван, например в Upr.3.PcbDoc.  

 Проверяването за грешки се извършва от Design → Update PCB Document 

Upr.3.PcbDoc при което се отваря прозореца Engineering Change Order. Натискаме бутона 

 и отметката на Only Show Errors и получаваме прозорец със съобщенията за 

грешки. Грешките са от типа Footprint Not Found и показват че съответстващите на схе-

мотехнични компоненти отпечатъци на корпуси /footprint/ за PCB не са намерени в за-

редените в паметта PCB библиотеки. Коригираме грешките, като избираме подходящи  

Footprint: за елекролитния кондензатор RB.2/.4, за неполярните rad0.2, за резисторите 

AXIAL0.4, за променливите резистори T93YA_. 

4.4. Прехвърляне на схемотехническата информация и разработка на печат-

на платка. Визуализация на елементите и свързващите печатни проводници. 

След замяната на корпусите на елементите с грешки отново изпълняваме командата 

Design → Update PCB Document Upr.3.PcbDoc. Ако няма предварително забелязани 

грешки натискаме бутона Validate Changes и ако статусът на всички елементи и връзки е в 

зелено в секцията Check финализираме прехвърлянето на информация с бутона Execute 

Changes.  
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Фиг.3.20. Преоразмеряване на габаритни размери на PCB. 

По нататък се повтарят стъпките описани в първото упражнение по отношение на 
разполагането на компонентите върху очертанията на печатната платка, като се спазват 
правилата за разполагането на елементите. След разполагане на елементите можем да 
променим размерите на печатната платка, така че те да са съобразени с площта на под-
редените и разположени елементи или да се спазят размерите ако има предварителни 
изисквания за тях. Един от начините за това е като се избере слоят Keep-out layer и с ин-
струмента Line се изчертават новите размери на платката. Следващата стъпка е да се се-
лектират всички елементи и се избере командата Design>Board Shape>Define from 
selected objects, както е показано на фиг.3.20. Използваме режим на автоматично опро-
водяване, като изпълняваме командата Route>Auto Route>All и от появяващия се екра-
нен прозорец избираме Default 2 Layer Board и натискаме бутона Route All.  

На фиг. 3.20 е представена опроводената печатна платка на разработваната схема, 
като на монитора ще се изобразят в червено печатните проводници на горния слой 
/Top layer/, а в синьо печатните проводници от долния слой /Bottom layer/. В жълто ще 
са очертанията на компонентите и означенията им /Top overlay/, което представлява 
слоя на т.н. „бял“ или сервизен печат на печатната платка. Ако отделните компоненти 
имат 3D модели, готовата печатна платка може да се разгледа и в 3D режим на изобра-
жение, достъпен чрез командата View>3D Layout Mode. 

 
Фиг. 3.21 Опроводена PCB на измервателна система с АЦП C520D. 
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Фиг. 3.22 PCB в 3D режим на измервателна система с АЦП C520D. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №4 

ЙЕРАРХИЧНИ СТРУКТУРИ В ALTIUM DESIGNER. ИЗРАБОТКА НА 

ПЕЧАТНА ПЛАТКА ОТ МНОЖЕСТВО СХЕМИ. 

1. Теоретична обосновка.  

 За провеждането на упражнението се предполага, че се владее работата със 

схеми и библиотеки в среда на Schematic Editor.  

В това упражнение, ще се разгледат следващите теми :  
 - Инструменти за организация на йерархични структури;  
 - Създаване на проект с множество схемотехнични документи; 
 - Създаване на печатна платка от множество схемотехнични документи.  
1.1. Инструменти за организация на йерархични структури. 

Символ на страница - Sheet symbol 
Избор чрез инструментното меню Wiring Tools 
Избор чрез главно меню: Place > Sheet symbol 

                  

Фиг. 4.1. Символ на страница. Символ от инструментното меню и разполагане на обекта в схемата. 

Използва се за да се изобрази подстраницата в един чертеж, от няколко йерархич-
ни страници. Големината на символа се задава при разполагането. 

След влизане в режим на разполагане, курсорът се позиционира и с щракване с ляв 
бутон или Enter се фиксира горният ляв ъгъл на обекта, след което курсорът се измества 
до получаване на желаната големина. С повторно щракване с ляв бутон символът се раз-
полага окончателно. Поставеният обект може да се редактира графично (след избор с 
еднократно щракване с левия бутон на мишката), както и да се променят с двукратно 
щракване с левия бутон на мишката. 

Вход-изход от друга страница - Sheet entry  
Избор чрез инструментното меню Wiring Tools  
Избор чрез главно меню: Place > Sheet entry 

     

Фиг. 4.2. Вход-изход от друга страница. Символ от инструментното меню и разполагане на обекта в схемата. 

Разполага се в Sheet symbol, за да се обозначат входно-изходните портове. Поради 
тази причина, преди да поставите Sheel Entry, е необходимо да сте разположили Sheet 
symbol-обекта. 
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След влизане в режим на разполагане, курсорът трябва да се позиционира върху то-
зи Sheet symbol, в който ще се разполагат входно-изходните портове. След щракване с 
ляв бутон, под курсора се появява изображението на Sheet entry. Обектът се позициони-
ра и разполагането се потвърждава с повторно натискане на ляв бутон на мишката. 

Sheet entry може да се разполага по всички ръбове на Sheet symbol. 
Схемен етикет - Net Label 
Избор чрез инструментното меню Wiring Tools  
Избор чрез главно меню: Place > Net Label 

 

Фиг. 4.3. Схемен етикет. Символ от инструментното меню и разполагане на обекта в схемата.. 

Чрез този етикет, към даден електрически обект се присвоява специфично наиме-
нование. При генериране на схемния списък за преминаване към печатна платка, автома-
тично се прави обозначаване на различните вериги. Ръчното разполагане на Net Label в 
схемата дефинира името на веригата, към която е привързан съответният обект. 

При влизане в режим на разполагане чрез избор от инструментното или от главно-
то меню, курсорът се позиционира и с щракване на ляв бутон или Enter обектът се раз-
полага. Чрез щракване с десен бутон на мишката или натискане на клавиша Esc от кла-
виатурата, може да се излезе от режима на разполагане. С натискане на TAB от клавиату-
рата, по време на разполагането могат да се редактират характеристиките на обекта. Ха-
рактеристиките на вече разположен етикет могат да се двукратно щракване върху него с 
ляв бутон. 

1.2. Създаване на проект с множество схемотехнични документи. 

Проектантите използват многостранични проекти по различни причини, на първо 
място заради размерите на схемите; някои проекти са прекалено големи или сложни, за 
да се поместят на един лист. Даже ако проектът не е толкова сложен, определено има 
преимущества в това проекта да е на няколко страници. Например, проектът може да 
включва елементи от различни функционални модули. Организацията на тези модули 
като самостоятелни документи позволява на няколко инженери да работят над проекта в 
едно и също време. Друга причина може да бъде това, че този метод позволява да се из-
ползват малоформатни принтери, такива, като лазерния принтер. 

Като цяло, имаме две решения за изпълнение на всеки многостраничен проект - 
структурни връзки между страниците и метод с употребата на свързаност между фраг-
ментните схеми на тези страници. Конкретния избор ще зависи от размера и типа на 
всеки проект и собствените предпочитания на потребителя. 

Формиране структурата на страницата. 
Тъй като проектният файл свързва различни изходни документи в единен проект, 

отношенията между документите и непосредствената свързаност се определят от ин-
формацията в самия документ. Многостраничният проект се формира като йерархическа 
структура от логически блокове, където всеки блок може да бъде или страница със схема, 
или файл във формат HDL. В началото на тази структура се намира единствен главна 
страница на схема, най-често разглеждна като най-горна страница на проекта. 
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Структурата на страницата се формира с използването на специални символи, на-
речени символи на схемотехнчната чертожна страница. Всеки от изходните документи, 
които се отнасят до даден проект, се представят на най-горната страница с помощта на 
специален символ. Името но всеки символ на страница съответства на подчинения файл 
на схемата (или файл тип HDL), който той представя графически. От друга страна, под-
чинената схема може да съдържа други символи на чертожни страници, които съответст-
ват на по-ниско ниво на чертожни страници от схемата или файлове тип HDL. По такъв 
начин, може да се сформира структурна йерархия на изходните документи, която може 
да бъде проста или сложна, в зависимост от изискванията на заданието. 

При компилация на многостраничния проект, се осъществяват логически връзки 
между модулните блокове на проекта и се създава структура. Тази дървовидна структура 
започва със страницата от схемата на върха и разклонения за всички други подчинени 
схеми и файлове HDL на всяко от нивата. 

 
Фиг. 4.4. Компилиране на многолистови проекти, показващи йерархията. 

Фиг. 4.4 показва 2 примера на компилиране на йерархични проекти. От лявата 
страна се намира структурната йерархия за компилиране проект на платка (*PrjPcb). От 
дясната страна се намира структурна йерархия за компилиране на проект тип ПЛИС 
/Програмируема логическа интегрална схема/ (*.PrjFpg). 

Създаване на йерархически структури 
Средата за проектиране съдържа редица свойства, които позволяват бързо и леко да 

се сформира многойерархична структура на проекта. Конкретните задаваеми свойства  
зависят от персоналната методология на проектирането – от горе надолу или от долу на-
горе. 

1. Проектиране « от горе надолу ». 
По надолу са показани достъпните команди за създаване йерархията на проекта във 

вариант «от горе надолу»: 
Create sheet from symbol (Създаване на страница от символ) – използва се от редак-

тора на схеми за създаване на чертожна страница от символ. В подчинената страница 
трябва да се добавят съгласувани портове, готови за опроводяване. 

Create VHDL file from symbol (Создание файла тип VHDL от символ) - използва се 
от редактора на схеми за създаване на VHDL файл, с обекти, които съдържат определе-
ни портове за съответствие с входовете на страницата в създадения символ. 

Create Verilog file from symbol (Создание файла тип Verilog от символ) - използва се 
от редактора на схеми за създаване на Verilog файл, с декларирани модули, , които съ-
държат определени портове за съответствие с входовете на страницата в създадения сим-
вол. 
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Push part to sheet (поставяне на компонент в страница) - тази команда на схемотех-
ничния редактор се използва за добавяне на секция в нова подчинена страница от схема-
та, съдържаща оригиналната секция на главната страница във вид на символ, препращащ 
на нова подчинена страница. Съответстващите портове ще бъдат добавени и съединени 
с проводници към секциите на подчинената страница. За достъп  на тази команда натис-
нете  ДБМ върху компонента. 

2. Проектиране « от долу нагоре ». 
Следващите команди позволяват да се построи йерархия на проекта във варианта 

«от долу нагоре». 
Create symbol from sheet or HDL (Създаване на символ на страницат от схема или 

HDL) – използва се от схемотехничния редактор за създаване на символ като страница 
от схема, VHDL или Verilog-описание. Трябва за се създаде страница от схемата, на кой-
то ще бъде поставен  символ на активния документ преди изпълнение на командата. 

Convert part to sheet symbol (Конвертиране компонент в символ на страница) – 
командата се използва от схемотехничния редактор за конвертиране на даден компонент 
в символ на страница. Полето на символното обозначение в началото ще бъде устано-
вено в позиционно обозначение на компонента, в поле Filename с  текст на коментара 
към компонента. Трябва да се измени името на файла за връзка с необходимия подчине-
на страница, като се изменят входовете на листа в съответствие с портовете, зададени в 
подчинения документ. Натиска се ЛКМ върху компонентя за достъп към тази възмож-
ност. 

Смесенна схемно-текстова (HDL) йерархия на документа 
При създаване на йерархията на проекта може да се използва символ на страница 

на родителската страница на схемата, за връзка с подчинената страница на схемата на 
ниско ниво. Тази йерархия може да бъде разширена, когато за формиране на проекта 
бъдат използвани съчетание от схемни страници и страници с описания на езика HDL. 
Подчинените документи във вида VHDL или Verilog – описания, също се представят ка-
то подчинени схеми, описващи имената на подчинените документи в символа на стра-
ницата, която ги представя. 

При връзка към подчинения документ  тип VHDL, тя се формира от символ на 
страница към описание на обектите във файл тип VHDL. За връзка към обект с име, ко-
ето се отличава от името на VHDL файла, се включва параметъра VHDLEntity в симво-
ла на страницата, значението на когото се явява име на обекта, описан във VHDL файла. 

  
Фиг. 4.5. Иерархически документ, създанен чрез поставяне на символ на лист за представяне на документ от нис-

ко ниво на йерархията във вид на схема (отляво) и във вид HDL (отдясно). 
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Фиг.4.5. илюстрира пример на такава смесена йерархия, посредством която един 
символ на страница се използва за връзка към подчинената страница на схемата в първия 
пример и на подчинения VHDL документ в другия. И в двата случая, подчинения доку-
мент представлява едно и също физическо устройство (брояч). След определяне на 
структурата на йерархическия многолистов проект е необходимо да се изпълни устано-
вяване в Altium Designer по указанията за компилация и съгласуване на портовете. 

Синхронизация на портовете на схемата и входовете на страницата. 
Символ на страница се явява документ, синхронизиран с неговата връзка към под-

чинените страници в по-ниското ниво на йерархията, всички входове на тази страница 
трябва да съвпадат със съответстващите портове на подчинените страници - както по 
име, така и по направление. Трябва да се използва диалога Synchronize Ports to Sheet 
Entries (фиг.4.6) за установяване символа на страница в съответствие с портовете на 
главната схема, за това се избира Synchronize Sheet Entries and Ports от меню Design. 

 
Фиг. 4.6. Обезпечение на синхронизацията на входовете на листа и портовете на схемата. 

Преименуване на символа на страница в подчинения лист. 
В процеса на проектиране често възниква необходимост от изменение на името на 

подчинената страница на схемата, например е необходимо да се измени схемата и да се 
зададе друго название за по-пълно отразяване на функцията и. Вместо това, за да се пре-
именува схемата и след това ръчно да се изменят връзките към всеки символ на страница,  
по - просто е да се използва командата Design>Rename Child Sheet. 

С помощта на тази команда може да се: 
• преименува подчинен документ и обновят всички действащи символи на страни-

ците на даден документ в текущия проект; 
• преименува подчинен документ и обновят всички действащи символи на страни-

ците в текущата група проекти (*.DsnWrk); 
• създаде преименувано копие на подчинения документ и да се обнови текущия 

символ на страница с указаните връзки на него. 
Освобождаване на пространство в схемите от ниско ниво. 
С един символ на чертожна страница може да се представят няколко подчинени 

страници. За това е нужно да се разделят имената на символите на страниците в полето 
Filename (фиг.4.7). С помощта на ефективното използване на междулистовите съедини-
тели, поставени в подчинените страници, може значително да се расширят възможнос-
тите на проекта, като не се увеличива количеството страници, а се разглеждат всички 
страници, като една цяла. Трябва да се отбележи, че използването на между странични 
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съединители е единствено възможния 
метод за реализация на свързаност меж-
ду схемите, свързани с един и същ сим-
вол на страница. 

Реализация на глобална свърза-
ност. 

Единствения метод за предаване на 
сигнали между страниците е използва-
нето на идентификатори на електричес-
ки вериги /връзки/. Те се явяват обекти, 
които създават логически съединения 
между различни обекти по-просто, от-
колкото това правят физическите съе-
динения (проводници). Идентификато-
рите на веригите могат да се използват 
локално в пределите на една страница, 

както е показано по-долу, но главното предназначение на дадените обекти – това е реа-
лизацията на глобална връзка за всеки проект. 

 
      връзки    означение на връзки      портове       силови портове 
Тези примери показват, как могат да се реализират проводници с помощта на 

обикновени връзки, означение на връзки, портове и силови портове, съответно. Всички 
тези обекти са обединени чрез общо название на идентификаторите на връзките.  

По долу е илюстрирана честата грешка: идентификаторите на връзки от различен 
тип (такива като отбелязване на електрически вериги и портове) ще бъдат логически 
свързани, ако имат еднакви имена. Фактически това не е така: различните типове иден-
тификатори на връзките могат да имат различни имена, но да се съединяват заедно за 
формиране на една електрическа верига. 

 
Тези диаграми засягат идентификатори на връзки, физически съединени на един 

лист, но те не могат да покажат това, че идентификаторите на връзките дават възмож-
ност за предаване на връзки между страниците в многостраничните проекти. Как става 
това зависи от идентификаторите на връзките, използвани в проекта и установените ог-
раничения. 

Идентификатори на връзките. 
Повечето идентификатори на връзки са от тип отбелязване на електрическа верига. 

Тяхната основна функция е да отразяват функционалното предназначение на съедине-

 
Фиг. 4.7. Пример за единичен символ на лист, свър-

зан с няколко подчинени листове. 
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нията и проводниците на листа. Тъй като има начини и обстоятелства, при които отбе-
лязванията на електрическите вериги могат да изпълняват функцията на връзки между 
чертожните страници, може да се използват за локални съединения и такива в рамките 
на чертожната страница. 

Портовете, подобно на отбелязванията на веригите, винаги ще се използват за съе-
диняване на локални връзки в един и същ документ. Но за разлика от отбелязването на 
веригите, портовете специално са предвидени за междустранични съединения. Те могат 
да се разполагат хоризонтално или вертикално. Хоризонталното разполагане е широко 
разпространена опция, тъй като не е чувствителна към многостраничната структура и 
съединява портове с еднакви имена в цялото пространство на проекта в една електричес-
ка верига. Вертикалните съединения са по-управляеми, тъй като те съединяват сигнали 
само между подчинени и родителски страници. Вместо съединения на порт с порт, вер-
тикалните съединения се изпълняват за съединения между порт на подчинената страни-
ца и вход на страница на родителския документ. Този вход на страницата трябва да бъде 
разположен в пределите на символа с връзка към специфчна подчинена страница. 

Междустраничните съединители обезпечават средно звено, позволяващо да се съз-
дават хоризонтални връзки между избрани групи страници в пределите на проекта. На-
чина на групиране на тези страници е чрез разполагане на имената им в полето Filename 
на символа на главната страница, разделени с точка и запетая. Нужно е да се разположат 
междустраничните съединители за тези сигнали така, че да се намират между тези групи 
страници (както на фиг. 4.7). Междустраничните съединители ще бъдат съединени с ед-
накви междустранични съединители, но само в пределите на страниците, групирани за-
едно на родителския символ. Ако една и съща подчинена страница е представена на 
символа, тогава неговите междустранични съединители няма за бъдат съединени с едно-
типни съединители, които могат да съществуват в друго място на проекта. 

Силови портове (наречени още силови обекти) - не са чувствителни към структура-
та на проекта и съединяват еднакви силови изводи на всички свързани листове. 

Невидимите изводи могат да бъдат въведени за символ в библиотеката и включени 
към определена верига, посредством установяване на стойност в полето Connect to (в ди-
алога Pin Properties). Ако се импортира проект от Protel 99 SE или по-ранна версия, то 
всеки невидим извод ще има име на електрическата верига, разположено в това поле. 

 

Отбелязване 
на верига 

Съединение по вертикала, ако се използва съвместно с пор-

тове или символи на страници,  използвани или в рамките 

на йерархията, или вътре в документа. По хоризонтала се 
обединяват всички вериги с еднакви означения. 

 

 

Порт 

Съединение по вертикала, ако е използвано за вход в стра-
ница на главния символ и е използваемо или в йерархията, 
или вътре в документа. Той съединява по хоризонтала всич-
ки еднакви портове, или ограничен брой портове вътре в 
указания документ. 

 

 

Вход на стра-
ница 

Винаги се съединява вертикално към порт на лист на под-
чинената схема, посочена на символа. 

 

 

Междустра-
ничен съеди-

нител 

Хоризонтално съединение на еднакви междулистови съе-
динители, но ограничено по отношение на лист, посочен на 
друг, разделен символ на лист. 

 

 

Силов 
Порт 

Съединява глобално всички еднакви силови портове на 
всички пространства на проекта 

 
Невидим  

извод 
 

Съединява глобално всички невидими изводи на проекта, 
които имат означение Connect to 
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Инверсни идентификатори на електрически вериги. 
Ако има необходимост от създаването на отбелязване на вериги, входове на стра-

ница или портове със знак за инверсия (чертичка над текста), това може да се направи по 
два начина: 

• Въвежда се символ «\» след всеки символ в името на веригата (например, 
E\N\A\B\L\E\) 

• Активира се опцията Single ‘V Negation на частта Schematic>Graphical 
Editing в диалога DXP>Preferences, след това се въвежда един символ «\» в началото на 
името на веригата (например, \ENABLE). 

Равнинна или йерархична свързаност. 
В рамките на структурата на документа, всички многостранични проекти са органи-

зирани йерархически, даже ако йерархията има само две нива (например, горната стра-
ница, съдържаща всички символи, които го свързват с подчинените страници от ниско 
ниво). Като свързан, проектът може да бъде реализиран или като на едно ни-
во/равнинен/, или като йерархическа структура. Основната разлика между тях се явява 
това, че йерархическите проекти включват сигнали между страници, съответстващи на 
създадената структура, а равнинните проекти не предлагат структурна организация на 
чертожните страници. 

Важно е да се отбележи, че при проектиране на проект тип ПЛИС, използвания 
модел на свързаност трябва да бъде йерархичен. 

Равнинни проекти без страница тип „блок-схема“. 
Ако разработвания проект не е йерархичен - например, всички страници на схемата 

се намират на едно и също ниво, без символи, отправящи на подчинени схеми - проекта 
е прост равнинен проект. В този случай, няма необходимост от страница тип „блок-
схема“, която съдържа само символи на страници. Необходимост от наличие на страни-
ца от горно ниво възниква при отсъстствие на файл на проекта, а файла на проекта тип 
„програмно осигуряване“ зависи от символите на страници на листа от горно ниво, за да 
се определи какви страници съдържа проекта. За тест на такъв проект без страници от 
горно ниво, се кликва върху името на файла на панела Projects и се избира Remove from 
Project от падащото меню. 

Равнинния проект, който вече съдържат страница от по-горно ниво, ще бъде ко-
ректно компилиран, но Altium Designer предоставя възможност за проекти без горна 
страница по необходимост. 

Примери за проекти по тип свързаност. 
Четири илюстрации по-долу, показват как да се определят или изберат ограниче-

ния за идентификаторите, които ще оказват въздействие на свързаността на еднаквите 
отбелязвания на вериги и портове в йерархическите структури. Петата показва, как се из-
ползват междустраничните съединители. В названията на примерите е посочена наст-
ройка за ограниченията на действията на идентификаторите, които се определят в спи-
съка Net Identifier Scope на секцията Options, достъпна в диалоговото меню Options for 
Project, което се извиква от изпълнението на Project>Project Option. 

Пример 1 - Hierarchical (Йерархически). Този схемен проект ще бъде автома-
тично определен като йерархически вариант, тъй като тук са разположени входовете на 
страниците в символите на страниците на главната страница. Отбелязванията на вериги-
те С1 и С2 на всяка подчинена страница няма да бъдат включени към съответстващите 
отбелязвания на вериги на главната страница, но ще се съхранят в пределите на техните 
локални страници. Портовете в този пример имат различни имена, но даже да имат съв-
падащи имена, те не могат да създадат хоризонтални връзки с други портове на подчи-
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нените страници, при въздействие на ограничение на идентификаторите на дадения тип 
йерархия. Затова, портовете създават само 
вертикално странично съединение към 
родителската страница. За да изпълни съ-
единение, порта на подчинената страница 
трябва да има едноименен вход на страни-
цата вътре в съответстващия символ на 
страница. 

В този пример, елементите на входо-
вете на главната страница са свързани към 
различни страници (трябва да се отбеле-
жи, че техните имена не са еднакви; това е 
физическо свързване, а не логическо). В 
структурно отношение относно прерабо-
тения проект, тези сигнали се свързват към 
портовете и се сравняват по вход с другия 
символ на страница на по-високо роди-

телско ниво на страницата. 
Пример 2 - Flat (Глобални портове) 
За представяне на портовете в този проект, съвместно с отсъстствието на каквито и 

да е входове на старници, използва се ва-
риант за автоматично определяне на гло-
бални портове. Това е особеност на рав-
нинен тип проект, тъй като портовете се 
явяват свързани; те получават логически 
връзки с всички портове със съвпадащи 
имена в произволно място в проекта. От-
белязванията на вериги не поддържат та-
кива възможности; те ще бъдат локални 
на отделните страници. 

Тъй като този проект е равнинен, 
върхната страница /блок-схемата/ може 
да се премахне от проекта и въпреки това 
той ще бъде коректно компилирон. Тряб-
ва да се отбележи, че Altium Designer из-

ползва файл тип проект, за да определи количеството на чертожни страници в проекта, 
което се явява важно свойство на понятието проект и е необходим за равнинен тип раз-
работки с ограничение на идентификаторите тип Flat. 

Пример 3 - Междулистови съединители (OffSheet) 
В този пример, горната страница тип „блок-схема“ се свързва с 4 подчинени стра-

ници с помоща на само два символа. Това се изпълнява с помоща на връзка към файло-
вете на няколко схеми чрез полето Name на символите на страницие, разделяйки имена-
та на схемите с точка и запетайка. Междустраничните съединители създават равнинни 
съединения между всички сгрупирани страници в пределите на един символ на страница 
- даже ако другите страници в проекта използват аналогична вертикална свързаност. 
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Групираните страници не из-
ползват други идентификатори на 
веригите, с изключение на междуст-
раничните съединители. Тези съе-
динения се разполагат само в преде-
лите на групите. 

Много разработчици никога не 
използват междустранични съедини-
тели, които първоначално са били 
въведени като средство за импорт на 
проекти, от други пакети за проекти-
ране. Въпреки това може да възникне 
ситуация, когато те са удобни. Нап-
ример, да предположим, че имаме 
високомодулен проект, в който всяка 
страница представлява логическа 
част на проекта. Разполагането на 

символи на страниците не просто ще създава желаната свързаност, но ще обеспечи на 
другите участници в разработката на проекта добро разбиране за целия проект. Ако си 
представим, че схемата вътре в един такъв функционален блок излиза от пределите на 
една чертожна страница, за да я поместим в йерархията, е необходимо да разположим 
необходимия брой отбелязвания на вериги, които трябва да се прехвърлят от страница 
на страница с портове, които ще ги предават нагоре на съответния вход на страницата, 
които се съединяват с проводниците. Това е трудно изпълнимо, като не вземаме под 
внимание  факта, че проекта ще бъде разделен на два символа на страници, които логи-
чески са неразличими, а всичко това идва от факта, че размера на чертожната страница е 
малък. Коректна алтернатива се явява такова разполагане на отбелязванията на веригите, 
което позволява нормално да се създават връзки към тези части на проекта с помощта на 
междустранични съединители. Групирането на няколко страници ще позволи да се съх-
рани функционалната блок-схема на потока данни на проекта, съгласувано с пълната не-
гова логика. 

1.3. Създаване на печатна платка от множество схемотехнични документи. 

Преозначаване на компонентите в схемата. 
За да може да се осъществи безпроблемно 

преобразуване на схемата в печатна платка (РСВ-
формат), всеки елемент трябва да има свое уни-
кално означение (сигнатура). Ако при разполага-
нето на елемента в схемата не е въведено конкрет-
но означение, той ще се разположи с означение 
от типа “R?*\ Процесът на преозначаване се на-
рича Annotation и може да бъде осъществен във 
всяка фаза на изчертаването, но е задължително 
да се направи, когато чертежът е завършен. За 
преозначаване на елементите, от главното меню 
трябва да се избере Tools > Annotation, при кое-
то ще се отвори диалоговият прозорец Annotate 

(фиг. 4.8). 
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От падащото меню Annotate Options се задава обсега на преозначаването, като са 
достъпни следните възможности: 

All parts - преозначаването ще обхване всички елементи в проекта: 
? parts - отнася се за означението на тези елементи от схемата, които имат текуща 

сигнатура от типа R?, С?, U?, т.е. само за елементите, за които не е въведено означение 
при изчертаването на схемата. 

Reset Designators - установява всички означения обратно във вида R?, С?, U?... Из-
ползвайте тази команда, ако желаете преномериране на всички компоненти, започвайки 
от 1. Някои компоненти могат да бъдат изключени от процеса на означаване чрез пред-
варителното им избиране. За целта е необходимо, в диалоговия прозорец Annotate (виж 
фиг. 4.4), да се разреши опцията Ignore Selected Parts. За да се идентифицират и групи-
рат многоелементни компоненти, по време на обозначаването им е необходимо да се ус-
танови Group Parts Together If Match By-полето (групиране на елементи при подобие на 
..). По подразбиране е зададено групиране само при подобие на гипа на елементите, но 
могат да се използват комбинации от 16 елементни полета и 8 библиотечни текстови 
полета за идентифициране на групата. Ако например използвате двоен операционен 
усилвател, който трябва да бъде групиран, редактирайте характеристиките на всеки един 
от съставящите го усилватели и въведете низ в едно от полетата (Part Fields), което го 
идентифицира. 

 
Фиг. 4.8. Означаване на компонентите. 

Например бихте могли да въведете “Stage 1” в поле 16 и за операционния усилва-
тел. Когато се изпълнява преозначаването, разрешете поле 16 (Part Field 16) в таблицата 
Group Parts Together If Match By на диалоговия прозорец Annotate. Ако имаме още един 
операционен усилвател, това ще осигури групирането на тези два операционни усилва-
теля в общ физически компонент. 
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Фиг. 4.9 Преномериране на елементите в схемата. 

Схемните компоненти ще бъдат означени (номерирани) на базата на тяхното раз-
положение в схемата. Позицията на всеки компонент е определена чрез отстоянието му 
от краищата на схемната страница. 

 
Включване на РСВ-информация в схемата 
При подготовката на схемата за преминаване към печатна платка, е възможно 

включването на допълнителни PCВ-подробности в схемния документ, чрез прикрепва-
нето на Рarameter Set-директиви Place/Directives. Тази информация ще бъде приведена в 
чертожните правила, когато чертежът ще се преобразува от PCВ-редактора. 

 

 
Фиг. 4.10. Предварително задаване на PCВ-параметрите за дадена верига. 

След разполагане на директивата (така, че долната точка на символа да докосва ве-
ригата, за която се отнася), трябва да се редактират обектните характеристики. За целта е 
необходимо, с двукратно щракване върху символа на обекта, да се отвори диалоговият 
прозорец Properties (фиг. 4.10), в който могат да бъдат зададени следните параметри: 

- Track Width - указва широчината на шината, чрез която трябва да бъде осъщест-
вена тази верига; 

- Hole Size Constraint - указва диаметъра на кой да е отвор (преход, via), използван 
при осъществяването на дадената верига; 

- Topology - указва топологията на свързване, използвана при тази верига; 
- Priority - указва приоритетите, които ще бъдат спазвани при прокарването на та-

зи верига; 
- Layer - използва се, за да се забрани прокарването на тази верига по определен 

слой. 
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2. Цел на лабораторното упражнение. 
Да се усвои създаването на йерархични структури в Altium Designer. Създа-

ване на печатна платка от множество схеми. 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема. Въвеждане на елементи-

те, опроводяване и ERC проверка.  

3.2. Запознаване с инструментите и методологията за работа с йерархични 

структури. Създаване на блок-схеми и подчинени подсхеми. 

3.3. Прехвърляне на схемотехническата информация и разработка на печатна 

платка от главната схема /блок-схемата/. Визуализация на елементите и свързва-

щите печатни проводници. 

4. Указания. 
4.1. Запознаване с принципната електрическа схема и елементите на отделни-

те модули към измервателна система с АЦП C520D. Въвеждане на елементите, оп-

роводяване и ERC проверка. 

Схемата на отделните модули към измервателна система с АЦП C520D са предста-

вени на фиг. 4.11. Първия модул е резистивен делител /атенюатор/ свързан с механичен 

превключвател, за измерване на напрежения по-високи от максималното входно напре-

жение на АЦП C520D от 2V. Тъй като механичния превключвател трябва да е достъпен, 

той обикновено не се разполага непосредствено на печатната платка. Следователно при 

проектирането трябва да разположим на PCB само резисторите от делителя и куплунг за 

връзка с превключвателя, като броя изводи на куплунга трябва да съвпада с броя изводи 

на превключвателя. Следващата схема е на модула представляващ входен предусилвател 

за осигуряване на високовходно съпротивление към АЦП, реализиран с операционен 

усилвател ИС B081D, разработка на ГДР, аналог на TL081, производство на Texas 

Insruments. В захранващата верига на предусилвателя е включен двузвенен изглаждащ 

филтър за предовратяване на смушения по захранване. Третата схема представлява пре-

образувател на температура в напрежение. Реализиран е със същите операционни усил-

ватели, като използва и транзистор SC308C, разгледан в предното упражнение.  

 
Фиг.4.11. Принципни електрически схеми на отделните модули към измервателна система с АЦП C520D. 

 

Като се спазват правилата за търсене на компоненти в библиотеките на AD описа-

ни в т.1.2 на Лабораторно упражнение №2 може да се направи търсене на TL081, в биб-
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лиотеките на Texas Insruments. Използваме създадения библиотечен елемент за транзис-

тора SC308C, съгласно т.4.2. на упражнение №3. 

За пасивните елементи и ценеровите диоди използваме стандартни означения, кои-

то са разположени в библиотеката BDS-ISO.Intlib. Названията на елементите в библио-

теката са съответно Резистор, Резистор потенциометър, Кондензатор неполярен, и Диод 

ценеров. За да се свържат проводниците с изходния сигнал Ue , захранването +Us и ма-

сата GND трябва да използваме куплунзи от типа Header2, като трябва да се поставят съ-

ответните Power port символи за захранване и маса, като се променя Net на съответния 

символ. За по добра функционалност разделяме схемата от фиг. 4.11 на 2 части – дели-

телят и входният усилвател, заедно с филтъра в схема 2, а преобразувателят на темпера-

тура в напрежение - температурният сензор, заедно с операционните усилватели - в схе-

ма 3. Схема 1 от проекта е схемата с АЦП C520D от предходното упражнение. Обединя-

ваме схемите в един проект, например Upr.4.prjpcb. Проверката за грешки се извършва 

по същия начин, описан в предното упражнение: от Design → Update PCB Document 

Upr.3.PcbDoc при което се отваря прозореца Engineering Change Order. Натискаме буто-

на   и отметката на Only Show Errors и получаваме прозорец със съобщенията 

за грешки, които отстраняваме. Окончателния вид на двете схеми в AD е показан на 

фиг.4.12. 

 

 
Фиг.4.12. Принципни електрически схеми на входен предусилвател и преобразувател на температура в напреже-

ние въведени в AD. 

4.2. Запознаване с инструментите и методологията за работа с йерархични 

структури. Създаване на блок-схеми и подчинени подсхеми. 
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За създаването на блок-схема, която обединява отделните подсхеми на проекта из-
ползваме инструментите описани в точка 1. Започваме със създаването на нова схема в 
проекта Схема 4, която трябва да обедини останалите три схеми. Изчертаваме блоковете, 
съответстващи на отделните схеми с използването на инструмента символ на страница - 
Sheet symbol, чрез командата Place > Sheet symbol или чрез съответната икона. Връзки-
те между отделните модули осъществяваме чрез вход-изход от друга страница - Sheet 
entry, чрез командата Place > Sheet entry или съответната икона. Общите връзки са зах-
ранванщите изводи: двуполярно напрежение +Us, -Us и масата GND, както и входния 
сигнал за АЦП – Ue. Общия вид на блок-схемата е показан на фиг.4.13. За да се уверим, 
че има връзка между създадената блок-схема и отделните подсхеми използваме инстру-

мента за навигация  или чрез командата Tools\Up/Down Hierarchy. При правилно 
въвеждане на имената на съответните схеми при кликване върху съответстващите им 
блокове би трябвало те да се отворят на екрана. 

 
Фиг. 4.13. Блок-схема на измервателна система с АЦП C520D.   

4.3. Прехвърляне на схемотехническата информация и разработка на печат-

на платка от главната схема /блок-схемата/. Визуализация на елементите и свър-

зващите печатни проводници. 

Създаваме нов файл тип PCB, като използваме командата File → New → PCB, ка-

то е желателно създадения файл PCB1.PcbDoc да бъде преименуван, например в 

Upr.4.PcbDoc. Прехвърлянето на информация към PCB става от блок-схемата Sheet4 

blog shematic projekt.Schdoc с командата Design → Update PCB Document 

Upr.4.PcbDoc при което се отваря прозореца Engineering Change Order. Получава се 

прозорец, съдържащ много съобщения за грешки като този, показан на фиг.4.14. Ведна-

га можем да забелеим, че има дублиране на означенията на отделните елементи. За да се 

избегне това трябва да се променят означенията на дублираните елементи в отделните 

схеми. За да стане това по-лесно използваме командата в AD за автоматично наименова-

ние на елементите Annotate Schematic, като за лесна идентификация на отделните еле-

менти се препоръчва индекса на отделните елементи да е свързан с номера на схемата, 

например означенията на елементите от първата схема да започват  с 1ХХ, от втората 

схема с 2ХХ и от третата с 3ХХ. За целта след отваряне на прозореца в резултат на из-

пълнение на командата Tools\Annotate\Annotate Schematics, показан на фиг.4.15, 
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чекваме срещу всяка схема Designator Index control и попълваме съответно за Star index 

101, 201 и 301 съответно. Кликваме последователно на бутоните Reset All и Update 

Changes List при което нулираме съществуващите означения и ги заменяме с нови, като 

номерата които се присвояват в означенията зависят от позиционното разположение на 

елементите в схемата и избрания метод за означаване от секцията Order of Processing. За 

да потвърдим предложените нови означения кликваме върху бутона Accept Changes. 

 
Фиг.4.14. Прозорец на съобщенията за грешки.   

 
Фиг.4.15. Автоматично преозначаване на елементите от трите схеми в проекта.   

 На следващия прозорец кликваме последователно върху Validate Changes и Execute 

Changes. За съхраняване на промените в трите схеми едновременно, изпълняваме 

File\Save All. 

 След замяната на означенията на елементите отново изпълняваме командата 

Design → Update PCB Document Upr.4.PcbDoc. Ако няма предварително забелязани 

грешки натискаме бутона Validate Changes и ако статусът на всички елементи и връзки 
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е в зелено в секцията Check финализираме прехвърлянето на информация с бутона 

Execute Changes.  

По нататък се повтарят стъпките описани в първото упражнение по отношение на 

разполагането на компонентите върху очертанията на печатната платка, като се спазват 

правилата за разполагането на елементите.  

Преди разполагане на елементите променяме размерите на печатната платка съоб-
разени с подходяща куия, където да се разположи. Избираме разпространената в търгов-
ската мрежа кутия с размери 110х90х50. Вътрешните размери са 98х84, като са предвиде-
ни 5 отвора за закрепване на печатната платка, 4 на 5 mm от ръбовете на платката и един 
централен така, че те да са съобразени с площта на подредените и разположени елемен-
ти или да се спазят размерите, ако има предварителни изисквания за тях.  

Използваме режим на автоматично опроводяване, като изпълняваме командата 
Route>Auto Route>All и от появяващия се екранен прозорец избираме Default 2 Layer 
Board и натискаме бутона Route All.  

На фиг. 4.16 е представена опроводената печатна платка на разработваната измер-
вателна система, заедно с крепежните отвори, а на фиг.4.17 и 3D изгледа. 
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Фиг. 4.16. Опроводена PCB на измервателна система с АЦП C520D. 
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Фиг. 4.17. PCB в 3D режим на измервателна система с АЦП C520D. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №5 

ИЗРАБОТКА НА ПЕЧАТНА ПЛАТКА С ПОМОЩТА НА WIZARD В 

СРЕДА ALTIUM DESIGNER. 

1. Теоретична обосновка. Проектиране на електроннeн възел в 

3D като печатна платка  
1.1. Прехвърляне на електрическата схема към печатната платка 

 Преди да се прехвърлят елементите към печатна платка (PCB) тя трябва да се 

създаде и конфигурира. Това 

става като в долният ляв ъгъл на 

работният екран се превключи 

левия панел от „Projects” към 

„Files”. След превключването на 

менюто от полето с шаблони се 

избира „PCB Board Wizard”. 

Чрез тази функция се създава 

печатната платка. Като се стар-

тира функцията „PCB Board 

Wizard” се отваря диалогов про-

зорец, в който се въвеждат пос-

тъпково параметрите на печат-

ната платка на електронният възел. Тази функция представлява автоматичен помощник, 

който улеснява изготвянето на печатната платка. 

1.2. Конфигуриране и създаване на печатна платка 

Чрез автоматичният 

помощник в няколко стъпки 

се създава и конфигурира 

печатната платка. Това е 

представено в следващите 

няколко фигури. 

Фигура 5.1 представя 

началният екран на автома-

тичният помощник. Про-

дължава се чрез натискане 

на бутона . 

На фигура 5.2 се вижда 

диалоговият прозорец, в 

който се избира типа на 

 

Фиг. 5.1. Начален екран на автоматичния помощник. 

 
Фиг. 5.2. Избиране на мерни единици 
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мерните единици за мащабиране на платката. Избира се те да бъдат „Metric” – работа в 

милиметри (мм). Продъл-

жава се с бутон . 

Следващата стъпка 

показана на фигура 5.3 е 

избор на размера на пе-

чатната платка. Избира се 

да бъде зададена ръчно – 

„Custom”. Продължава се 

с бутон . 

В диалоговият про-

зорец на фиг. 5.4 се зада-

ват размерите и формата 

на платката, както и ши-

рочините на отворите. 

Тъй като изработваният 

електронен възел включва 

малък брой елементи и те 

не са големи по обем се 

задава размера на платката 

да е 50мм х 50мм (5см х 

5см). След задаване на 

размера се продължава с 

бутон . 

В стъпката от фиг. 

5.4 се избира броят на 

сигналните и захранващи-

те слоеве. Не се налага 

промяна и се преминава 

към следваща стъпка с бу-

тон . 

 

 

 

Фиг. 5.3. Определяне размер на платката 

 
Фиг. 5.4. Задаване на размери на платката 

 
Фиг. 5.5. Избор на брой слоеве 

 
Фиг. 5.6. Избор на типа на отворите 
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В тази стъпка се избира какъв тип трябва да бъдат отворите на печатната платка. 

Избира се те да бъдат „Thruhole Vias Only” – цялостни отвори. Продължава се с бутон 

. 

 
Избира се броят на пистите минаващи между компонентите и типът на компонен-

ти, които ще се използват. В случая се избират компонент монтиращи се в отвори 

(Trough-hole components) и брой на пистите – една (One track). Преминава се към след-

ващата стъпка с бутон . 

В стъпката представена на фи-

гура 5.8 е се задават размери на отво-

рите, дебелина на пистите и мини-

малното разстояние между пистите. 

След задаването на размерите се про-

дължава с бутон . 

Това е последната стъпка пред-

ставена на фигура 5.9. След натиска-

не на бутона  се завършва със 

създаването и конфигурирането на 

печатната платка. Тя се визуализира 

на екрана и вече могат да бъдат прех-

върлени електронните елементи в 

нея. 

1.3. Прехвърляне на електронните елементи към печатната платка. 

След като бъде изчертана 

електронната схема в редактора за 

електронни схеми, тя трябва да 

бъде прехвърлена към печатната 

платка и да се завърши електрон-

ният възел. За да бъде прехвър-

лена електронната схема към пе-

чатна платка задължително усло-

 
Фиг. 5.8. Размери на отворите 

 
Фиг. 5.7. Избор на брой писти и тип монтаж. 

 
Фиг. 5.9. Завършване на печатната платка. 

 
Фиг. 5.10. Съобщение за различия. 
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вие е файлът, в който ще се изготвя печатната платка (PCB файла) да бъде запаметен. В 

противен случай Altium Designer изписва, че съответният файл не съществува. 

Прехвърлянето става от меню Design → Update Schematic in PCB Project. След 

стартирането на тази функция Altium Designer сравнява електронните елементи в двата 

файла – електронната схема и печатната платка. В случая във файла с печатната платка 

няма никакви елементи и на екрана се изписва съобщение за броят различия между 

файловете – фигура (5.11). За да се разгледат различията се избира бутон  (фигура 

5.12), в противен случай се избира бутона . 

 
Фиг. 5.11. Визуализиране на различията. 

След като бъде обновен списъка с елементи и той е коректен може да се пристъпи 

към прехвърляне на елементите в печатната платка. Това става като се избере от меню 

Design → Import Changes from PCB. При стартиране на тази функция се отваря диа-

логов прозорец (фигура 1.26), в който се прави потвърждаване на промените с бутон 

. Като бъде направено потвърждаването на промените с бутон  еле-

ментите биват прехвърлени в работното поле на печатната платка. 

 
Фиг. 5.12. Прехвърляне на електронните компоненти. 
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1.4. Преминаване към 3D проектиране 

След като бъдат прехвърлени електронните елементи в работното поле за изготвя-

не на печатна платка се преминава към триизмерно проектиране. Преминаването към 

него става в меню View → Switch to 3D или чрез натискане на бутон „3” от клавиатура-

та. След преминаване в триизмерен режим на проектиране маркера се сменя и електрон-

ните елементи се визуализират с техните корпуси. Това дава възможност за завъртане на 

работният екран и погледа над електронният възел под различни ъгли. Така конструкто-

ра може да добие реална представа за крайната разработка. За целта е нужна 3D мишка, с 

която да бъде извършено завъртането на PCB. 

Altium Designer дава възможност и за реални триизмерни модели на електронните 

елементи. Това ще рече, че електронните елементи в работното поле ще бъдат с техните 

реални производствени корпуси. За тази цел трябва всеки от тях да бъде добавен със 

своят корпус в библиотеката с елементи. 

 
Фиг. 5.13. Разполагане на елементите върху печатна-

та платка. 

 
Фиг. 5.14. 3D Образ на печатната платка 

Като вече работната среда е променена от двумерна в триизмерна може да започне 

разполагането на елементите върху печатната платка. Това става чрез щракане с левият 

бутон на мишката върху съответният елементи и преместването му върху печатната 

платка. При преместването и разполагането на елементите с тънки линии се виждат 

връзките между тях – фигура 5.13. На фигура 5.14 е представена печатната платка в ней-

ният 3D образ. 

Както се вижда от фигури 5.13 и 5.14 елементите се намират от горната страна на 

печатната платка, а пистите се намират от долната. Както бе споменато тънките линии 

свързващи елементите (фигура 5.13) не са пистите на печатната платка. Подобно на оп-

роводяването при създаването на електрическата схема, при изготвянето на печатната 

платка също се налага да бъде правено. Свързването между изводите на елементите е 

сходно, но тук вече трябва да се съобразява разстоянието между пистите и да не се до-

пускат пресечни точки между тях. Тъй като печатната платка е с малък размер и елемен-

тите са малко на брой, опроводяването ще бъде ръчно. Altium Designer не позволява оп-
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роводяването да се извършва в триизмерен (3D) режим и затова се прави в двумерен ре-

жим на работа (2D). Опроводяването се извършва чрез натискане на бутона Interactively 

Route Connections  от лентата с менюта или чрез натискане на десният бутон на 

мишката в работното поле и избор на Interactive Routing функция от падащото меню. 

След като се избере Interactively Route Connections режима на опроводяване маркера на 

мишката се променя в „кръст” и опроводяването може да започне – фигура 5.15. На фи-

гура 5.16 е представена вече изцяло опроводената платка.  

              
Фиг. 5.15. Опроводяване на пистите.                                        Фиг. 5.16. Опроводена платка. 

След като е опроводена изцяло платката тя вече е в завършен вид, което ще рече, че 

електронният възел е реализиран. Тя може да бъде разгледана в 3D проекция, но както 

бе споменато за тази цел препоръчително е да се използва 3D мишка или едновремен-

ното използване на Ctrl+ЛБМ. На фигура 5.17 и фигура 5.18 са представени сходни 

електронни възли с цел даване на пример за 3D проекция.  

 
Фиг. 5.17. Завъртене при 3D проекция на печатна платка.              Фиг. 5.18. 3D проекция на печатна платка. 

 

2. Цел на лабораторното упражнение. 
Проектиране на електронен възел с използването на автоматичния помощник 

/Wizard/ при създаването на печатна платка с нетрадиционна форма. 

 

3. Задачи на лабораторното упражнение. 
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3.1. Запознаване с принципната електрическа схема. Въвеждане на елементи-

те, опроводяване и ERC проверка.  

3.2. Използване на Wizard за създаване на платка във вид на диск с кръгла 

форма. 

3.3. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

4. Указания. 
4.1. Запознаване с принципната електрическа схема и елементите на Измери-

тел на напрегнатостта на електрическото поле. Въвеждане на елементите, опрово-

дяване и ERC проверка. 

Устройството, показано на фиг. 5.19 е предназначено да измерва напрегнатостта на 

електрическото поле и да визуализира резултата в логаритмична скала със светодиодна 

индикация от тип стълб. Сигналът от сензора се подава на неинвертиращия вход на 

усилвателя реализиран с IC1 (TLC271). Коефициентът му на усилване се определя от от-

ношението R4/P1. В случая потенциометърът трябва да се настрои на стойност около 

210 kΩ, което отговаря на 

коефициент на усилване 

около 50. След като вход-

ният сигнал бъде усилен, 

следва изправяне (чрез 

IC2, VD11) и филтриране 

(чрез C5, R7). През отри-

цателната полувълна на 

входния сигнал, на изход 6 

на IC2 има положително 

напрежение, в следствие 

на което диодът VD11 се 

отпушва и зарежда С5. А 

през положителната полу-

вълна сигналът преминава 

през резисторите R5, R6 и 

отново зарежда С5. Така 

интегрираното напрежение се подава на вход 5 от управляващата интегрална схема за 

индикацията LM3915. За сензор се използват два кръгли диска от двустранно фолиран 

текстолит. Елементите са монтирани от страна спойки върху единия диск. За целта из-

водите на елементите трябва да се огънат на 2 mm от краищата им за да се осигури по-

добър контакт при запояването им. Елементите С6, S1 и светодиодната индикация се 

монтират надолу, а всички останали нагоре. Двата диска се монтират заедно с изолацио-

нен болт на разстояние един от друг 20 mm. На фиг.5.20 е показан препоръчителния вид 

на печатната платка, съответно изгледи „страна елементи“ и „страна спойки“. Диаметъ-

рът на PCB трябва да е около 100 mm. Трябва да се обърне особенно внимание на нали-

чието на метализация по периметъра на кръглата PCB откъм „страна спойки“, свързана 

 
Фиг.5.19. Принципни електрически схеми на измерител на напрегна-

тостта на електрическото поле. 
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към маса. Тази метализация образува защитен екран за предпазване на електронните 

елементи на PCB от влиянието на интензивното електрическо поле, в което тя работи. 

Наличието на затворен контур от метализация, свързан към масата или 

захранването на разработеното устройство, е задължителен елемент при про-

ектирането на печатни платки, работещи при наличието на интензивни елек-

трически и/или магнитни полета!  

 
Фиг.5.20. Общ изглед на PCB за измерител на напрегнатостта на електрическото поле. 

Преди да се започне с въвеждането на елементите от схемата е препоръчително 

предварително да се зареди стандаризиран по ISO формат, в случая A3, който е на раз-

положение в същата директория където е библиотеката BDS-ISO, с наименование 

А3_ISO.schdoc. Като се спазват правилата за търсене на компоненти в библиотеките на 

AD се прави търсене на TLC271, в библиотеките на Texas Insruments. Използваме диск-

ретния корпус със 8 извода с фирмено обозначение FK package[8], съответстващ на кор-

пус DIP-8 в библиотеките на AD. 

За пасивните елементи и ценеровите диоди използваме стандартни означения, кои-
то са разположени в библи-
отеката BDS-ISO.Intlib. Наз-
ванията на елементите в 
библиотеката са съответно 
Резистор, Резистор потен-
циометър, Кондензатор не-
полярен, Кондензатор поля-
рен, Диод и Светодиод. За да 
се свържат проводниците с 
батерията и ключа S1 трябва 
да използваме куплунзи от 
типа Header2, като трябва да 
се поставят съответните 
Power port символи за зах-
ранване и маса, като се про-
меня Net на съответния сим-
вол. След свързването на 
елементите, окончателния 
вид на схемата трябва да изг-

 
Фиг. 5.21. Задаване на размери на платката 
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лежда подобно на схемата, представена на фиг.5.22. 
4.2. Използване на Wizard за създаване на платка във вид на диск с кръгла 

форма. 

За създаването на PCB извършваме стъпките, описани в т.1, като разликата е по от-

ношение на прозореца, представен на фиг.5.4, където трябва да изберем за Outline Shape 

– Circular, както е показано на фиг.5.21 и повтаряме стъпките до края. След създаването 

на платката с кръгла форма, разполагаме елементите, като се стремим да спазим изгледа 

от фиг.5.20. 

 
Фиг. 5.22. Общ изглед на схемата на измерителя на напрегнатостта на електрическото поле в стандартен 

формат А3. 

За да си помогнем, можем да отворим изображението от фиг.5.20 като графика в 

PAINT и да го разположим на същия екран, на който проектираме платката – фиг.5.23.  

4.3. Прехвърляне на схемотехническата информация и разработка на печатна 

платка. Визуализация на елементите и свързващите печатни проводници. 

След като поставим елементите на подходящото място, преди започване на опро-

водяването е необходимо да се направят някои предварителни настройки, за да се полу-

чи разполагане на печатни проводници само в слоя наречен „страна спойки“ – bottom 

layer. За целта отваряме прозорец за настройка на правилата за проектиране на печатната 

платка с командата Design/Rules и от там избираме RoutingLayers откъдето махаме от-

метката на слоя Top Layer, както е показано на фиг.5.24. Преди да престъпим към авто-

матичното опроводяване е необходимо да поставим защитната метализация по края на 

платката, образуваща електромагнитен екран за използваните елементи. 
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Фиг. 5.23. Проектиране на PCB по зададено изображение. 

 
Фиг. 5.24. Предварителна настройка за еднослойна печатна платка. 

За това предварително трябва да установим центъра на платката. Понеже при съз-

даването на платката автоматично е разположена окръжност  в слоя Keep Out Layer, кой-

то ограничава разполагането на елементи и печатни проводници по края на платката 

съгласно изискването на стандарта IPC-2221A. Кликваме 2 пъти с ЛБМ върху този слой 

за да отворим настройките /Properties/на тази окръжност за да видим координатите на 

центъра на окръжността и следователно центъра на платката, в секцията Location, както е 

показано на фиг.5.25. В центъра на PCB поставяме контактна площадка с Place/Pad, ка-
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то за център избираме същите координати. Правим настройки за диаметъра на метали-

зацията на Pad в секцията Size and Shape, 

съответно 5 mm по x и y и избираме за 

диаметър на отвора на Hole Size 0.8 mm. 

Желателно е да преместим и центъра на 

координатната система, така че да съв-

пада с центъра на PCB с командата 

Edit/Origin/Set и посочваме центъра. 

За разполагане на екраниращата мета-

лизация избираме Place/Arc/Full 

Circle, като за Radius избираме 47 mm, а 

за широчина на метализацията Width 

избираме 3 mm. Настройваме Net да 

бъде +9V, за да свържем екраниращата 

метализация към захранване. Желател-

но е да заключим координатите на пос-

тавената метализация преди да престъ-

пим към автоматичното опроводяване. За да дефинираме широчината на свързващите 

печатни проводници настройваме чрез  Design/Rules и от там избираме Width, като 

избираме 0.5 mm за Min Width, 1.0 mm за Preferred Width и 3.0 mm за Max Width. Опро-

водяваме като изпълняваме командата Route>Auto Route>All и от появяващия се екра-

нен прозорец избираме Default 2 Layer Board и натискаме бутона Route All. Окончател-

ния вид на проектираната печатна платка е показан на фиг.5.26. 

 

 
Фиг. 5.26. Окончателен вид на проктираната еднослойна печатна платка за измерителя на напрегнатостта на 

електрическото поле в 2D и 3D изглед. 

 
Фиг. 5.25. Установяване центъра на платката 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №6 

РАБОТА С РЕДАКТОРА ЗА ПЕЧАТНИ ПЛАТКИ. НАСТРОЙКИ НА PCB.   

1. Теоретична обосновка.  
1.1. Конструкционен процес на PCB. 

   Подготвителният период за конструиране на PCB показва как да се използва 
изходната иформация, за да бъде създадена PCB, разположение на компонентите, посо-
ка при преименуване, проверка на конструкционните правила и CAM изходни файлове.  

Диаграмата по-долу дава една обща представа за изграждащия процес на PCB от 
схематично въведение до комплексното изграждане на PCB. 

 
Фиг.6.1. Алгоритъм на процеса на проектиране на PCB от схема или netlist. 
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1.2.  Създаване на изходни файлове за производството на печатната платка. 

  След като конструирането на  PCB е завършено и са направени необходимите 
проверки, следващия етап е създаването на производствени файлове. Този процес е по-
казан по-долу на фиг.6.2. 

 
Фиг.6.2. Алгоритъм за генериране на изходни файлове на PCB за производство. 

1.3. Работна среда на редактора за проектиране на печатни платки PCB Editor. 

Тази част посочва как се работи при PCB дизайна и как се подготвят изискванията 
към мястото за работа и други документни опции, такива като слоеве(изводи) и контакт-
ни площадки. 

1.3.1. PCB панел. 

PCB панелът осигурява комплексна информация за съдържанието на печатната 
платка с всичките и електрически и неелектрически обекти. 

Кликвайки върху дадена област в панела можем да променяме нейните размери в 
зависимост от елементите, които ни интересуват. За да се сменят обектите можем да из-
ползваме различни опции. 

1.3.2.  Прозорец на начините за селекция. 



 
ЛАБОРАТОРНО УПРАЖНЕНИЕ №6    Работа с редактора за печатни платки. Настройки на PCB.         89 
 

 

Списъкът, посочен долу, поставен в най-горната част на панела позволява да под-
редите по ред, да локализирате или да зададете следните PCB обектни типове в активни-

те PCB документи. 

• Компоненти (а след това компонентните 
класове) 

• Връзки (а след това класовете връзки) 

• From-To редактор на връзките 

• Отделни(разделящи) панели 

• Конструкционни правила и нарушения на 
конструкционните правила 

• Диференциални двойки 
Когато изберете обект върху панела, той ще 
бъде осветен, според опциите в най-горната 
част на панела.  

1.3.3 Мини наблюдател 
Той е разположен в дъното на панела 

и осигурява наблюдение над работното 
пространство. Правоъгълникът с двойна 
линия показва участъкът който е показан в 
момента във работното поле(пространство). 

Мини наблюдателя има също следните 
контролни функции върху дисплея: 

• Кликване и влачене в рамките на четириъ-
гълника за да се очертае работното по-
ле(пространство) 

• Кликване и влачене(провлачване) в ъгъла 
на четириъгълника, за да промени размера 
на работното поле(пространство) 

1.4. Използване на контролния па-
нел 

1.4.1 Разглеждане на връзки и кла-
сове връзки. 

За разглеждане на връзките изберете 
Nets (връзки) от следния списък в PCB па-
нела 

• Кликнете върху  All Nets (всички 
връзки) в класове връзки в областта за свър-
зване, за да прегледате всички връзки в PCB.  

Връзките са подредени в списък в дол-
ната част и те също са осветени в PCB. 

• Ако проекта включва класове връзки, те също са подредени в списък. Класове 
връзки като D(0.....7) са били автоматично създадени в PCB. 

• Кликнете върху името на връзките в района мрежи, за да изберете връзки - всич-
ки обекти, които принадлежат към тази връзки са подредени в списък в Net Items region 
(участък връзки). Също така желаната връзка е осветена в PCB. 

 
Фиг.6.3. Панел PCB Editor. 
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• Кликнете върху точка в участъка и 
забележете, че тя се осветява върху PCB. За-
бележете също, че обектът върху който сте 
кликнали е избран. 

• Осигурени са мулти - селективни 
клавиши. Задръжте  SHIFT или  CTRL като 
кликвате върху входове от списъка. 

• Кликването два пъти върху име на 
връзка отваря Edit Net dialog (редактиране 
на мрежова връзка). Тук можете да промени-
те името на връзката, да добавите или пре-
местите възлови точки от  връзката и да оп-
ределите цвета на свързващата линия за тази 
връзка. 

• Мрежите и участъка на мрежовите точки 
има много колони. Забележете, че можете да 
контролирате избора, чрез кликване върху 
колоната. 

• Можете чрез клавиатурата бързо да 
преглеждате списъците. Натиснете Esc , за 
да спрете текущия символ, да потърсите и да 
стартирате друг. 

1.4.2 Търсене на компоненти и кла-
сове от компоненти 

• За да търсите компоненти, изберете 
Components(компоненти) от посочения 
списък. 

• Когато панелът се използва, за да се 
избере (освети) компоненти, за  предпочи-
тане е да изберете опция Select (избор) от 
най-горната част на панела при неактивно 
изключено) положение. 

• Кликнете на All Components (всички 
компоненти) в областта клас компоненти, за 
да се прегледат всички компоненти в PCB. 
Те са подредени в списък, както и са освете-
ни върху дисплея. 

• Ако в проекта са включени класове компоненти, те също са подредени в списък. 
Когато кликнете върху компонентен клас са появяват осветени и подредени в списък са-
мо компонентите в този клас. 

• Кликнете върху името на компонента в област Компоненти, за да го изберете. 
Всички обекти, които принадлежат към този компонент са подредени в списък в област 
Component Primitives(основни компоненти). И в този случай компонентът се появява в 
осветено поле в PCB. 

 
Фиг.6.4. Разглеждане на списък с връзките. 
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• Кликнете върху област Компоненти. 
Забележете, че той е осветен във (върху) 
PCB. Забележете също, че обекта върху кой-
то сте кликнали е избран. 

• Осигурени са клавиши за мулти-
селекция. Задръжте SHIFT или CTRL като 
кликнете върху входовете от списъка. 

• Кликване с десен бутон в участък 
Компоненти, дава възможност за избор кои 
основни компоненти да се появят на дисп-
лея. 

• Ако кликнете два пъти върху компо-
нентово име се отваря Component dialog, 
при което можете да промените която и да е 
характеристика на компонента. 

• Компонентите и компонентните ха-
рактеристики имат множество колони. 
Обърнете внимание, че можете да контро-
лирате тяхната селекция чрез кликване върху 
дадена колона. 

• Редът на колоните също може да 
бъде променен: кликнете и провлачете върху 
колоната, за да промените реда. Това е удоб-
но когато желаете да използвате важни ха-
рактеристики от различни колони. 

• Осигурен е начин за бързо предвиж-
ване напред. Чрез клавиатурата можете бър-
зо да минете напред в списъците. Натиснете 
ESC, за да избегнете настоящото търсене и 
да започнете друго. Тази функция винаги е 
представена върху лявата основна колона, 
така че всяка желана колона трябва чрез вла-
чене да се превърне в основна лява. 

1.4.3. Търсене на конструкционни 
правила и нарушения 

За да разгледате конструкционни пра-
вила, изберете Rules(правила) от посочения по-долу списък. Всички класове правила са 
подредени в списък. 

• Кликнете върху Rule Class (клас правила) и всички правила, които се отнасят към 
този клас се появяват в списъка. 

• Кликнете върху Rule list (списък с правила) и още се появяват в осветено поле 
всички обекти, които се подчиняват на това правило. 

• Кликнете два пъти върху правилото, за да се задейства влизане в сила на това 
правило. 

• Ако избраното правило е нарушено, всички обекти, които го предизвикват се 
появяват в списък в участъка Violations (нарушения). За да проверите всички нарушени 

 
Фиг.6.5. Разглеждане на списък с Компоненти. 
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правила, изберете [All Rules] (всички правила) в избор на класове правила(Rule Classes 
Section). 

• Кликнете върху Violation(нарушение), 
за да бъдат осветени всички обекти, които 
причиняват нарушението. 

• Двойно кликване върху  Violation (на-
рушение) отразява на дисплея Violation Details 
dialog(детайлно разглеждане на нарушението), 
при което се изолира правилото, при което 
има нарушение и подробно се посочват пара-
метрите на точния пункт, който причинява на-
рушението. 

1.4.4. Избор от - до 

• Изберете From-To Edior по-долу 
описания начин, в най-горната част на PCB  
панела. В списъка, намиращ се в най-горната 
част на панела ще откриете всички настоящи 
връзки, отнасящи се към дизайна. 

• Когато кликнете върху входа конст-
рукционни правила към веригите, всички раз-
клонения ще се появят в средната част от спи-
съка на панела. Прави се подбор и се виждат 
само  възловите точки на веригите. Всички 
други обекти не се виждат ясно. 

• С двойно кликване върху мрежови 
вход се отваря Edit Net dialog, чрез което се из-
бират само подходящите точки от мрежата. 

• За да добавите нов from-to, изберете 
Nodes (възлови, основни, пунктове, разклоне-
ния) от мрежите, към които желаете да добави-
те from-to  и натиснете клавиш Add From-To. 
Новата From-to  функция се появява в From-To  
в участъка Мрежи(Nets). Кликнете върху във в 
участък Мрежи и кликнете върху Generate 
(създай) и from-to изберете топология. 

• From-To-Editor може също да се из-
ползва за създаване на from-tos. За да се прове-
ри дали съществува from-tos , направете запит-
ване в панела за селекция (Filter) като използва-
те Is Fromto като ключова дума. 

• Обърнете внимание, че всички свърз-
ващи линии, освен онези, които са били опре-
делени като From-Tos в мрежата, избрана в мо-
мента, няма да бъдат ярко отразени. Свържете 
задната част на панела към мрежи, за да възста-
новите появата на линейни връзки. 

 

 
Фиг.6.6. Разглеждане на конструкционни 

правила. 

 
Фиг.6.7. Разглеждане на редактор от-до  

връзките. 
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2. Цел на лабораторното упражнение. 
Проектиране на печатна платка с използването на инструмента за ръчно оп-

роводяване Interactive Routing. 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема. Въвеждане на елементи-

те, опроводяване и ERC проверка.  

3.2. Създаване на печатна платка в стандартизиран формат. Промяна разме-

рите на платката. Използване на библиотечни елементи с 3D модели. 

3.3. Прехвърляне на схемотехническата информация и разработка на печатна 

платка с използването на Interactive Routing. Преходи между слоевете. Динамична 

промяна на широчината на пътечките. 

4. Указания. 
4.1. Описание на принципната електрическа схема. Въвеждане на елементите, 

опроводяване и ERC проверка. 

Схемата, показана на фиг.6.9 е вариант на усилвател QUAD 405. Освен традицион-
ната ООВ (отрицателна обратна връзка) този усилвател има и т.нар. права връзка, която 
по същество компенсира изкривяванията на крайното стъпало, работещо в клас В.  

 
Фиг.6.8. Принципна електрическа схема на усилвател QUAD 405. 

 Входното стъпало в тази схема е изградено от каскодната схема ОЕ, ОБ с Т1 и Т2, нато-
варена с генератор на ток Т3. Т4 представлява повторител с особено благоприятно дейс-
твие, съгласуващо високото изходно съпротивление на входния каскод със следващото 
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стъпало.С Т5 и Т6 е изграден усил-
вателят на напрежение (на практика 
троен Дарлингтон транзистор), кой-
то захранва комплементарното из-
ходно стъпало по схема ОК с Т11 и 
Т12. Т6 е натоварен с Т9 и Т10 – ге-
нератор на стабилен ток. Т12 обаче 
през R24 работи заедно с Т6 по схе-

ма на “PUSH-PULL”, или самоинвертиращо стъпало. На практика тук изкривяванията 
при ниско ниво на сигнала се компенсират от Т6 с неговия динамичен товар Т12. Опе-
рационният усилвател ОУ1 (евтиният и популярен 741) заедно с R15 и С7 е включен ка-
то интегратор, т. е. той задава само постояннотоковия режим на усилвателя. Напрежени-
ето на базите на Т2 и Т9 е стабилизирано посредством ценеровите диоди D1 и D2, като 
по този начин се осигурява независимост на постояннотоковия режим в случай на “про-
падане” на захранването. Друго подобрение са диодите D4 и D5, които намаляват стъп-
ката при отпушване на Т11. Транзисторите Т9 и Т10 изграждат схема, която в литерату-
рата често е наричана “токово огледало”. Ако поради някаква причина токът през Т9 се 
промени (например нарастне), падът върху R17 се увеличава, Т10 се поотпушва и напре-
жението на базата на Т9 намалява. Последното води до намаляване на тока през Т9. Еле-
ментите С5, С9, С10, С11, С12, С15, R23 и L2 са за честотна корекция и отстраняват са-
мовъзбуждането. R4 и С4 изграждат входен ВЧ-филтър, непропускащ честотите над зву-
ковия обхват. R25 и С16 компенсират евентуалния силно индуктивен товар при по-
високите звукови честоти. Кондензаторите С2, С6, С8, С13 и С14 изграждат филтри за 
различните ВЧ-смущения през захранването, предпазвайки по този начин усилвателя от 
самовъзбуждане. Препоръчително е при ±50V захранване, С13 и С14 да бъдат с пробив-
но поне 63V. Кондензаторът С3 е единственият електролитен кондензатор в схемата. 
Той не участва във веригата на променливотоковия сигнал, а свързва базата на Т3 към 
маса по променлив ток. Липсата на електролитни кондензатори във веригата на полез-
ния сигнал, която се постига със свързването на ИС 1 като постояннотоков усилвател, 
повишава качеството на звучене и е схемно решение, което се използва все по-често при 
съвременните усилватели. За да се постигне достатъчно голям коефициент на усилване 
без обратна връзка, се използват генераторите на стабилен ток, изпълнени с транзисто-
рите Т3 и Т9. Отрицателната обратна връзка е изградена с елементите R11 и R5. Коефи-
циентът на усилване на усилвателя се определя от отношението (R11+R5)/R5 и в нашата 
схема е около 50 пъти. Ако е необходимо да се повиши чувствителността на входа, се 
намалява стойността на резистора R5. (Например при R5=6.8 , Ku=75 пъти.) Ако вход-
ното ниво е високо (както е при повечето съвременни CD-възпроизвеждащи устройст-
ва), е по-добре стойността на R5 да се запази или дори да се повиши до 18, при което 
Ku=29 пъти. В последния случай обратната връзка е по-дълбока и оттам изкривяванията 
ще са още по-малки. Резисторът R6 определя входното съпротивление на усилвателя. С1 
е входен разделителен кондензатор, който пропуска само звуковите честоти и “развърз-
ва” входа по постоянен ток. R12 е предназначен да отклони част от емитерния ток на Т5 
и го предпазва от работа в режими, при които усилването на транзистора е малко. Пос-
редством резисторите R3 и R17 се задава токът на транзисторите Т3 и Т9, така че стъпа-
лата, изпълнени с тях да работят в клас А. Защитата на усилвателя е изпълнена с тран-
зисторите Т7 и Т8. Резисторите R20 и R22 снемат сигнал по ток за защитата. Когато из-
ходният ток нарастне над допустимата стойност, падът на напрежение върху R20 и R22 
се увеличава до стойност, достатъчна да отпуши Т7 и Т8. Последните шунтират базите 
на Т11 и Т12, което от своя страна ограничава изходния ток. R19 и R21 ограничават пра-

 
Фиг.6.9. Чертеж и изглед на бобините L1 и L2. 
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га на задействане на защитата за достигане на пикова изходна мощност 200W, при из-
ползване на товар 4. При товар 8, за да се настрои прагът на сработване, на платката се 
монтират двата допълнителни резистора R13 и R18. Токовете, протичащи през R13 и 
R18, задават на базата на Т7 (съответно Т8) преднапрежение, което намалява прага на 
сработване на защитата. Намотките L1 и L2 (фиг. 6.13) се навиват въздушно (без сърце-
вина) на два слоя върху тяло с диаметър 8 mm (може да се използва обикновен фулмас-
тер). L1 има 16 + 14 навивки, а L2 – 24 + 22 навивки. Естествено, и при двете намотки 
вътрешният слой е този, който съдържа по-големия брой навивки (виж снимката). Из-
ползваният проводник е меден, с лакова изолация, като и за двете бобини неговият диа-
метър е 1mm2.  

Захранването е двуполярно по традиционна схема, като трансформаторът трябва да 
е оразмерен поне за 250VA мощност при стерео вариант (200W е пиковата мощност на 
усилвателя). Филтровите кондензатори е добре да са по 10 000μF и за напрежение поне 
63V. Естествено най-добри резултати се получават при стабилизирано захранване, но по 
принцип такъв вариант усложнява схемата. Добре е свързващите проводници (особено 
на захранващите шини, крайните транзистори и изхода) да бъдат със сечение, не по-
малко от 1mm. За намаляване на мрежовия брум в изхода всички маси трябва да се свър-
жат в обща точка (например, към общата точка на филтровите кондензатори от захран-
ването). Транзисторът Т9 се монтира на малък радиатор (около 10 сm2), а Т6, Т11 и Т12 
се монтират с изолационни подложки на общ радиатор с обща площ, не по-малка от 
1000 сm2. Използвани елементи: интегрални схеми: ИС1 – 741; транзистор и диоди: Т1, 
Т2 – ВС550, Т3, Т4 – ВС560, Т5 – ВС640, Т6 – TIP137 (Дарлингтон), Т7 – 2Т6551(BC639), 
Т8 – 2Т6821(BC640), Т9 – 2Т7237В, Т10 – ВС108, Т11 – КТ827А (или TIP142) (Дарлинг-
тон), Т12 – КТ825Г (2Т825A или TIP147) (Дарлингтон), D1, D2 – BZX15V (ценеров 15 
V), D3, D4, D5 – 1N4007; резистори и кондензатори: R1 – 560 , R2 – 22 к, R3 – 100 , R4 – 
3 к, R5 – 10 /0.5 W, R6 – 47 к, R7, R8 – 3.3 к/1 W, R9 – 3 к, R10 – 4.7 к, R11 – 510 /2 W, 
R12 – 560 , R13 – 30 к, R14 – 10 /0.5 W, R15 – 180 к, R16 – 22 к, R17 – 11 , R18 – 30 к, R19 
– 180 , R20 – 0.1 /5 W, R21 – 120 , R22 - 0.1 /5 W, R23 – 22 /0.5 W, R24 – 47 /2 W, R25 – 
10 /2 W,  C1 – 470 nF, C2 – 100 nF, C3 – 100 μF/10 V, C4 – 680 pF, C5 – 47 pF, C6 – 100 
nF, C7 – 470 nF, C8 – 100 nF, C9 – 120 pF, C10 – 330 pF, C11 – 1 nF, C12 – 1 nF, C13, C14 
– 100 nF/100 V, C15 – 1 nF, C16 – 100 nF/100 V; дросели - L1 и L2 - изработени по опи-
сания по-горе начин. 

Преди да се започне с въвеждането на елементите от схемата е препоръчително 

предварително да се зареди стандаризиран по ISO формат, в случая A3, който е на раз-

положение в същата директория където е библиотеката BDS-ISO, с наименование 

А3_ISO.schdot. Препоръчително е файла да се преименува, например Upr.6.schdoc. 

Като се спазват правилата за търсене на компоненти в библиотеките на AD се пра-

ви търсене на 741, в библиотеките на National Semiconductor. Използваме дискретния 

корпус със 8 извода с фирмено обозначение J08A на LM741J [9], съответстващ на корпус 

DIP-8 в библиотеките на AD. 

За пасивните елементи и ценеровите диоди използваме стандартни означения, кои-
то са разположени в библиотеката BDS-ISO.Intlib. Тъй като символите на мощните Дар-
лингтон транзистори не са достъпни по БДС е необходимо те да се създадат като нови 
библиотечни елементи в нова схемотехнична библиотека към проекта. С цел улеснение 
може да се копират и модифицират символите PNP1 и NPN1 от библиотеката 
Miscellaneous Device.IntLib. Трябва да се създаде библиотека и с корпусите на елементите 
– компоненти за PCB в проекта, като се препоръчва за всеки от активните компоненти да 
се потърси информация в Internet. След установяване на наименованията и вида на кор-
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пусите, те трябва да се потърсят в библиотеките на AD и да се копират в библиотеката с 
компоненти за печатната платка в проекта. Тъй като имаме транзистори с различни кор-
пуси и мощност, то предварително трябва да се изберат подходящите Footprints, в наст-
ройките на схемотехничните им означения.  

За улеснение при попълване на информацията за типа на елемента или стойността 
му, както по отношение на корпуса му / Footprint/ е желателно използването на панела 
Navigator, който може да се активира от Design Copmiler или с командата 
View→Workspace Panels→Design Compiler→Navigator.  

Според техническата им документация компонента TO92 се използва за транзисто-
рите Т1, Т2, Т3, Т4 и Т5. Корпус TO39 се използва за транзистори Т7 – 2Т6551 и Т8 – 
2Т6821. За транзистор Т10 се използва корпус TO-18, за Т6 -TO220, за Т9 корпус ТО126, 
а за Т11 и Т12 - TO247. 

По отношение на резисторите, корпусите и от там компонентите от библиотеките 
за печатната платка, трябва да се избират според мощността им. За мощност 0.25W се 
избира компонент AXIAL0.4 – резистори R1, R2, R3, R4, R6, R9, R10, R12, R13, R15, R16, 
R17, R18, R19 и R21. За мощност 0.5W съответно AXIAL0.5 - R5, R14 и R23. За мощност 
1W - AXIAL0.6 - R7 и R8. За мощност 2W компонент AXIAL0.8 - R11, R24 и R25 и за 
мощност 5W компонент R-5W - R20 и R22. За високоговорителя трябва да се използва 
Footprint като за букса - ARK1102. За двуполярното захранване трябва да се постави в 
схемата допълнително букса HEADER 3 с корпус ARK1103. За предпазителите се изби-
ра корпус FUSE – 3519. За бобините L1 и L2 се избира корпус LC027. За високоволтови-
те кондензатори С13, С14 и С16 се използва корпуса RAD0.2W. Вида на схемата с фор-
матирания лист е показан на фиг. 6.13. 

 
Фиг.6.10. Изглед на готовата схема във формат А3. 
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4.2. Създаване на печатна платка в стандартизиран формат. Промяна разме-

рите на платката. Използване на библиотечни елементи с 3D модели. Инструкции 

за проектиране на печатната платка. 

Снимка на изготвената печатна платка с елементите е показана на фиг.6.11, а на 
фиг. 6.12 е показан препоръчителен изглед на разположението на компонентите и оп-
роводяването на печатната платка. 

 
Фиг.6.11. Изглед на готова печатна платка с монтирани елементи. 

 
Фиг.6.12. Препоръчително разположение на компонентите и печатните проводници в долния слой /еднослойна 

печатна платка/. 

След въвеждане на схемата, за да работим в стандартен формат по БДС, се отваря 
чертожен лист на платка с формат А3 от предварително създадения файл 
A3_ISO.pcbdoc, като е желателно той да бъде преименуван, например в Upr.6.PcbDoc. 
Прехвърля се информацията от схемата към печатната платка, която се преоразмерява. 

Преди разполагане на елементите променяме размерите на печатната платка съоб-
разени с изгледа от фиг.6.12 на 150х70 като са предвидени 4 отвора за закрепване на пе-
чатната платка, 4 на 10 mm от ръбовете на платката.  За да преоразмерим платката на 
формата е необходимо да начертаем новите размери на платката във слоя Keep Out 
Layer. Преди това е препоръчително да преместим началото на координатната система в 
долния ляв ъгъл на бъдещата платка с командата Edit →Origin→Set. Започваме да чер-
таем с инструмента Line от началото на преместената координатна система, като за дъл-
жината на линията следим от информацията изобразяваща се най-отдолу в центъра на 

екрана . 
Прехвърлянето на информация към PCB става от схемата Upr.6.schdoc с командата 

Design→Update PCB Document Upr.6.PcbDoc при което се отваря прозореца 

Engineering Change Order.  
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Ако няма предварително забелязани грешки натискаме бутона Validate Changes и 

ако статусът на всички елементи и връзки е в зелено в секцията Check финализираме 

прехвърлянето на информация с бутона Execute Changes.  

По нататък се повтарят стъпките описани в първото упражнение по отношение на 

разполагането на компонентите върху очертанията на печатната платка, като се спазват 

правилата за разполагането на елементите.  

4.3.  Прехвърляне на схемотехническата информация и разработка на печатна 

платка с използването на Interactive Routing. Съвети при използване на Interactive 

Routing. Преходи между слоевете. Динамична промяна на широчината на пътеч-

ките.  

Опроводяването е процес за дефиниране на свързащи проводници между възлите 
на всяка една връзка между отделните елементи. Свързващите проводници се дефинират 
чрез поставяне на PCB обекти, като печатни пътечки, закръгления или vias-и 
/метолизирани отвори/, за да се образуват непрекъснати електрически връзки между 
възлите. В PCB редактора интерактивното опроводяване е интелигентен процес. След 
стартирането на командата се кликва върху контактната площадка, за да се избере връз-
ката, която трябва да се опроводи.  

Широчината на печатните проводници се контролира от настройките по подраз-
биране  и от настройките Track Width Mode setting.  
Интерактивното опроводяване се осъществява чрез: 

• Единична връзка – Route→Interactive Routing, или  
• Две връзки дефинирани като диференциална двойка – Route→Interactive 

Differential Pair Routing, или 
• Набор от селектирани връзки – Route » Interactive Multi-Routing. 
По надолу са посочени някои полезни съвети за интерактивно опроводяване:  
• Стартираме командата Route » Interactive Routing  (Ctrl+W) след което кликваме 

върху обекта, който има връзки за да стартираме опроводяването. Това може да е контак-
тна площадка, свързваща линия, съществуващ преход между слоевете, край на печатен 
проводник, т.е. всеки обект, който е със същия потенциал или възел.  

• Редакторът PCB editor ще прехвърли опроводяването до най-близкия електрически 
обект на връзката, като център на контактна площадка или край на сегмент на пътечка, 
след което ще се опита да дефинира свързващ път от там до текущото положение на 
курсора. 

• Способността на Interactive Router да достигне до текущото положение на курсора 
зависи от текущия режим Routing Conflict Resolution mode, който се изобразява на 
Status bar когато се изпълнява интерактивно опроводяване.  

 
• Натискаме Shift+R за да променяме циклично съществуващите конфликтни ре-

жими.  
• Ако режима е избран като Walkaround, Push and Hug или Push, редакторът за 

интерактивното опороводяване ще се стреми да намери път между съществуващите 
обекти. 

• Потенциалните сегменти на свързващата пътечка ще се изобразяват като защрихо-
вани (разполагащи се при следващо кликване) или кухи (сегменти тип look-
ahead; използва се за да изобрази откъде ще мине следващия сегмент преди да се разпо-
ложи). 

• Натискаме Spacebar за да се смени вида на ъгъла на пътечката. 
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• Чрез Shift+Spacebar се променят съществуващите режими за ъглите 
• Чрез бутона Backspace „разкъсваме“ последно поставения сегмент от печатната 

пътечка. 
• За да се превключи сигналния слой 

/слой с метализация на PCB/ и да се постави 
прошивка между слоевете /via/:  

o Натиска се * клавиш от numeric keypad 
на клавиатурата или 

o Използва се Ctrl+Shift+Wheel Scroll 
комбинацията. 

• Натискаме / на цифровата клавиатура 
за да вмъкнем via и да завършим връзката. 

• Натискаме 2 за да вмъкнем via без да 
превключваме слоевете (продължаваме да 
опроводяваме в текущия слой). 

• Натискаме L ако започнем опроводя-
ването от контактна площадка /pad/ с отвор 
или via и ги поставим върху грешен слой, 
като превключваме между and realize you are 

on the wrong layer to step through the наличните сигнални слоеве без да се поставя via. 
• Ctrl+Click за да инструктираме програмата да завърши автоматично текущата пе-

чатна пътечка. Ако амтоматично не се завърше опроводяването, това не означава че 
връзката не може да се опроводи. Може да означава че разтоянието е много голямо или 
крайната точка е на друг слой. 

• Чрез Shift+F1 се изобразява списък с бързи клавиши. 
• Разполагането или вида на свърващите проводници на връзка се нарича топология. 

Топологията се дефинира чрез конструктивното правило Routing Topology, при правила 
по подразбиране, касаещи всички връзки и избрана топология „най-къси пътечки“ – 
Shortest. 

4.3.1.  Настройка на широчината на пътечките – Routing Width и размера на 

Via при опроводяване. 

 

Когато опроводяваме ин-
терактивно се създава серия от 
сегменти на печатната пътечка 
от най близкия pad до текущото 
разположение на курсора. Ши-
рочината на сегмента се опре-
деля от настройките в текущия 
режим за широчина на пътечка 
Track Width Mode, който се 
изобразява в status bar при оп-
роводяването. 

Съществуват 4 възможни 
настройки за Routing Width: 

• Предпочитана от конст-
руктора широчина, или 

• Минимална, предпочи-

 
Фиг.6.13. Свързващата линия GND е прик-

репена за  pad 1 независимо от края на текущо опро-
водяваната пътечка.  Активирането на режима 

Smart Track Ends ще прехвърли свързващата линия 
на края на текущия сегмент от печатната пътечка. 

Фиг.6.14. За да се промени широчината на пътечката при интерак-
тивно опроводяване натискаме, клавиша 3. Чрез комбинацията 

Shift+W избираме различна стойност за широчината на пътечката. 
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тана, или максимална стойност, зададени в секцията Routing Width design rule на конст-
руктивните правила. 

Избора на User Choice / Min rule / Preferred rule / Max rule  се записва и може да се из-
бира от Track Width Mode drop-down на страницата PCB Editor – Interactive Routing в 

диалога за настройки Preferences. 
Може да се избира между четири 
предварително настроени режима на 
работа чрез натискане на бутона 3. 
Текущия избор се показва най – от-
долу на текущия прозорец в лентата 
на състоянието. Чрез натискане на 
комбинацията Shift+F1 виждаме бър-
зите клавиши и клавишните комби-
нации. 
Когато променяме широчината на 
пътечката, избираме стойности пред-
варително дефинирани в чертожните 
правила (min/preferred/max) и пот-
ребителски. 
Избираме няколко бързи клавиши 
при интерактивно опроводяване: 

• Shift+W – използваме за да се отвори диалога Choose Width. Кликваме върху 
нова стойност и продължаваме да опроводяваме с тази стойност. Достъпните широчини 
могат да се редактират чрез кликване на бутона Favorite Interactive Routing Widths на 
страницата PCB Editor – Interactive Routing в настройките. 

• Tab – използваме ако искаме стойност различна от дефинираните като предпо-
читани широчини. Натискането Tab ще отвори панела Properties на избор на широчина 
на пътечката. Въвеждаме нова стойност и натискаме Enter за да продължим опроводява-
нето с новата широчина. Алтернативата е след избора на нова стойност на широчината 
на пътечката да се натисне бутона пауза, за да се продължи опроводяването. Ако не ис-
каме да променим широчината натискаме Esc. 
Широчената на пътечката трябва да между минималната и максималната стойност дефи-
нирани в чертожните правила Routing Width.  

Съществуват два подхода при интерактивно променяне на слоевете на пътечката по 
време на опроводяване: 

• С бутона * на цифровата клавиатура. Всяко натискане на бутона променя слоя с 
по-долния от достъпните сигнални слоеве. 

• С комбинацията Ctrl+Shift+Wheel Scroll. Задържаме Ctrl+Shift след което със 
скрола на мишката променяме достъпните сигналните слоеве;  

Vias-ите между слоевете автоматично се поставят при промяна на слоя. Също като 
широчината на пътечките, размера на прошивките се определя от текущия Via Size 
Mode. Режима се преконфигурира от опциите Interactive Routing Width Sources .Чрез 
клавиша 4 избираме четири размера на Via при интерактивното опроводяване. Текущия 
избор се изобразява на лентата за състоянието – фиг.6.11. За да променим размера дока-
то опроводяваме натискаме: 

• Shift+V – отваряме диалога Choose Via Size. Автоматично се показва списък с 
всички размери на via, които са достъпни за избор;  

 Фиг.6.15. Променяне на потребителските стойности на ши-
рочината на пътечките при опроводяване. 
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• Tab – както и при 
промяна на широчината на 
пътечката отваряме панела 
Properties, където променяме 
размера на via. Както и при 
широчината на пътечките 
стойността която се въвежда 
трябва да е между максимал-
ната и минималната стой-
ност, предварително зададе-
ни в правилото Routing Via 
Style. 
Преопроводяване на компо-
нент 

По време на опроводя-
ването на платката не е рядък 

случая, когато се налага да се коригира разположението на опроводен компонент, за да 
се освободи място за нова пътечка. Тази особеност е достъпна чрез разрешаване на 
Component re-route в областта Dragging на PCB Editor – Interactive Routing страницата 
в диалога Preferences. 

По време на преместването са достъпни следните горещи клавиши, за да се предиз-
вика специфично действие: 

• Промяна на режима на преопроводяване (Shift+R) – превключваме  за опро-
водяване след поставяне на пътечки. Софтуера ще се стреми да преопроводи компонен-
та, за да пресъедини разкъсана връзка.  Следващото натискане на Shift+R забранява пре-
опроводяването (или да се деактивира Component re-route опцията в PCB Editor –
 Interactive Routing в диалога Preferences). Текущия статус се индикира на Heads Up дисп-
лея и на лентата за състоянието. 

• Промяна на селекцията на компонента (Shift+Tab) – когато влачим няколко 
обекта, които трябва да преместим, чрез натискане на Shift+Tab се сменят последова-
телно:  

o Само компоненти, след това 
o Компоненти +Via +Escapes +свързвания, след това 
o Първоначално избрани обекти (ако са различни от предните две), след това 
o Обратно към само компоненти. 
• Показване/Скриване на свързващите линии (N) – чрез буто-

на N превключваме между 3 състояния: без свързващи линии, свързващи линии от кон-
тактна площадка до друта и свързващи линии от връзка до връзка. Последното състоя-
ние показва къде свързващите линии са прекъснати и могат да се възтановят.  

• Промяна на начина на преопроводяване (Shift+Ctrl+G) – превключване на 
опциите за начина на преопроводяване. 

Активираме опцията Move component with relevant routing в областта Dragging в 
PCB Editor – Interactive Routing страницата на настройките, за да се започне премест-
ването на компонента със свързаните към него пътечки и обекти (компоненти+Via 
+изходи +взаимовръзки). Чрез Shift+Tab се превключват набора от обекти които се 
преместват.  
За да направи режима на преместване на компоненти подходящ за последващо опрово-
дяване, софтуера установява и коригира нарушенията на чертожните правила и по от-
ношение на преместваните опроводявания, така и по отношение на бъдещите пътечки.  

Фиг.6.16. Клавишна комбинация Ctrl+Shift+Scroll за промяна на теку-
щия сигнален слой и 4 при избор размера на  via. 
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4.3.2. Динамично показване на границите на допиране при интерактивно 

опроводяване. 

Замисляли ли сте се защо печатния проводник не се побира през празното прост-
ранство между два електрически обекта по време на интерактивно опроводяване? Това е 
поради неправилно дефинирано ограничение на правилото или растерната мрежата е 
настроена грешно. 

Създадена с цел да помогне за интерпретиране и разбиране на въздействието на 
правилата за проектиране, функцията за динамично показване на границите на просвет 
показва колко точно пространство е на разположение по време на интерактивно опро-
водяване. 

 
Разстоянието около съществуващите обекти /клирънс/ на работното пространство мо-
же да се показва динамично, докато се опроводява. Използвайте комбинацията Ctrl + W, 
за да активирате / деактивирате тази функция по време на опроводяване. 

Клавишът Ctrl + W се използва за стартиране на интерактивно опрводяване и след 
това може да се използва отново за включване или изключване на функцията за показ-
ване на клирънса по време на опроводяване. 

Функция за предварителен изглед 
• По време на интерактивното опроводяване за връзката, която в момента се опро-

водява чрез печатен проводник, сегментите на трасето на пистата се показват като щри-
ховани или кухи (празни). Всички щриховани сегменти се поставят със следващото 
щракване на мишката. 

• Щрихованият сегмент се нарича сегмент Look Ahead. Целта му е да позволи на 
дизайнерите да планират предварително, т.е. да обмислят къде може да бъде поставен 
следващият сегмент, без да е необходимо да се ангажират с него. Режимът Look Ahead се 
включва и изключва с помощта на  бързия клавиш  1 (докато се опроводява). 
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 Щрихованият или празен сегмент се нарича сегмент Look Ahead. Използвайте го, 
за да планирате къде ще бъдат разположени бъдещите сегменти. 

Натиснете 1 по време на маршрутизиране, за да включите и изключите режима 
Look Ahead. 
Преки пътища, налични по време на интерактивно опроводяване. 
• Използвайте * на цифровата клавиатура, за да превключите към следващия наличен 
слой за опроводяване и да поставите Vias. 

• Задръжте Ctrl + Shift, докато превъртате колелото на мишката, за да преминавате 
от следващия наличен слой за опроводяване и поставяне на Vias. Всяко щракване на ко-
лелото на мишката води до превключване на един слой. 

• Използвайте Shift + R, за да преминете през наличните режими за разрешаване 
на конфликти при опроводяване. 

• Използвайте Shift + Spacebar, за да превключвате циклично достъпните режими 
на ъглите на поставяните пътечки /печатни проводници/. За размера на дъгата при зак-
ръгления на ъглите на пътечките използвайте „,“ и „.“ бутони на клавиатурата, за да на-
малите или увеличите размера и. 

•Spacebar превключва посоката на последния ъгъл. 
• Използвайте Backspace, за да „извадите“ последния поставен сегмент (и). 
• Използвайте Shift + W, за да отворите диалога Избор на ширина, за да промените 

ширината на пътечката. 
• За да преминете към следващия наличен сигнален слой и да поставите Vias чрез: 
- Натиснете клавиша * на цифровата клавиатура или 
- Използвайте комбинацията от клавиши Ctrl + Shift + Wheel Scroll. 
• Ако щракнете, за да започнете опроводяване на контактна площадка с отвор /pad/ 

или via и осъзнаете, че сте на грешен слой, натиснете клавишната комбинация L, за да 
преминете през наличните сигнални слоеве, без да добавяте via. 

• Използвайте Ctrl + Click, за да инструктирате програмата за интерактивно опро-
водяване да се опита автоматично да завърши текущото опроводяване. 

• Натиснете Shift + F1, докато опроводявате, за да покажете интерактивните преки 
пътища (или тилдата – бутона ~). 

• Командите, за смяна на слоя, са: 
- Използвайте Ctrl + L, за да отворите списък с налични слоеве, след което щракне-

те, за да изберете желания слой. 
- Използвайте клавишите от 1 до 10 на цифровата клавиатура, за да преминете вед-

нага към този номер на слоя. 
- Отворете панела Свойства /Properties/, за да покажете Z изгледа на via, което може 

да се използва за промяна на слоя. 
4.3.3. Режим на следване при Interactive Router. 

Често срещано изискване по време на опроводяване е да се постави пътечка, която 
да следва съществуваща форма или контур. Този контур може да бъде препятствие, из-
рязване или край на платката или съществуващо опроводяване. 

Вместо да се налага да се опроводява "срещу" контура, като се използват внимателни и 
точни движения на мишката и щраквания, за да гарантирате, че новата пътечка следва 
контура, в режим "Следване" щракнете, за да изберете контура, след това преместете кур-
сора по контура, за да определите посоката на опроводяване. В режим "Следване" инте-
рактивният опроводител ще добави сегменти на пътечки и дъга, така че новата пътечка 
да следва контура в съответствие с приложимите правила за дизайн. Тази функция е 
особено полезна при поставяне на извити пътечки. 
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За да използвате функцията: 
• Стартирайте интерактивното опроводяване, щракнете, за да изберете електрическа 
връзка за опроводяване и преминете към необходимия стил на ъгъла (Shift + Spacebar). 
• За да следвате контур, поставете курсора върху необходимия обект и натиснете Shift + 
F. Интерактивният рутер ще открие обекта под курсора и ще премине в режим на след-
ване. 
• Преместете курсора в желаната посока; софтуерът автоматично ще постави сегменти на 
пътечката и дъги на печатния проводник, за да следва контура в тази посока. 
• Щракнете с левия бутон, за да поставите сегментите на пътечката и да излезете от ре-
жим „Следване“. 
• Завърщете опроводяването според изискванията. 

Режим за разрешаване на конфликт при опроводяване 
Както бе споменато, интерактивният опроводител реагира на обекти, които вече са 

в работното пространство на PCB, като например контактни площадки на други nets, в 
зависимост от текущия режим на разрешаване на конфликт при опроводяване. Конфи-
гурирайте кои режими за разрешаване на конфликти са достъпни по време на опроводя-
ване в PCB Editor - в Interactive Routing  настройките на Preferences. 

Режимите за разрешаване на конфликти включват: 
• Игнориране на пречките /Ignore Obstacles/ - игнорират се съществуващи обекти 

(опроводяването може свободно да се постави). Нарушенията /Violations/ се осветяват. 
• Push Obstacles – избутва се съществуващите пътечки и прошивки, за да се напра-

ви място за новата пътечка. 
• Обходни препятствия /Walkaround Obstacles/ - опит за намиране на път около 

съществуващите обекти. Клирънсът /минималното разстояние/ към други обекти се оп-
ределя от приложимото правило за дизайн на клирънс. 

• Стоп при първо препятствие/Stop At First Obstacle/ - в този режим опроводява-
нето ще спре при първото препятствие, което попадне на пътя. 

• Hug And Push Obstacles - в този режим опроводителят ще следи отблизо за съ-
ществуващи обекти и ще ги избутва само когато няма достатъчно място за пътечката, ко-
ято се опроводява. 

• AutoRoute на текущия слой - този режим прилага интелигентността на автоматич-
ния опроводител към интерактивния опроводител, като автоматично избира между из-
бутване и преминаване край обекта, за да даде най-кратката обща дължина на пътечката. 

• AutoRoute на множество слоеве - този режим прилага интелигентността на авто-
матичния опроводител към интерактивния, като автоматично избира между избутване, 
преминаване или превключване на слоеве, за да даде най-кратката обща дължина на пъ-
течката. Текущият режим на разрешаване на конфликти се показва на лентата на състоя-
нието в долната част на Altium Designer.  

 
Използвайте клавишите за бърз достъп Shift + R, за да преминете през наличните 

режими по време на интерактивно опроводяване. 
На фиг. 4.17 е представена опроводената печатна платка на разработвания Усилва-

тел 200 W, заедно с крепежните отвори и размерните линии във стандартизиран формат 
на чертожния лист, а на фиг.4.17 и 3D изгледа. 
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Фиг. 4.17. Опроводена PCB на Усилвател 200 W. 

 
Фиг. 4.18. PCB в 3D режим на Усилвател 200 W. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №7 

 СЪЗДАВАНЕ НА БИБЛИОТЕКИ С КОМПОНЕНТИ ЗА ПЕЧАТНА 
ПЛАТКА В ALTIUM DESIGNER. 

 

1. Теоретична обосновка. 

 Създаването на библиотеки и библиотечни компоненти за печатните платки 

в Altium Designer е свързано със следните въпроси: 

 - Създаване на PCB компоненти /корпуси/ по два начина: ръчно и използвайки 

Component Wizard; 

 - Проверяване на компонентите използващи PCB Library Editor reports; 

 - Създаване на цялостна библиотека от нови компоненти и модели. 

- Създаване на цялостна библиотека от нови компоненти и модели. 

1.1. Създаване на корпус на РСВ компонент. 

Тази част от обучението покрива следните теми : 

- Създаване на нова PCB библиотека 

- Използване на Component Wizard за създаване на корпуси на схемни компоненти 

- Ръчно създаване на необичайни корпуси в PCB библиотека 

- Използване на routing примитиви в корпуси. 
Корпусите могат да бъдат създавани в PCB Editor и да се копират в PCB библиоте-

ката, копирани между PCB библиотеки, или създадени отначало с помоща на PCB 
Library Editor’s PCB Component Wizard или инструменти за изчертаване. Ако имате гото-
ва PCB и всички корпуси вече са поставени, може да използвате командата 
Design→Make PCB Library в PCB Editor за да генерирате PCB библиотека включваща 
тези корпуси. 

AD също включва изчерпателни библиотеки с предефинирани through-hole и 
SMD корпуси за използване при дизайна на PCB. Библиотеките с корпуси (.PcbLib фай-
лове) се намират в папката \Altium\Library в директорията където са разположени биб-
лиотеките на AD. 

1.2. Създаване на нова PCB библиотека. 

За да създадете нова PCB библиотека : 

1. Изберете File→New→PCB Library. Файлът на новата PCB библиотека 

PcbLib1.PcbLib е създаден и се отваря празна страница за компонент PCBComponent_1 в 

работният прозорец. 

2. Преименуваме новата PCB библиотека на Footprints.PcbLib за примера, като из-
бираме File →Save As. 

3. Отваряме PCB Library Editor панела като кликваме върху PCB Library менюто. 
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4. Сега можете да добавяте, премахвате или променяте корпусите на компонентите  

в новата PCB библиотека, използвайки командите в PCB Library Editor. 

1.3. Използване на PCB Component Wizard. 

PCB Library Editor включва Component Wizard, с него можете да създавате корпуси 

на компоненти базирани на въпроси които ви се задават. Ние ще използваме wizard за да 

създадем корпус DIP14. 

За да създадете вашият нов корпус , DIP14, използвайки Component Wizard: 

1. Изберете Tools→New Component. Component Wizard автоматично стартира. 
Натиснете Next > за да преминете напред. 

 
 
2. Отговаряйте на въпросите които ви се задават, като избирате от възможностите 

които са налични. За да създадете вашият DIP14, изберете Dual in-line Package (DIP). 
3. Натискайте Next > докато се стигнете до последната станица на Wizard и натис-

нете Finish. Името на файла DIP14, ще се появи в списъка с компоненти в PCB Library 
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Editor и новият корпус ще бъде показан в работният прозорец. Тогава вие можете до-

пълнително да променяте компонента според вашите изисквания. 

4. Запишете библиотеката с новият корпус като изберете File→Save. 

1.4. Ръчно създаване на корпуси. 

Корпусите се създават и променят в PCB Library Editor използвайки само инстру-

ментите и обектите за изработка налични в PCB Editor. 

За да създадете корпус ще поставите линии /пътечки/ и дъги и 
след поставяне на контактните площадки на изводите и връзките. Тези 
обекти могат да бъдат поставени върху какъвто и да било слой. Когато 
поставите корпуса в PCB всички обекти които изграждат корпуса ще 
бъдат прехвърлени на техните дефинирани слоеве. 

За ръчно създаване на корпус: 
1. Изберете Tools→New Component. Component Wizard ще 

стартира автоматично. 
2. Натиснете Cancel за да прекратите изпълнението на Wizard и 

ръчно да създадете компонент. Появява се празно работно пространст-
во за създаване на корпус на компонент на име PCBComponent_2. 

3. За да преименувате този корпус, изберете PCBComponent_2 от списъка в PCB 
Library Editor панела и щракнете двукратно. Отваря се диалогов прозорец Rename 
Component. 

4. Препоръчително е да изграждате корпусът на компонента около точка 0, 0 от 
работното пространство наречена reference point. Изберете Edit→Jump→Reference за 
да позиционирате курсора на координати 0, 0. 

Reference point е точката в която трябва да задържите компонента когато го поста-
вяте. По принцип това е точката която се явява център на платката или геометричен цен-
тър на компонента. Reference point може да се задава по всяко време, като се използва 
Edit→Set Reference от настройките в подменюто. 

1.5. Поставяне на pads на нов корпус. 

Една от най – важните процедури при създаването на нов корпус е поставянето на 
pads които се използват за закрепването на компонента към PCB. Те трябва да бъдат пос-
тавени в точно правилната позиция за да могат да съответстват на изводите на физичес-
ките устройства. 

За да поставите pads на корпус: 
1. Натиснете Top Layer слоя най – 

долу в раборният прозорец преди да за-
почнете поставянето на pads. 

2. Изберете Place→Pad или на-
тиснете бутона от лентата с инструмен-
ти. Pad се появява след курсора. Преди 
поставянето на първият pad, натиснете 
клавиша TAB за да дефинирате негови-
те свойства. Появява се диалоговият 
прозорец Pad. 

 Променете размера и офрмление-
то както се изисква и задайте Designator 
да бъде 1 ( за да кореспондира с номера 

на пина на компонента ). Натиснете ОК. 
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3. Позиционирайте курсора и кликнете или натиснете клвиша ENTER, за да пос-
тавите първият pad и го поставете в центъра на координати 0, 0 . 

4. Преди да поставите следващият pad, натиснете клавиша TAB за да направите 
промени. Обърнете внимание, че pad designator нараства автоматично. 

5. Натиснете десният бутон на мишката, или клавиша ESC, за да излезете от режи-
ма на поставяне на pad. 

6. Запишете корпуса като изберете File→Save. 
1.6. Pad Designators и Paste Arrays. 

Pads могат да се обозначат с designator ( обикновенно представлява номера на извода 
на компонента), с до четири знака, букви и цифри без интервали. Ако designator-а започ-
ва или завършва с число, номерът ще се увеличава автоматично при поставяне на серия 
от pads последователно. За да се постигнат алфа увеличения, т.е. 1А, 1В, или увеличаване 
на номерата се използват предварителните настройки на редактора. 

Като настройки на pad designator при копиране в клипборда се копират и настрой-
ките от полетата за увеличаване в Paste Array прозореца, следните типове  pad designator 
могат да бъдат поставени: номера ( 1, 3, 5); букви ( А, В, С ) 

- комбинация от букви и цифри ( А1 А2, или 1А 1В, или А1 В1, или 1А 2В , т.н. ) 
За увеличаване на номерата, задайте в полето за нарастване стойността до която ис-

кате да нарастват. За нарастване на буквените в полето за нарастване номерата на буквите 
които искате да пропуснете. 

1. Създайте pad с designator, т.е. 1А. Копирайте този pad в клипборда като използ-
вате Edit →Copy. Центрирайте pad като дефинирате reference point. 

2. Изберете Edit→Paste Special. Появява се диалоговият прозорец Paste Special. 
Изберете Paste on current layer и Keep net name. 

3. Натиснете бутона Paste Array за да се покаже диалоговият прозорец Setup Paste 
Array. 

4. За примера задайте Item Count да бъде 5, нарастването С, изберете Linear Array 
Type и подходящ масив за копираният pad и натиснете ОК. 

5. Кликнете за да поставите масива. Проверете pad designators нарастват ли както 
беше очаквано. 

 
Рисуване очертанията на 

нов корпус 
Ще създадем очертанието на 

корпус на най-горният слой така, че 
да може да бъде включено в 
silkscreen mask по време на произ-
водството на PCB. Очертаването е 
само като ръководство за оператора 
при насищането на платката. Поста-
вянето на pads е решаващо, тъй като 
ако не са точни размерите и очерта-
нията, няма да могат да се монтират 

правилно елементите, особено при автоматизиран монтаж. 
1. Натиснете Top Overlay менюто най-долу в работният прозорец преди да започ-

нете поставянето на линиите. 
2. Проверете производствените спецификации на корпуса. Натиснете Q за да про-

мените координатите от инчове в милиметри. Проверете координатите в Status bar най – 
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долу на екрана за да видите в кой режим за измерване сте вие (mils или mm). Поставете и 
мрежата като изберете Tools →Library Options. 

3. Използвайте инструмента линия за да очертаете компонента на най горно ниво. 
Изберете Place→Line. 

4. Кликнете за да дефинирате стартова точка на пътя който е дефиниран за корпу-
са. 

5. Натиснете клавиша TAB за да дефинирате линия ( 0,2 mm ) и проверете нивото 
в прозореца Line Constraints. 

6. Кликнете за да създадете пътищата на очертанията и натиснете десният бутон за 
край на тази серия сегменти. 

7. За да излезете от режима на поставяне на пътища, кликнете с десният бутон на 
мишката или натиснете ESC. 

Поставяне на Designator и специални низове за коментар 
Специални низове, Designator и коментар, могат да бъдат добавяни към корпусите в 

PCB Library Editor, ако вие искате контрол над техният слой, местоположение и атрибу-
ти преди поставянето на компонента върху  PCB  листа. 

Типично за тези специални низове, е че се поставят в механичните слоеве които са 
включени в събирателният чертеж. Показва се изисквания механичен слой, като се избе-
ре Tools →Layers & Colors. Натиснете Enable и после Show 

1. Натиснете в менюто Mechanical layer най – долу в работният прозорец за да ак-
тивирате този слой. 

2. Изберете Place→String, или натиснете бутона Place String от менюто. 
3. Натиснете клавиша TAB за да определите типа на текстовият низ и да се дефи-

нират неговите свойства, т.е. шрифт, размер и ниво, преди да поставите текста. Показва 
се диалоговият прозорец String. Изберете .Designator от падащото меню. 

4. Сега ние можем да поставим текстовият низ. Позиционирайте текстовият низ в 
изискваното местополужение и кликнете. 

5. Поставете специален низ като коментар използвайки същата процедура. 
6. Щракнете с десният бутон на мишката или натиснете бутона ESC за да излезете 

от режима на поставяне. 
Ако текста не се покаже когато корпуса се постави в PCB документа, уверете се че 

Convert Special Strings опцията е избрана в менюто Display от прозореца Preferences 
(Tools →Preferences) в PCB Editor.   

Създаване на цялостна библиотека 
Сега ние можем да създадем библиотека на схема с някакви компоненти на схемата 

и PCB библиотека със свързани модели на корпуси, ние можем да ги добавим към пакета 
на библиотеката и след това да ги компилираме заедно в цялостна библиотека. Компо-
нентите тогава ще се съхраняват винаги със своите модели. Забележете, че файловете на 
модела за симулация трябва да бъдат копирани в библиотеки на същата папка като из-
точникът преди компилиране. 

Стъпките за създаване на цялостна библиотека са: 
1. Избиране на пакет от библиотеката източник  като изберете File→New 

→Integrated Library. Показва се панелът Projects с празен Library Package файл на име 
Integrated Library1.LibPkg. Преименувайте новоят Library Package като използвате 
File→Save As. 

2. Добавете библиотеката източник към Library Package като изберете Project→Add 
Existing to Project. Прегледайте за да намерите библиотеките на схеми (. schlib ) и библи-
отеките на модели (. pcblib ), Protel 99 SE библиотеки (. lib ), SPICE модели или Signal 
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Integrity модели които вие искате да добавите във вашият Library Package. Натиснете 
Open и добавете библиотеките които са изброени като Source Libraries в панела Projects. 

Ако вие не искате да добавяте в библиотеките на модели и файлове, вие можете да 
укажете пътя където те се помещават на вашият твърд диск с натискане на десният бутон 
на мишката върху името на Library Package в панела Projects като изберете Project 
Options. 

3. Компилирайте библиотеката източник и файловете на модела в библиотечен 
пакет в цялостната библиотека, като изберете Project→Compile Integrated Library. 
Всички грешки или предопреждения се показват в панела Messages. 

4. Генерира се новата Integrated Libraryname.INTLIB, записва се в изходяща папка 
намирараща се в манюто Options от прозореца Project Options и показваща се в панела 
Library готово за използване. Integrated library автоматично се добавя към текущият спи-
сък с библиотеки в панела Libraries. 

2. Цел на лабораторното упражнение. 
Създаване на компоненти и библиотека за проектиране на печатна платка с 

използването на специфични елементи. 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема. Въвеждане на елементи-

те, опроводяване и ERC проверка.  

3.2. Създаване на печатна платка в стандартизиран формат. Промяна разме-

рите на платката. Създаване на библиотечни елементи и библиотеки за печатни 

платки с 2D и 3D модели. 

3.3. Прехвърляне на схемотехническата информация и отстраняване на евен-

туални грешки. Разработка на печатна платка с използването на Interactive Routing. 

Преходи между слоевете. Динамична промяна на широчината на пътечките. 

4. Указания. 
4.1. Описание на принципната електрическа схема. Въвеждане на елементите, 

опроводяване и ERC проверка. 

4.1.1. Описание на принципната електрическа схема. 

 Схемата (фиг. 7.1) може да се разглежда като съставена от три основни части: 
Първата представлява микрофонен усилвател, изпълнен с транзистора Т1, преднапре-
жението на който е подбрано така, че транзисторът да работи като усилвателно стъпало 
от клас А. Във веригата на кондензаторния микрофон е последователно свързан потен-
циометърът за регулиране чувствителността на устройството. Избрахме такъв вариант за 
регулиране, тъй като свързването на потенциометър към базата на транзистора Т1 създа-
ва възможност за неприятно самовъзбуждане на схемата при допир на потенциометъра. 
Същевременно при такова свързване може да се постигне добро качество на регулиране 
на чувствителността, така че ефектът да работи както при съвсем слабо ниво на звука, 
така и при много силна музика. Изходът от усилвателното стъпало се подава през разде-
лителния кондензатор С2 към входа на тондекодера (ИС1), на базата на който е изграде-
на и втората част от схемата, предназначението на която е да изработи сигнал за запал-
ване на “Блитц”-а, при наличие на определена честота в приемания от микрофона ауди-
осигнал. Задаването на честотата се извършва с помощта на потенциометъра Р2, който 
заедно с постоянния резистор R4 е свързан между крачета 5 и 6 на интегралната схема. 
При така подбраните стойности на резистора и потенциометъра, средната честота на 
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тондекодера може да се променя в границите 90Hz – 2kHz. Ако желаете да промените 
този обхват на регулиране, е достатъчно да промените стойностите на постоянния ре-
зистор R4 и на кондензатора С3. 

 
Фиг. 7.1. Принципна схема на електронно устройство за дискотечен „Блитц“ ефект. 

Към изхода на ИС1 е включен транзисторът Т2. Този транзистор трябва да работи 
в ключов режим, т. е. нормално той трябва да бъде напълно отпушен, а при получаване 
на ниско ниво от изхода на ИС1 да се запушва напълно. При това запушване падът на 
напрежение между неговия колектор и емитер се подава през токоограничаващия резис-
тор R8 към управляващия електрод на тиристора Т. Третата част на схемата представлява 
самото захранване на импулсната ксенонова лампа. За да стане ясна работата на тази част 
от схемата обаче, тук ще напомним, че за нормална работа на ксеноновата лампа се 
изисква към двата електрода на тръбичката да бъде подадено постоянно напрежение от 
порядъка на 300-400V, а към средния (управляващ) електрод да се подават стръмни висо-
коволтови импулси, които са необходими за запалване на лампата. 

В нашата схема е използвана една от най-популярните импулсни газоразрядни лам-
пи – ИФК120. Постоянното захранващо напрежение от 300V се получава след еднопо-
лупериодно изправяне на мрежовото 220V напрежение посредством веригата R10, R11, 
D6 и се филтрира от кондензаторната група С9 и С10. Общият капацитет на тази група 
не трябва да е по-малък от 22 F, а работното и напрежение не бива да е по-малко от 
400V, но кондензатор с такива данни трудно се намира на пазара. По тази причина ние 
сме използвали два последователно свързани кондензатора от 47 F/ 350V, каквито може-
те да заявите и чрез редакцията на списанието. При използване на по-малък капацитет 
не е възможно да се постигне максималната честота на мигане на ксеноновата лампа, а 
при по-ниско работно напрежение съществува опасност от повреда на кондензаторите. 

Високоволтовите импулси за запалване на тръбичката се получават посредством 
повишаващото трафче (за печатен монтаж), в първичната намотка на което се получават 
бързи разреждания на кондензатора С8 при всяко отпушване на тиристора. Работното 
напрежение на този кондензатор не бива да е по-малко от 630V. 

4.1.2. Въвеждане на елементите, опроводяване и ERC проверка. 

Пристъпваме към създаването на схемотехнична библиотека, както е описано в 

точка 1.2. в Лабораторно упражнение №3. Променяме името на библиотеката, например 

Upr.7.SchLib. Препоръчва се имената на файловете в AD да са на латиница. 

Започваме създаването на библиотечен компонент за ИС LM567, трябва първо да 

създадем нов компонент в библиотеката с бутона Add от панела SCH Library и в отворе-

ния чертожен прозорец да започнем изчертаването около координати(0,0). Подходящ е 
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за използване инструмента Place Rectangle с който изчертаваме правоъгълник с размери 

съобразени с броя крачета от всяка страна, съгласно фиг.7.1. Поставяме изводите съглас-

но т. 1.7.3. в Лабораторно упражнение №3. Трябва да присъединим подходящ модел на  

корпуса. По описанието на ИС се ориентираме към пластмасов корпус с 8 извода двуст-

ранно разположени около корпуса. Това съответства на стандартен корпус DIP-8, достъ-

пен от библиотеките на AD. Правим настройки на означението DA? В полето Default 

Designator, а в полето Default Comment попълваме LM567. Другият корпус на  LM567 е 

означен като H08C, а по международната класификация е TO-8. Този корпус трябва да 

се начертае като нов компонент в PCB библиотеката. 

За пасивните елементи и ценеровите диоди използваме стандартни означения, кои-
то са разположени в библиотеката BDS-ISO.Intlib.  

За да предвидим място за крепежните елементи поставяме от същата библиотека 
компонентите BOLT, като въвеждаме 3.5 mm за Comment и F3.5x14-Bolt за Footprint. 

Вида на въведената схема е представен на фиг.7.2. 

 
Фиг. 7.2. Въведена в AD схема на електронно устройство за дискотечен „Блитц“ ефект. 

 
4.1.3. Въвеждане на елементите, опроводяване и ERC проверка. 

След завършване на опроводяването между отделните елементи се прави проверка 

за тяхното правилно свързване, правилно наименование на елементите и други липси и 

пропуски, които би могло да бъдат пропуснати по време на изчертаването.  

4.2. Създаване на печатна платка в стандартизиран формат. Промяна разме-

рите на платката. Създаване на библиотечни елементи и библиотеки за печатни 

платки с 2D и 3D модели. 

4.2.1.  Създаване на печатна платка в стандартизиран формат. Промяна раз-

мерите на платката. 
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След въвеждане на схемата, за да работим в стандартен формат по БДС, се отваря 

чертожен лист на платка с формат А3 от предварително създадения файл 

A3_ISO.pcbdoc, като е желателно той да бъде преименуван, например в Upr.7.PcbDoc. 

Прехвърля се информацията от схемата към печатната платка, която се преоразмерява. 

Преди разполагане на елементите променяме размерите на печатната платка на 

120х70 като са предвидени 4 отвора за закрепване на печатната платка, 4 на 5 mm от ръ-

бовете на платката.  За да преоразмерим платката е необходимо да начертаем новите 

размери в слоя Keep Out Layer. Преди това е препоръчително да преместим началото на 

координатната система в долния ляв ъгъл на бъдещата платка с командата Edit 

→Origin→Set.  

4.2.2. Създаване на библиотечни елементи и библиотеки за печатни платки с 

2D и 3D модели. 

За да създадем нова PCB библиотека избераме File→New→PCB Library. Създава се 

файлът на новата PCB библиотека PcbLib1.PcbLib и се отваря празна страница за ком-

понент PCBComponent_1 в работният прозорец. Преименуваме новата PCB библиотека 

на Upr.7.PcbLib, като избираме File →Save As. Отваряме PCB Library Editor панела като 

кликваме върху PCB Library менюто. Създаваме два нови компонента с корпусите на еле-

ментите ИС LM567 и трансформатора Тр.1, съответно TO-8 и SP-E 36/11. За геомет-

ричните размери и оформлението на компонентите се ръководим от техническата доку-

ментация за двата корпуса. Самото въвеждане на компонентите става по начина описан в 

т.1.4. и т.1.5. 

4.3. Прехвърляне на схемотехническата информация и отстраняване на евен-

туални грешки. Разработка на печатна платка с използването на Interactive Routing. 

Преходи между слоевете. Динамична промяна на широчината на пътечките. 

Прехвърлянето на информация към PCB става от схемата Upr.7.schdoc с командата 

Design→Update PCB Document Upr.7.PcbDoc при което се отваря прозореца 

Engineering Change Order.  

Ако няма предварително забелязани грешки натискаме бутона Validate Changes и ако ста-

тусът на всички елементи и връзки е в зелено в секцията Check финализираме прех-

върлянето на информация с бутона Execute 

Changes.  

По нататък се повтарят стъпките описани в 
Лабораторно упражнение №6 по отношение на 
разполагането на компонентите върху очертанията 
на печатната платка, като се спазват правилата за 
разполагането на елементите.  

Полезна функция за намаляване на електро-
магнитните  излъчвания на пътечките е функцията 
за закръгляне на острите ъгли при разклоненията на 
печатните проводници т.нар. „teardrops“. Командата 
за изпълнението е Tools>teardrops, след като плат-
ката е опроводена и проверена за грешки с команда-

та Tools>Design Rule Check. Появява се диалогов прозорец за настройки на корекции-
те на опроводяванията, показан на фиг.7.3. 
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Вида на готовата печатна платка във формат А3 е показан на фиг.7.4., а изгледа на 
платката в , а изгледа на платката в 3D - на фиг.7.5. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №8 

 СИМУЛАЦИЯ НА РАБОТАТА НА ЕЛЕКТРОННИ СХЕМИ В ALTIUM 

DESIGNER 

1. Теоретична обосновка.  

  
1.1. Видове анализи 

Смесеният симулатор поддържа широк спектър от типове симулационен анализ, 
включително: Анализ на работната точка; Преходен анализ; Анализ на Фурие; DC Sweep 
анализ; Малосигнален анализ на променлив ток; Анализ на импедансния график; Анализ 
на шума; Полюсно-нулев анализ; Анализ на трансферната функция; Монте Карло ана-
лиз; Параметричен анализ; температурен анализ. 

Диалоговия прозорец на „Advanced Options“ позволява да дефинирате разширени 
опции за симулация, включително стойностите на SPICE променливите, метода на ин-
теграция, използван от Simulation Engine и симулационната референтна мрежа. По 
принцип не трябва да променяте нито един от параметрите в тази страница на диалого-
вия прозорец за точна симулация. Променете тези опции само ако разбирате параметри-
те за симулация на SPICE. 

1.2. Симулационни модели 

Базирания на Altium Designer Circuit Simulator е истински симулатор за смесени сиг-
нали, което означава, че може да анализира вериги, които включват както аналогови, така 
и цифрови устройства. 

Симулаторът използва подобрена версия на задвижвания от събития XSpice, разра-
ботен от Института за технически изследвания в Джорджия (GTRI), който сам се основа-
ва на кода SPICE3 на Бъркли. Той е напълно съвместим с SPICE3f5, както и осигурява 
поддръжка за редица модели на електронни елементи за Pspice®. 

Моделите, поддържани от симулатора, могат ефективно да бъдат групирани в след-
ните категории: 

1.2.1. SPICE3f5 аналогови модели 

Това са предварително дефинирани аналогови модели устройства, които са вграде-
ни в SPICE. Те покриват различните често срещани аналогови типове компоненти, като 
резистори, кондензатори и индуктивности, както и източници на напрежение и ток, 
преносни линии и ключове. Моделират се и петте най-често срещани полупроводнико-
ви устройства – диоди, BJT, JFET, MESFET и MOSFET. 

Включени са и голям брой файлове с модели (* .mdl), които определят поведението 
на конкретни екземпляри на тези устройства. 

1.2.2. PSpice аналогови модели 

Това са предварително дефинирани аналогови модели на елементи, които са вгра-
дени в Pspice. За съвместимост с тези модели са направени промени в общото описание 
за съответния елемент в SPICE3f5 и/или е добавена допълнителна поддръжка на пара-
метри за използване в свързан файл на модел. Тези модели не са конкретизирани отдел-
но. Информацията за поддръжка на Pspice е включена като част от информацията за съ-
ответния модел на елемент в SPICE3f5. 

1.2.3. XSpice аналогови модели 

Това са предварително дефинирани кодови модели на аналогови елементи, които 
са вградени в Xspice. Кодовите модели позволяват да се определят сложни, неидеални 
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характеристики на елементите, без да е необходимо да се разработват дефиниции на 
подсхеми с дълги вериги, които могат да повлияят неблагоприятно на скоростта на си-
мулатора. Предоставените модели покриват специални функции като усилване, хистере-
зис, ограничаване на напрежението и тока и дефиниции на трансферни функции на s-
домейн. SPICE префиксът за тези модели е А. 

1.2.4. Подсхемни модели 

Това са модели за по-сложни устройства, като операционни усилватели, таймери, 
кристали и т.н., които са описани с помощта на йерархичния синтаксис като подсхема. 

Подсхемата се състои от SPICE елементи, които се дефинират и препращат по на-
чин, подобен на моделите на дискретните елементи. Няма ограничение за размера или 
сложността на подсхемите и подсхемите могат да извикват други подсхеми. Всяка под-
схема е дефинирана във файл от типа (* .ckt). 

Префиксът в SPICE за моделите на подсхемите е X. 
1.2.5. Модели на математически функции 

Математическите функции позволяват на конструктора да извършва поведенческо 
моделиране на веригата. Префиксът в SPICE за моделите на тези функции също е X. 

1.2.6. Цифрови модели 

Това са модели на цифрови устройства, които са създадени с помощта на езика 
Digital SimCode ™. Това е специален описателен език, който позволява да се симулират 
цифрови устройства с помощта на разширена версия на XSpice, управлявана от събития. 
Това е форма на стандартния код XSpice. Изходния код на модела тип SimCode се съх-
раняват в текстов файл ASCII (* .txt). Компилираните модели SimCode се съхраняват в 
компилиран файл на модел (* .scb). Няколко модела на цифрови схеми могат да бъдат 
поставени в един и същ файл, като всяка препратка става чрез специален параметър 
"func =". Префиксът в SPICE за моделите на тези устройства е A. 

Digital SimCode е патентован език - устройствата, създадени с него, не са съвмести-
ми с други симулатори, нито са създадени цифрови компоненти за други симулатори, 
съвместими с базирания на Altium Designer симулатор на смесен сигнал. 

Много от библиотеките с компоненти (* .IntLib), които се доставят с инсталацията, 
включват елементи и устройства, готови за симулация. Тези устройства имат необходи-
мия модел или файл на подсхемата и са свързани към схематичния компонент. Това са 
чисто SPICE модели за максимална съвместимост с аналогови симулатори. 

Не са направени промени в синтаксиса между SPICE3f3 и SPICE3f5. Следователно 
наръчникът за SPICE3f3 описва правилния синтаксис за списъка с връзките и моделите, 
поддържани от симулатора на смесен сигнал на Altium Designer. 

1.3. Компонентни и симулационни мултипликатори 

При въвеждане на стойност за компонент или друг параметър, свързан със симула-
ция, стойността може да бъде въведена в един от следните формати: 

Като цяло число (напр. 10) 
Като стойност с плаваща запетая (напр. 3.142) 
Като цяло число или стойност с плаваща запетая, последвано от цяло число степен 

(например 10E-2, 3.14E2) 
Като цяло число или стойност с плаваща запетая, последвано от валиден коефици-

ент на мащаба. 
 
По отношение на последния формат, по-долу е даден списък на валидни коефици-

енти на мащаба (множители), които могат да бъдат използвани: 
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Символ Множител 

T 10 12 

G 10 9 

Meg 10 6 

K 10 3 

mil 25.4 -6 

m 10 -3 

u (or μ) 10 -6 

n 10 -9 

p 10 -12 

f 10 -15 

Буквите, непосредствено след стойността, които не са валидни коефициенти на 
мащаба, ще бъдат игнорирани. Буквите, непосредствено след валиден коефициент на 
мащаба, също се игнорират. Те могат да бъдат полезни като препратка към използваните 
мерни единици, когато се разглежда компонентът на схемата и съответният параметър се 
прави видим. Мащабните коефициенти трябва незабавно да следва стойността - интер-
валите не са разрешени. Мащабните коефициенти могат да бъдат въведени или с малки, 
или с големи букви, или смес от тях. 

Примерни мащабни коефициенти: 
10, 10V 10Volts и 10Hz представляват една и съща стойност, 10. Буквите се игнори-

рат във всички случаи, тъй като нито една от тях не е валиден коефициент на мащаба. 
M, m, MA, MSec и MMhos представляват един и същ мащабен коефициент, 10-3. 

Във всеки случай буквите след първото „m“ се игнорират. 
1000, 1000.0, 1000Hz, 1e3, 1.0e3, 1KHz и 1K представляват едно и също число, 1000. 
 
 

2. Цел на лабораторното упражнение. 
Да се изследва схемата на активен филтър чрез симулация на работата и в 

AD, като се използват основните модели на електронните елементи и моделни па-
раметри в XSpice. 

 

3. Задачи на лабораторното упражнение. 
3.1. Да се начертае схемата на активен филтър показана на фиг.8.1. 

3.2. Да се настоят всички параметри за преходен анализ. Да се разгледат моде-

лите на всички използвани електронни елементи и интегралната схема. 

3.3. Да се разгледа работата на схемата като се направят времедиаграми в ха-

рактерни контролни точки. 

3.4. Да се разучи програмата за визуализация на изходните резултати. 

 

4. Лабораторен стенд и указания. 
4.1. Въвеждане на схемата за симулация.  
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 Ще започнем със създаването на нов файл на проекта и след това ще добавим пра-
зен схематичен лист. Избе-
рете File » New » Project » 
PCB Project от менютата. 
Показва се панелът Проек-
ти. Новият файл на проек-
та, Project1.PrjPCB, е в спи-
съка, без добавени докумен-
ти. Запазете и преимену-
вайте новия файл на проек-
та, като изберете File »Save 
Project As. Придвижете се 
до подходящо място, въве-
дете името Filter.PrjPCB в 
полето File Name и кликне-
те върху Save. 

След това ще създадем 
нов схематичен лист, който да добавим към празния файл на проекта. Тази схема ще бъ-
де за филтърна верига, като можете да изтеглите подобен проект Filter.PrjPCB от стра-
ницата на AD. 

Създайте нов схематичен лист, като изпълните следните стъпки: 
Изберете File » New » Schematic. Празен схематичен лист с име Sheet1.SchDoc се 

показва в прозореца за проектиране на 
редактора на схеми и схематичният лист 
вече е в списъка Документи под името 
на проекта в панела Projects. 

     Преименувайте новия схемати-
чен файл (с разширение .SchDoc), като 
изберете File »Save As. Придвижете се 
до място, където искате да съхраните 
схемата на вашия твърд диск, въведете 
името Filter.SchDoc в полето File Name 
и щракнете върху Save. 

Сега можем да създадем филтър-
ната схема, показана на фиг.8.1. Преди 
да можем да стартираме симулация, схе-
мата трябва да съдържа компоненти с 

прикрепени SIM модели, източници на напрежение за захранване на филтъра, източник 
на възбуждане, справка за земя за симулациите и някои мрежови етикети в точките на ве-
ригата, където искаме да видим времедиаграми. 

Като начало трябва да намерим необходимите компоненти, да настроим свойствата 
на компонентите и след това ще свържем схемата. 

Първо ще потърсим компонента на операционния усилвател, LF411CN. 
Щракнете върху раздела „Library“, за да се покаже панелът на работното простран-

ство „Library“. Натиснете бутона за търсене в панела „Library“ или изберете Tools » Find 
Component. Това ще отвори диалоговия прозорец за търсене на библиотеки. Задайте 
обхвата на Библиотеки по пътя и се уверете, че полето Path съдържа правилния път към 
вашите библиотеки. Ако сте приели директориите по подразбиране по време на инста-
лацията, пътят трябва да е подобен на \Public Documents\Altium\ADХХ \ Library. 

 
Фиг.8.1. 

 
Фиг.8.2. 
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Щракнете върху иконата на папката, за да прегледате самата папка на библиотеката, ако е 
необходимо. Уверете се, че опцията Include Subdirectories е активирана (маркирана). 

Искаме да търсим всички препратки към LF411, така че в текстовото поле за търсе-
не в горната част на диалоговия прозорец за търсене на библиотеки въведете * LF411 *. 
Символът * е заместващ символ, използван за отчитане на различните префикси и су-
фикси, използвани от различни производители. 

Щракнете върху Search, всички библиотеки в посоченото местоположение ще бъ-
дат търсени и резултатите от заявката ще се покажат в панела „Library“, докато се извър-
шва търсенето. 

Ако подходящ компонент не е намерен в инсталираните библиотеки, вместо това 
ще трябва да изтеглите библиотеката. Компонентът, от който се нуждаем е в библиоте-
ката NSC Amplifier.IntLib, която може да изтеглете от връзката към Google Drive -
https://drive.google.com/drive/folders/1r57S4pDoEGTBdoPmSlPvc3DZ4MeIpVzm?usp=s
haring). След като изтеглите библиотеката, създайте папка \ Public Documents \ Altium \ 
ADХХ \ Library \ NSC \, в която да поставите библиотеката. След като направите това, 
повторете процеса на търсене. 

Първият компонент, който ще поставим на схемата, е операционният усилвател, 
U1. За общото оформление на схемата вижте чертежа, показан по-горе. 

Щракнете върху LF411CN в списъка Components на панела Libraries, за да го избе-
рете и щракнете върху бутона Place LF411CN. Като алтернатива щракнете двукратно 
върху името на компонента. 

 
Диалоговият прозорец за потвърждение Confirm (показан по-горе) ще се покаже, ако 

библиотеката не е инсталирана. 
Щракнете върху Yes, за да инсталирате библиотеката. Очертана версия на опера-

ционния усилвател изглежда "плаваща" върху курсора. Вече сте в режим на частично 
разположение. Преди да поставите частта на схемата, първо редактирайте нейните 

свойства. Докато операционният 
усилвател се носи върху курсора, 
натиснете клавиша Tab, за да от-
ворите диалоговия прозорец 
„Свойства на компонента“ - 
Properties. 

В раздела Properties на диа-
логовия прозорец задайте стой-
ността за първия обозначител на 
компонент, като напишете U1 в 
полето Designator. 

След това ще разгледаме 
SIM модела, който ще се използва 
при стартиране на симулацията. 
Използвахме компонент от ин-
тегрирана библиотека, което оз-
начава, че препоръчаните модели 

за симулация на схемата вече са включени. Изберете LF411 в списъка Models долу вдяс-
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но на диалоговия прозорец, след което щракнете върху бутона „Редактиране“ - Edit по-
долу, за да се покаже диалоговият прозорец SIM Model - General / Generic Editor. 

Имайте предвид, че в областта на местоположението на модела Model Location на 
диалоговия прозорец информацията за намерено показва, че моделът е намерен в интег-
рираната библиотека. Щракнете върху раздела Файл на модел в долната част на диалого-
вия прозорец, за да покажете съдържанието на файла на модела Model File (показано 
по-долу). Ако не е намерен файл с модел, в този раздел ще се появи съобщение за греш-
ка. Симулаторът на Altium Designer поддържа модели Spice 3F5 и повечето модели 
PSpice. 

 
Щракнете върху раздела Netlist Template, за да покажете шаблона на netlist. Всяка 

показана тук числова стойност е номерът от списъка Model Pin в раздела „Карта на пор-
та“ Port Map в диалоговия прозорец. 

  
Щракнете върху раздела Netlist Preview , той показва как подробностите ще бъдат 

записани в списъка на SPICE, преди да се симулира. Тъй като схемата е непълна и не е 
съставена, тази подробност все още няма да бъде пълна. Това, което е показано в схема-
тичния номер на извода от символа на компонента, се заменя с името на възела (net), 
свързана към този извод, след като веригата е съставена. 
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Щракнете върху OK, докато всички диалогови прозорци се затворят. Вече сте гото-
ви да поставите операционния усилвател на схематичния лист. 

Позиционирайте операционния усилвател на подходящо място на схематичния 
лист и щракнете, за да го поставите. Съветите за ориентиране на плаващ компонент са 
подробно описани по-долу. 

Излезте от режима на разположение на части, като щракнете с десния бутон или 
натиснете клавиша Esc. 

Съвети за разположение на компонентите (докато компонентът се носи върху кур-
сора): Натиснете интервал, за да завъртите обратно на часовниковата стрелка; Натиснете 
Y, за да обърнете по оста Y; Натиснете X, за да обърнете по оста Z. Натиснете PageUp / 
PageDown, за да увеличите / намалите мащаба. 

Почти във всеки проект за симулация на схема е вероятно да се наложи да използ-
вате файл на симулационен модел, който е получен извън библиотеките на Altium, нап-
ример от уебсайта на производителя на устройството. Освен файловете с модели, съхра-
нявани в интегрирани библиотеки, могат да се използват и дискретни файлове с модели. 
Имайте предвид, че трябва да използвате правилното разширение на файла за всеки тип 
модел. Например SPICE файл тип .subckt няма да бъде намерен, освен ако не е във файл 
*.ckt, нито SPICE модел във файл .model, ако не е във файл *.mdl. Препоръчително е да 
копирате всички файлове на модели, получени от производител, в папката на проекта на 
вашия дизайн, която автоматично се сканира за модели, когато схемата се симулира. 

За демонстрация ще добавим друг модел SPICE, LF411C.ckt. По-надолу са изход-
ните данни за модел за LF411C. С помощта на текстов редактор копирайте съдържание-
то и го поставете в текстов файл, като го запазите с името LF411C.ckt. Запазете файла в 
същата папка като другите документи на проекта. 

 Добавете файла на модела към проекта, като изберете името на проекта 
(Filter.PrjPCB) в панела Projects, щракнете с десния бутон и изберете „Добавяне на същес-
твуващ към проект“ Add Existing to Project. В диалоговия прозорец „Избор на доку-
менти“ Choose Documents задайте филтърния тип на „Всички файлове“ - All files (*.*). Из-
берете файла на модела и щракнете върху Open. Файлът на модел SPICE LF411C.ckt се 
добавя към проекта под папката \ Libraries \ AdvancedSim Sub-Circuits в панела Projects. 
Имайте предвид, че това не се изисква, ако моделът е в папката Projects, но трябва да се 

направи, ако моделите се съхра-
няват другаде, като например 
фирмена папка за съхранение на 
модели на електронни елементи. 

Вече можем да добавим мо-
дела към компонента в схемата. 
Това може да се направи и в 
библиотеката на схемата 
Schematic library за този компо-
нент, ако е необходимо. 

The SIM Model - General / 
Generic Editor dialog displays, as 
shown below. Щракнете двукрат-
но върху операционния усилва-
тел (U1), за да отворите диалого-
вия прозорец Properties. Изтрийте 
съществуващия модел на SIM в  
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раздела Models, като го изберете и щракнете върху Remove, след което потвърдете изт-
риването. 

Щракнете върху стрелката надолу върху бутона Add  в раздела Models List, за да се 
покаже списък с типове модели и изберете Simulation от списъка. 

Показва се диалоговият прозорец SIM Model - General / Generic Editor, както е по-
казано по-долу. 

Изберете Spice Subcircuit от списъка Model Sub-Kind, за да зададете Spice пре-
фикса на X и да активирате полетата Model Location. Имайте предвид, че името на диа-
логовия прозорец се променя, за да отрази подвида на модела. 

Въведете LF411C в полето Model Name (не е необходимо разширение) и изберете 
Model Location на Any, за да търсите във всички налични библиотеки и текущата ди-
ректория на проекта за съвпадащ модел. Имайте предвид, че името на файла не се из-
ползва за търсене на модела, по-скоро се търсят всички .CKT файлове, намерени в ва-
лидните местоположения, за декларацията за модел .subckt LF411C. 

Altium Designer спира да търси модел веднага щом бъде намерено съвпадение. За 
всички модели, които не са обвързани с интегрирана библиотека, търсенето ще продъл-
жи към файловете на моделите, добавени към проекта, и след това към моделиращите 
файлове, намерени в пътищата за търсене, както е настроено в раздела Search Paths в 
диалоговия прозорец „Опции за проект“ (Project » Project Options). В този пример 
търсенето ще намери файла на модела LF411C.ckt, намиращ се в папката на проекта, 
който ще бъде подробно описан в полето Found In в диалоговия прозорец. 

Винаги, когато търсенето на модел не намери съвпадение, в раздела Model File ще 
се появи грешка. Интерактивна грешка също ще се появи в панела „Messages“, когато 
компилирате проекта. 

Последната стъпка е да проверите номерацията на изводите на новия модел, за да 
се уверите, че съвпада с номерирането на изводите на схематичния компонент. Щракне-
те върху раздела Port Map в диалоговия прозорец SIM Model - General / Spice Subcircuit, за да 

направите това. 
Сравнете подробностите, 

показани в раздела Model File на 
диалоговия прозорец, с подроб-
ностите за Schematic Pin и 
Model Pin на модела, изброени в 
горната част на диалоговия про-
зорец. Имайте предвид, че чис-
ловите стойности, използвани за 
идентифициране на връзките 
във файла на модела, не са но-
мера на изводи, те са просто 
уникален числов идентификатор 
за всяка връзка във файла на мо-
дела. Важен е редът на връзките, 
като всяка позиция на връзката в 
реда се отразява от числовата 
стойност, показана в списъка 
Model Pin на модела. За да кар-

тографирате изводите, погледнете функцията на всеки Schematic Pin, като използвате 
описателната информация в раздела за коментари в раздела Model File в долната част на 
диалоговия прозорец, намерете тази връзка, намерете нейното числово положение в 
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оператора .SUBCKT (напр. 3 за третата връзка), след това задайте числовата стойност на 
Model Pin на модела в горната част на диалоговия прозорец (двойно щракване за редак-
тиране). 

Ако схематичният символ е многоелементен компонент, тогава ще повторите про-
цеса за всяка част от интегралната схема. Когато приключите с картографирането на из-
водите, щракнете върху OK, докато всички диалогови прозорци се затворят. Сега ще 
продължим със създаването на готова за симулация схема на филтър. 

След това ще поставим двата резистора. В панела „Libraries“ направете библиотеката 
„Miscellaneous Devices.IntLib“ активната библиотека. 

Задайте компонента Filter, като въведете res в полето за филтриране точно под 
името на библиотеката. 

Щракнете върху Res1 в списъка с компоненти, за да го изберете, след което щрак-
нете върху бутона Place Res1. Вече ще имате символ на резистор, плаващ върху курсора. 

Преди да поставите, натиснете клавиша Tab, за да отворите диалоговия прозорец 
за свойства и да редактирате настройките на резистора. В раздела Properties на диалого-
вия прозорец задайте Designator на R1. 

Симулаторът не използва полето за коментар на компонента, за да установи стой-
ност на дискретен компонент, той търси параметър, наречен Value. Уверете се, че резис-
торът има параметър, наречен Value, и задайте стойността на този параметър на 100K. 
Ако няма параметър Value, добавете такъв и задайте стойността му на 100K. 

Потвърдете, че квадратчето Visible за параметъра Value е изчистено (не е активи-
рано). За да покажете тази Value на схемата вместо низ Comment, използвайте падащото 
меню Comment и изберете =Value от списъка. Това инструктира Altium Designer да по-
каже съдържанието на параметъра Value вместо низа Comment. Това също ще бъде 
предадено на печатната платка, за да се използва като низ за Comment на компонента на 
печатната платка. Потвърдете, че квадратчето Visible за полето Visible е активирано. 

Сега, за да проверите SIM модела в списъка Models list, долу вдясно на диалоговия 
прозорец. Намерете симулационния модел и щракнете двукратно, за да се покаже диало-
говият прозорец Sim Model - General / Resistor. Този тип резистор не изисква файл с модел 
и той взема стойността, изисквана от шаблона за Netlist от параметъра Value. 

Щракнете върху OK, за да затворите диалоговия прозорец Sim Model и да се върнете 
към диалоговия прозорец Properties на компонента. Щракнете върху OK, за да затворите 
този диалогов прозорец, готов да завърши поставянето на резистора. 

Използвайки схематичното изображение, показано по-рано като ориентир, пози-
ционирайте резистора и щракнете с левия бутон (или натиснете Enter), за да поставите 
детайла. Ако е необходимо, натиснете интервала, за да завъртите компонента, преди да 
го поставите. 

Друг резистор ще се появи плаващ върху курсора. Тъй като сте определили обоз-
начителя на R1 по време на поставянето, обозначителят автоматично ще се увеличи, ко-
гато щракнете, за да поставите R2, да го поставите и поставите на подходящо място. 

След като поставите двата резистора, щракнете с десния бутон или натиснете Esc, 
за да излезете от режима на разположение на части. 

- Настройване на готови за симулация кондензатори. 
Сега да намерим и поставим двата кондензатора. В библиотеката Miscellaneous 

Devices.IntLib има подходящ кондензатор, който вече трябва да бъде избран като активна 
библиотека в панела „Libraries“. Въведете cap в полето за филтриране в панела Libraries. 

Щракнете двукратно върху Cap в списъка с компоненти, за да започнете процеса на 
поставяне. Преди да поставите, натиснете клавиша Tab, за да редактирате свойствата на 
кондензатора. В раздела Properties на диалоговия прозорец задайте Designator на C1. 
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Редактирайте параметъра Value, за да имате стойност 112pF, и изчистете квадратче-
то Visible. В раздела Properties на диалоговия прозорец кликнете върху полето 
Comment и изберете низа =Value от падащия списък. Активирайте квадратчето Visible 
за полето Comment. Поставете и поставете кондензатора на подходящо място. 

Ще се появи втори кондензатор, плаващ върху курсора, натиснете Tab и променете 
стойността за C2 на 56pF за C2. Ако е необходимо, натиснете интервала, за да завъртите 
компонента, преди да го поставите, след което го поставете на подходящо място. 

Щракнете с десния бутон или натиснете Esc, за да излезете от режима на поставяне. 

- Добавяне на източници на напрежение 
Сега можем да добавим източниците на напрежение, необходими за захранване на 

проекта, когато симулираме. Първо ще поставим VDD източника на захранване. За да 
можете да направите това, трябва да се направи достъпна библиотеката на симулационни 
източници. За да направите библиотеката достъпна, щракнете върху бутона Libraries в 
горната част на панела Libraries, отваряйки диалоговия прозорец Available Libraries. 

Щракнете върху бутона Install, след което прегледайте папката \Library\Simulation. 
Тази папка има редица специални библиотеки за симулация, включително; източници, 
математически функции, PSpice функции и преносни линии. Намерете и изберете 
Simulation Sources.IntLib , за да го добавите към списъка с налични библиотеки, след кое-
то щракнете върху бутона Close в диалоговия прозорец Available Libraries. 

В панела Libraries изберете Simulation Sources.IntLib, така че да е активната библио-
тека, след това прегледайте съдържанието, като спрете на компонента VSRC. 

Щракнете двукратно върху VSRC, за да го поставите, като натиснете Tab , за да ре-
дактирате свойствата му преди поставяне. 

Щракнете двукратно върху SIM модела VSRC в списъка Models в долния десен 
ъгъл на диалоговия прозорец Properties на компонента, ще се отвори диалоговият прозо-
рец Sim Model - Voltage Source/DC Source. 

Проверете дали Model Kind е зададен на Voltage Source, а Model Sub-Kind - DC 
Source. 

Щракнете върху раздела Parameters в диалоговия прозорец, за да настроите необ-
ходимата стойност на напрежението. Въведете 5V в полето Value и активирайте неговата 
опция Component Parameter. Това инструктира Altium Designer да създаде автоматично 
параметър Стой Value  ност за вас в диалоговия прозорец Component Properties. Въведете 0 
(нула) в останалите полета. 

 
Щракнете върху OK, за да 

затворите диалоговия прозорец 
Sim Model. 

В диалоговия прозорец 
Component Properties въведете обоз-
начителя VDD, задайте 
Comment на =Value, активирай-
те квадратчето Visible на комен-
тара и щракнете върху OK, за да 
затворите диалоговия прозорец. 

Щракнете, за да поставите 
този източник на напрежение 
върху схемата, той ще се появи, 
както е показано по-долу. За ин-
формация за източник или друг 
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компонент, поставен от една от специалните библиотеки за симулация, натиснете F1, 
когато курсорът е над компонента. 

 
Следващата задача е да поставите VSS източника на захранва-

не. Използвайте същата последователност от стъпки, за да поставите 
друг VSRC, с изключение на този път параметърът на стойност на 
модела е -5V, а обозначителят е VSS. 

Последният компонент, който трябва да се постави, е източни-
кът на напрежение на синусоидалното напрежение. Това е VSIN 

компонент, който също е достъпен от Simulation Sources.IntLib. Натиснете Tab, за да ре-
дактирате свойствата му, докато той се носи върху курсора, след това щракнете двукратно 
върху симулационния модел, за да отворите диалоговия прозорец Sim Model - Voltage Source 
/ Sinusoidal и превключете към раздела Parameters. 

 
Задайте параметъра Frequency модел на 50kHz и Amplitude на 5, както е показано 

на изображението по-горе. 
Щракнете върху OK, докато диалоговите прозорци се затворят, и щракнете, за да 

поставите този източник на напрежение върху схемата, както е показано в схемата в гор-
ната част на тази страница. 

Щракнете с десния бутон или натиснете Esc, за да излезете от режима на поставяне. 
Запазете вашата схема [shortcut: CTRL + S]. 

- Свързване на схемата. 
Свързването е процес на създаване на връзка между различните компоненти на ва-

шата верига.  
Изберете Place »Wire [shortcut: P, W] или щракнете върху инструмента Wire в лента-

та с инструменти Wiring Tools, за да влезете в режим на поставяне на проводници, както 
е показано на изображението по-долу. 
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Когато приключите, щракнете с десния бутон или натиснете Esc, за да излезете от 

режима за поставяне на проводници. 

- Добавяне на захранващи портове 
Добавете захранващите портове, както е показано на изображението на схемата в 

горната част на тази страница. 
Изберете Place »Power Port [shortcut: P, O], или щракнете върху бутона VCC 

Power Port в лентата с инструменти за свързване, както е показано на изображението по-
долу. 

 
Докато Power Port плава върху курсора, натиснете Tab, за да отворите диалоговия 

прозорец Power Port, след което редактирайте името на Net, като го настроите на VDD. 
Имайте предвид, че стилът може да бъде настроен на различни опции, както е показано 
на изображението по-долу. Първоначално ще се използва стил Bar. Щракнете върху 
OK, за да затворите диалоговия прозорец. 

 
Ако е необходимо, завъртете плаващия Power Port, като натиснете интервала. 
Поставете VDD захранващ порт върху извод 7 на U1 и втори върху горния извод 

на VDD източник. 
Натиснете Tab, за да отворите отново диалоговия прозорец Power Port, като този 

път зададете Net name на VSS. 
Поставете VSS захранващ порт; горната част на източника на VSS, друга на извод 4 

на U1 и друга на долния извод на C2, както е показано на изображението в горната част 
на страницата. 

Натиснете Tab, за да отворите отново диалоговия прозорец Power Port, задайте 
Style на Power Ground и Net name на GND. 

Поставете 3 GND захранващи порта, по един на всеки от долните изводи на ком-
понентите на източника, както е показано на изображението в горната част на страница-
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та. Натиснете Tab, за да отворите отново диалоговия прозорец Power Port, задайте Style 
на Circle и Net name на OUT. 

Поставете OUT захранващия порт на изходния извод на операционния усилвател, 
както е показано на изображението в горната част на страницата. 

Когато приключите с поставянето на захранващите портове, щракнете с десния бу-
тон или натиснете Esc, за да излезете от режима на поставяне, след това запазете схемата. 

- Добавяне на Net Labels  
Последната ни задача преди стартирането на симулация е да поставим възлови ети-

кети в подходящи точки на веригата, за да можем лесно да идентифицираме сигналите, 
които искаме да видим. В представената схема точките на интерес са възлите IN и OUT. 
IN възела се идентифицира с етикет на възел /Net/, докато името на OUT възела съот-
ветства на OUT захранващ порт. 

За да поставите възлови етикети върху необходимите възли, както е показано в схе-
мата трябва да направите следното: 

Изберете Place »Net Label [shortcut: P, N], натиснете Tab и въведете името на Net 
label IN. Щракнете, за да поставите етикета на възела върху проводника между VIN и R1. 
Имайте предвид, че долният ляв ъгъл на правоъгълника за избор на Net Label е електри-
ческата гореща точка, тази точка трябва да докосва връзката. 

Поставете мрежови етикети A и B в схемата, както е показано в примерната схема. 
Те могат да се използват за изследване на функцията на веригата в тези точки. 

Щракнете с десния бутон или натиснете Esc, за да излезете от режима за поставяне 
на Net Label. 

Запазете вашата схема. Запазете и проекта, като щракнете с десния бутон върху 
името на проекта в панела Projects и изберете Save Project. 

- Компилиране на проекта 
Компилирането на проекта прави проверки за грешки при изчертаване и спазване 

на електрически правила в проектните документи. Ще използваме настройките по под-
разбиране в раздела Error Reporting и Connection Matrix в диалоговия прозорец 
„Options for Project“ (Project » Project Option). 

За да компилирате проекта на активния филтър, изберете Project »Compile PCB 
Project. Когато проектът е компилиран, всички генерирани предупреждения и грешки 
ще се покажат в панела Messages. Ако има грешки, проверете схемата си и се уверете, че 
всички връзки са правилни. Имайте предвид, че използването на настройките по под-
разбиране ще доведе до предупреждение No Driving Source, тъй като неинвертиращият 
вход на операционния усилвател има само изводи на пасивни елементи, свързани към 
него. Щракнете двукратно върху предупреждението в панела „Messages“, за да отворите 
панела „Compile Errors“, където можете да кликнете върху всеки извод на свой ред. Като 
проектант трябва да вземете решение как да разрешите предупреждението. 

Поставете конкретна директива No ERC във възела, като инструктирате компила-
тора да игнорира предупреждението Nets with No Driving Source , само на това място. 
Имайте предвид, че има редица стилове на Specific No ERC директиви, които ви позво-
ляват да изберете такъв, който най-добре отговаря на обстоятелството на изключението. 

Преконфигурирайте режима Report Mode с проверка за нарушение на компилато-
ра Nets with No Driving Source  в диалоговия прозорец Options for Project , като го зададе-
те на No Report. 

Редактирайте резистора R1, след това редактирайте изводите и преконфигурирайте 
извода, който се свързва към операционния усилвател, за да бъде изходен Output тип из-
вод. Имайте предвид, че това ще доведе до добавяне на изходен символ към резисторния 
щифт, което може да обърка други, които работят със схемата. 
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Запишете си мислено предупреждението и продължете напред, тъй като знаете, че 
това не е проблем. Запазете схемата и проекта. 

 
4.2. Настройка на анализите 

Altium Designer ви позволява да стартирате масив от симулации директно от схема-
та. В следващите раздели ще симулираме изходните форми на вълната, произведени от 
нашата филтърна верига. 

Симулацията може да се настрои и стартира с помощта на командата от менюто 
Design » Simulate » Mixed Sim или чрез щракване върху съответния бутон в лентата с 
инструменти Mixed Sim. Ако лентата с инструменти не се вижда, изберете View » 
Toolbars » Mixed Sim , за да я покажете. 

Симулаторът се конфигурира и изпълнява от лентата с инструмен-
ти Mixed Sim. При отворен файл Filter.SchDoc в схематичния редактор и 
показаната лента с инструменти Mixed Sim, щракнете върху бутона Setup 

 в лентата с инструменти, за да се покаже страницата Analyses Setup на 
диалоговия прозорец General Setup, както е показано по-долу. Имайте предвид, че ди-
зайнът се компилира първо, за да се генерира списъкът с формат SPICE (.NSX), преди 
да се отвори диалоговият прозорец, панелът Messages ще покаже всички предупреждения 
или грешки, открити в схемата. Ако е необходимо, затворете диалоговия прозорец за 
Analyses Setup, отстранете всички проблеми и след това изберете инструмента за настрой-
ка Setup отново. 

 
Освен общите опции за симулация, диалоговият прозорец за настройка на анализи 

се използва за активиране и конфигуриране на всеки тип симулация. 
Всички опции за симулация са настроени в диалоговия прозорец Analyses Setup, как-

то и типовете симулационни анализи, които трябва да се извършат. Опциите за симула-
ция на General Setup включват: какви данни трябва да бъдат събрани по време на проце-
са на анализ; обхватът на симулацията (схеми към netlist-а); и сигналите, коитода се по-
казват автоматично, когато симулацията завърши (активни сигнали).  

Тези опции се съхраняват във файла на проекта (когато са запазени) и се използват 
при създаването на списъка на SPICE (*.nsx), който се генерира автоматично при стар-
тиране на симулацията. 

Първо ще настроим възлите във веригата, които искаме да наблюдаваме. В падащо-
то меню Collect Data For изберете Voltage Voltage, Supply Current, Device Current и 
Power от списъка. Тази опция определя какъв тип данни искате да се изчисляват по вре-
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ме на изпълнението на симулацията, т.е. запазва данни за напрежението във всеки възел, 
тока във всяко захранване и тока и мощността във всяко устройство. 

Задайте опцията Sheets to Netlist на Active project. 
Задайте опцията за настройка SimView Setup на Show active signals. 
В полето Available Signals щракнете двукратно върху имената на сигналите IN и 

OUT. Когато щракнете двукратно върху всеки от тях, той ще се премести в полето Active 
Signals. Можете също да изберете множество сигнали от списъка Available Signals, като 
щракнете и плъзнете мишката върху списъка със сигнали или използвате клавишите 
SHIFT и CTRL, докато щраквате върху сигнали. След това използвайте бутона>, за да 
преместите сигналите в списъка с активни сигнали Active Signals. Резултатите от симу-
лацията за активни сигнали автоматично се показват в прозореца за показване на време-
диаграмата в резултат на анализа, когато симулацията се изпълни. 

В списъка Analyses/Options активирайте анализ на работната точка - Operating 
Point Analysis, преходен анализ Transient Analysis и анализ за малък сигнал AC Small 
Signal Analysis, както е показано на изображението по-долу. 

 
Всеки отделен тип анализ, посочен в раздела Analyses/Options, е конфигуриран 

на отделна страница в диалоговия прозорец Analyses Setup. Щракнете върху името на ана-
лиза, за да активирате съответната страница за настройка. 

Натиснете F1, когато мишката е над диалога, за да получите помощ относно диало-
га. За да получите конкретна помощ за анализ, изберете необходимия тип анализ, щрак-
нете навсякъде в страната за настройка на анализа в диалоговия прозорец, след което на-
тиснете F1. 

- Настройване на преходен / Фурие анализ 
Преходен / Фурие анализ генерира изход като този, който обикновено се показва 

на осцилоскоп, изчислявайки преходните изходни променливи (напрежение, ток или 
мощност) като функция от времето през зададения от потребителя интервал от време. 

Анализът на работната точка се извършва автоматично преди преходния анализ, за 
да се определи DC пренапрежението на веригата, освен ако не е активирана опцията Use 
Initial Conditions. Ако тази опция е активирана, DC пренапрежението се изчислява от 
първоначалните условия, дефинирани в схемата. Началното състояние може да бъде 
дефинирано за всеки подходящ компонент в схемата или .IC елементи могат да бъдат 
поставени във схемата. 
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За да прегледаме шест цикъла на 50kHz възбуждащо напрежение, ще настроим да 
видим 60u от времедиаграмата. 

Уверете се, че анализът Transient/Fourier Analysis е активиран (маркиран). Щрак-
нете върху името на Transient/Fourier Analysis в списъка Analyses/Options, за да се 
покаже страницата за настройка Transient/Fourier Analysis Setup.  

 
Проверете дали опцията Use Transient Defaults е деактивирана, за да могат пара-

метрите на преходния анализ да бъдат модифицирани. 
За да зададете 60u втори прозорец за симулация, задайте полето Transient Stop Time 

на 60u. 
Задайте Transient Step Time на 100n, което показва, че симулацията изчислява 

точка на всеки 100ns. По време на симулацията действителната стъпка на времето се 
променя автоматично, за да се постигне конвергенция и необходимата точност. 

Полето Maximum Step ограничава вариацията на размера на стъпката от време, за-
дайте Transient Max Step Time на 200 ns. 

- Настройване на анализ по променлив ток AC Small Signal Analysis 
Анализът на променлив ток генерира изход, който показва честотната характерис-

тика на веригата, изчислявайки променливите променлив ток за малък сигнал като фун-
кция на честотата. Желаният изход на анализа с малък сигнал при променлив ток обик-
новено е трансферна функция, напр. усилване по напрежението. 

Схемата трябва да съдържа 
поне един източник на променлив 
ток със стойност, въведена за па-
раметъра AC Magnitude в своя SIM 
модел. Вече сме настроили пара-
метрите на нашия синусоидален 
източник на възбуждане (VSIN), 
за да съдържат стойността, често-
тата и амплитудата на величината 
на променлив ток в секцията 
Adding the Voltage Sources. 

Уверете се, че опцията AC 
Small Signal Analysis е активира-

на. Въведете стойностите на параметрите Parameter Values, както е показано по-горе. 
Когато този анализ се изпълнява, първо се изпълнява анализ на работна точка, за да се 
определи DC преднапрежението на веригата. След това източникът на сигнала се заменя 
с генератор на синусоида с фиксирана амплитуда и веригата се анализира в определения 
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честотен диапазон, като се стъпва на стъпки, дефинирани от стойностите в тестовите 
точки Test Points и полетата Sweep Type. 

- Стартиране на симулацията 
Вече сте готови да стартирате активираните анализи. 
За да стартирате симулацията, щракнете върху бутона Run Mixed Signal 

Simulation  в Mixed Sim toolbar.  
Имайте предвид, че ако сте отворили диалоговия прозорец Analyses Setup , като из-

берете командата от менюто Design » Simulate » Mixed Sim , симулацията се извършва, 
когато щракнете за затваряне на диалоговия прозорец. В противен случай използвайте 
бутона Run в лентата с инструменти. 

Всички предупреждения или грешки, генерирани по време на генерирането на спи-
съка на SPICE или самият процес на симулация, ще бъдат показани в панела Messages. 
Коригирайте грешките, преди да продължите. 

Ако във веригата няма грешки, се създава списък с възли SPICE (* .nsx), който се 
предава на симулационния механизъм на Altium Designer. Имайте предвид, че netlist се 
регенерира всеки път, когато се изпълнява симулация. Симулацията започва и ще се от-
вори файл с данни за симулация (* .sdf). 

 
4.3. Времедиаграми в характерни контролни точки 

Резултатите от всеки анализ са показани като отделна диаграма в прозореца 
Waveform Analysis на SimData Editor. Анализът на работната точка се извършва първо, за 
да се определи DC преднапрежението на веригата. 

Когато симулацията приключи, трябва да видите изходи, подобни на показаните 
по-долу. 

 
Резултатите от симулацията се показват в прозореца Waveform Analysis (SDF), като 

всеки активиран тип анализ се показва в отделен раздел - AC анализът е показан по-горе.  

 
Резултатът от анализа на операционната точка преставлява просто списък на ак-

тивните сигнали и техните стойности.  
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Врецедиаграми от преходния Transient Analysis. 
4.4. Програма за визуализация на изходните резултати. Обобщение на работа-

та с времедиаграми. 

 
Менюто с десен бутон включва команди, използвани за конфигуриране на всеки 

аспект на прозореца за анализ на вълновите форми, стрелките показват какъв аспект ще 
модифицира всяка команда. 

Много е лесно да преконфигурирате формите на вълната в прозореца Waveform 
Analysis. Менюто с десен бутон е чувствително към контекста (показано по-горе), напри-
мер командата Plot Options ще се приложи към Plot под мястото с десен бутон. По съ-
щия начин има различни команди с десен бутон, представени, когато щракнете с десния 
бутон на мишката върху дадена ос по x или y. 

Времедиаграмата може да бъде преместена от един Plot в друг с помощта на щрак-
ване и плъзгане. 
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Например, за да покажете сигналите IN и OUT на една и съща координатна систе-
ма, щракнете и задръжте времедиаграмата OUT в долния Plot на времедиаграмата за ана-
лиз на променлив ток и го плъзнете и пуснете върху горния Plot, както е показано по-
долу. 

 
Щракнете и плъзнете, за да преместите времедиаграмата от един plot в друг. Обър-

нете внимание, че графиките се показват с получер шрифт, за да ги направят по-видими 
на тази страница (Tools » Document Options). 

- Създаване на Bode Plot 
Режимът на дисплея по подразбиране за диаграмата за променлив ток има напре-

жение като линейна величина. Това може 
да се промени, например, за да се покаже 
величината в децибели, както се използва 
в Bode Plot. Графиката на Боде се състои 
от две криви – амплитудата на сигнала 
(усилване) и фаза - като функции на чес-
тотата. Коефициентът на усилване в де-
цибели (dB) и фазата се нанасят по оста Y 
на диаграма, която има няколко цикъла по 
оста X. Всеки цикъл представлява коефи-
циент от десет честоти. 

Първата стъпка е да промените ве-
личината на IN и OUT вълновите форми 
до децибели. Щракнете двукратно върху 
етикета с форма на вълна IN, показан 

вдясно на графиката   за да се отвори 
диалоговия прозорец Edit Waveform. 
 

Изберете Magnitude (dB) от списъка със сложни функции Complex Functions. 
Щракнете върху бутона Create, за да затворите диалоговия прозорец и да покажете 
формата на вълната в dB (net_name), т.е. dB (in), върху графиката. 

 



 
ЛАБОРАТОРНО УПРАЖНЕНИЕ №8   Симулация на работата на електронни схеми                                135 
 

 

Повторете този процес за формата на вълната OUT. 
Празната долна графика ще се използва за показване на фазата. Добавете IN вълна-

та към празния plot, като щракнете с десния бутон върху графиката и изберете Add Wave 
to Plot. 

Ще се отвори диалоговият прозорец Add Wave to Plot, изберете от списъка с 
Waveforms, изберете Phase (Deg) в списъка с комплексни функции и щракнете върху 
Create. Повторете този процес, за да добавите OUT към долния Plot, както е показано 
по-долу. 

 
Тези времедиаграми могат да се показват и на различни оси Y, ако е необходимо. 

Това се прави, когато вълната се добавя към Plot, като се активира опцията Add to new Y 
axis в диалоговия прозорец Add Wave to Plot . За да премахнете новата ос Y, щракнете с 
десния бутон върху оста и изберете Delete Axis. Всички времедиаграми, които са нане-
сени към тази ос, се премахват, както и всички курсори за измерване, прикрепени към 
тези времедиаграма.  

 
Ако е необходимо, могат да бъдат дефинирани множество оси Y. 

- Използване на курсори за измерване. 
Сега можем да определим 3dB точката с помощта на курсорите за измерване.  
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Щракнете с десния бутон върху кривата dB (out) и изберете Курсор А. Поставете 

курсора A в нискочестотната секция, като плъзнете маркера, както е показано по-горе 
(местоположението не е критично, стига да е в нискочестотния регион). 

Щракнете с десния бутон върху кривата dB (out) отново и изберете Cursor B. 
Панелът Sim Data ще бъде използван, за да помогне за намирането на курсора, ако 

той не се вижда, изберете View » Workspace Panels » Editor » Sim Data от менютата, за 
да го покажете. 

Докато гледате стойността на B-A 
Measurement в панела Sim Data, щракнете и плъзне-
те курсора B, за да дадете стойност Y (усилване) на -3. 

Разглеждайки областта за измерване на курсори 
на панела Measurement Cursors, може да се види, че 
резултатът X за Wave Name B е 20.178k, което по-
казва, че точката 3dB на филтърната верига е 20kHz.  

 Използвайте курсорите за четене на информа-
ция от времедиаграмите. 

За да изчистите курсорите, щракнете с десния 
бутон върху всеки маркер на курсора и изберете 
Cursor Off. 

- Изпълнение на параметричен анализ 
Parameter Sweep Analysis 

Друго ценно дизайнерско използване на симу-
латора на верига е извършването на параметричен 
анализ. Това ви позволява да изследвате вариации в 
стойностите на компонентите, без да редактирате 
схемата няколко пъти. При параметричен анализ 
стойността на даден пасивен елемент се променя на 
определени стъпки в рамките на определен диапазон. 
Анализи на променлив ток, постоянен ток или пре-
ходни процеси също трябва да бъдат активирани, за 
да се извърши параметричния анализ, тъй като симу-
латорът извършва множество проходи на всеки акти-
виран анализ. 

Параметричния анализ може да варира стой-
ностите на основните компоненти и параметрите на 

модела, но данните за подсхемата не се променят по време на анализа. 
Кликнете на Filter.SchDoc за да направите схемата активен документ в Altium 

Designer. Кликнете на бутона Setup Mixed-Signal Simulation за да се отвори диалога 
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Analyses Setup. Кликнете на Parameter Sweep в секцията Analyses/Options на диалоговия 
прозорец за да активирате този тип анализ и за да се визуализират настройките на ана-
лиза. Въведете параметрите в полето Primary Sweep Variable. В този пример ще въве-
дем като параметър капацитета на C2, като щракнем 2 пъти на полето Value за да го се-
лектираме от списъка със стойности. 

За да дефинираме област от изменение на стойностите на параметъра капацитет, 
установяваме Primary Start Value на 20p. Установяваме Primary Step Value за да дефи-
нираме стъпка на увеличаване на 10p. 

Установяваме опцията Primary Sweep Type на Relative Values. Това означава, че 
стойностите въведени в полетата Primary Start Value, Primary Stop Value и Primary 
Step Value са съответстващи на съществуващите параметри или на такива по подразби-
ране. 

Кликваме на Enable Secondary за да добавим вторичен параметър, който се изме-
ня. Когато той се дефинира, първичния параметър се изчиства за всяка стойност на вто-
ричния. Установяваме Secondary Sweep Variable за C1[капацитет], за да имаме 
Secondary Start Value на -80p, Secondary Stop Value на  80p, Secondary Step Value на 
80p и  Secondary Sweep Type да бъде Relative Values. 

 
Щракнете върху OK, за да затворите диалоговия прозорец, след което щракнете 

върху бутона Run Mixed-Signal Sim на лентата с инструменти за Mixed SIM, за да стар-
тирате симулацията. Всеки първичен размах се появява като времедиаграма с нотация 
<net_name_p <номер на размах>, например out_p01, в нов plot в раздела AC анализ и 
преходен анализ на прозореца Waveform Analysis. 

Резултатите от преходния анализ ще бъдат показани по подразбиране, превключе-
те към резултатите от AC анализа. 

Щракнете върху името на параметъра, за да се покаже повече информация, напри-
мер щракване върху out_p10 подчертава тази крива и показва sweep информацията под 
графиката. Имайте предвид, че ако задържите курсора на мишката върху име на крива, то 
също ще покаже информацията за размах в подсказката, както е показано по-долу. Мо-
жете също да използвате клавишите със стрелки на клавиатурата, за да преминете през 
поредицата от времедиаграми. 
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Информация за стойността (ите) на изследвания компонент се показва под графи-

ката (ако е избрана кривата) или чрез задържане на курсора. 

- Използване на разширени опции Advanced Options 
Страницата Advanced Options в диалоговия прозорец Analyses Setup съдържа спи-

сък от вътрешни SPICE опции, които могат да бъдат настроени да извършват симулаци-
онни изчисления, като допустими отклонения на грешки и граници на итерации. 

 
За да промените стойността на опция SPICE, щракнете върху една в полето Value, 

за да я изберете, след което тя трябва да е готова за редактиране. 
Пример за това кога може да се наложи да промените Advanced Options може да 

бъде, ако имате дизайн на веригата с неочаквани високочестотни трептения, в този слу-
чай можете да промените стандартния метод на интеграция Integration method от трапе-
цовиден на Gear. Трапецовидният метод е сравнително бърз и точен, но има тенденция 
да колебае при определени условия. Методите Gear изискват по-дълги времена на симу-
лация, но са по-стабилни. Теоретично, колкото по-висок е редът на Gear, толкова по-
точни са резултатите, но времето за симулация се увеличава. 

- Използване на SPICE Netlist за симулация 
Можете също така да извършите симулация директно от списък на SPICE, което ви 

позволява да използвате симулатора Altium Designer заедно с други схематични инстру-
менти. За да бъде възможно това: 
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Включете нетния списък в проект за печатни платки на Altium Designer (.PrjPCB). 
За да се направи; създайте нов проект, след това щракнете с десния бутон на мишката 
върху името на проекта в панела Projects и изберете Add Existing to Project и добавете 
списъка с формат SPICE (ще трябва да промените филтъра на типа файл, за да видите 
.NSX файла). Използването на проект ви позволява да запазвате информация за наст-
ройка между сесиите на симулация, тъй като информацията за настройка се съхранява 
във файла на проекта. Ако списъкът с възли се отвори като свободен документ, инфор-
мацията за настройка не се съхранява между сесиите на симулация. Имайте предвид, че 
проектният файл се добавя автоматично, когато стартирате симулация за първи път от P-
CAD. 

Симулационният механизъм на Altium Designer изисква netlist, който включва ин-
формация за компонентите, свързаност на дизайна и данни за модела, както и информа-
ция за настройката. Ако в netlist-а вече няма информация за настройка на симулация, ко-
гато изберете Simulate » Run от менютата на текстовия редактор, се създава нов списък 
с име на оригинален файл> _tmp.nsx. Този файл съдържа информация за настройка от 
диалоговия прозорец „Simulation Analyses“ (съхранява се във файла на проекта), както и 
информация за нетлиста от оригиналния .nsx файл. 

Ако в нетлиста има информация за типа настройка на симулация, тогава симулаци-
ята се изпълнява директно от netlist списъка. Това е полезно за напреднали потребители, 
които искат да могат да променят настройките директно в нетлиста. Имайте предвид, че 
не можете да добавяте или конфигурирате информация за настройка, като използвате 
диалоговия прозорец Analyses Setup, ако нетлиста вече включва информация за настрой-
ка. Ако в нетлиста няма информация за настройка на симулацията, но в проекта има схе-
матични документи, тогава нетлиста се регенерира от схематичните документи и ин-
формацията за настройка на проекта. Това би се случило само ако сте изтрили инфор-
мацията за настройка от нетлиста и след това сте се опитали да симулирате от нея. 

След като добавите към проект нетлист, който няма информация за настройка, мо-
жете да конфигурирате анализите, като изберете Симулиране »Настройка от менютата на 
текстовия редактор. 

За да стартирате симулация, изберете Simulate » Run от менютата. Формите на си-
мулация ще се покажат в .sdf документ. Преименувайте файла на netlist, за да не бъде за-
менен следващия път, когато стартирате симулация.  

Примерен файл с модел 
По-долу са изходните данни за модел на LF411. С помощта на текстов редактор ко-

пирайте съдържанието от тази страница и го поставете в текстов файл, като го запазите с 
името LF411C.ckt. 

*LF411C 
*Sngl LoOffset LoDrift JFET OpAmp pkg:DIP8 3,2,8,4,6. pkg:CAN8 3,2,8,4,6. 
* 
* Connections: 
*               Non-Inverting Input 
*               | Inverting Input 
*               | | Positive Power Supply 
*               | | | Negative Power Supply 
*               | | | | Output 
*               | | | | | 
.SUBCKT LF411C  1 2 3 4 5 
  C1   11 12 3.498E-12 
  C2    6  7 15E-12 
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  DC    5 53 DX 
  DE   54  5 DX 
  DLP  90 91 DX 
  DLN  92 90 DX 
  DP    4  3 DX 
  BGND 99  0 V=V(3)*.5 + V(4)*.5 
  BB    7 99 I=I(VB)*28.29E6 - I(VC)*30E6 + I(VE)*30E6 + 
+              I(VLP)*30E6 - I(VLN)*30E6 
  GA    6  0 11 12 282.8E-6 
  GCM   0  6 10 99 1.59E-9 
  ISS   3 10 DC 195E-6 
  HLIM 90  0 VLIM 1K 
  J1   11  2 10 JX 
  J2   12  1 10 JX 
  R2    6  9 100E3 
  RD1   4 11 3.536E3 
  RD2   4 12 3.536E3 
  RO1   8  5 50 
  RO2   7 99 25 
  RP    3  4 15E3 
  RSS  10 99 1.026E6 
  VB    9  0 DC 0 
  VC    3 53 DC 2.2 
  VE   54  4 DC 2.2 
  VLIM  7  8 DC 0 
  VLP  91  0 DC 30 
  VLN   0 92 DC 30 
.MODEL DX D(IS=800E-18) 
.MODEL JX PJF(IS=12.5E-12 BETA=250.1E-6 VTO=-1) 
.ENDS LF411C 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №9 

ИЗРАБОТКА НА КОНСТРУКТОРСКА ДОКУМЕНТАЦИЯ С ALTIUM 

DESIGNER 

1. Теоретична обосновка.  

 Конструкторската документация на печатна платка включва следните 

документи [7,9]: 

1. Чертеж сборен на възела – платката с елементите, с означение хххххх.00. 

2. Към чертеж сборен се прибавят всички схеми – в случая принципна 

електрическа схема с означение хххххх.00 Е3 както е според [9]. 

3. Към документацията на възела се включва и Спесификация, която се изготвя 

съгласно стандарта и включва опис на всички документи с техните номера и 

елементите от платката, които са стандартизирани и не е необходимо да се посочва 

чертеж, но е необходимо да се посочи каталог на производител, в който да фигурира 

чертеж на габаритните им размери. 

4. Следват документите свързани със самата печатна платка, като първия от тях 

е Страна елементи. 

5. Следващия документ е Страна спойки, който трябва да даде изглед на 

платката от долната и страна. Тъй като при SMD монтаж може да имаме елементи и 

от тази страна на платката названието на документа е условно. 

6. Последния документ е Страна отвори със стандартна таблица на отворите. 

За разпечатване на документите от конструкторската документация е 

необходимо да се създаде файл от типа *.OutJob в проекта с командата 

File>New>Otput Job File – фиг.9.1. 

 

Фиг.9.1. Конфигурационен прозорец на Final Artwork Prints за разпечатка на 

отделните документи от техническата документация. 
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2. Цел на лабораторното упражнение. 
Да се разработи конструктивна документация на електронен възел на импул-

сното захранване с интегрална схема TOP249, като се използват стандартни фор-
матирани страници и файл за автоматизация на изгледите за печат. 

 

3. Задачи на лабораторното упражнение. 
3.1. Запознаване с принципната електрическа схема. Да се начертае схемата 

на импулсното захранване с TOP249, показана на фиг.9.1, като се използва стан-

дартен формат на чертожната страница, опроводяване и ERC проверка.  

3.2. Създаване на печатна платка в стандартизиран формат. Промяна разме-

рите на платката. Използване на библиотечни елементи с 3D модели. 

3.3. Прехвърляне на схемотехническата информация и разработка на печатна 

платка с използването на Interactive Routing. Използване на стандартизиран фор-

мат на стандартната страница в PCB редактора. Промяна размерите на печатната 

платка. 

3.4. Зареждане и използване на предварително създаден файл за автоматиза-

ция на разпечатването на отделните изгледи на печатната платка от типа *.OutJob 

за изготвяне на конструктивната и документация 

 

4. Указания за изпълнение. 
4.1 Въвеждане на схемата.  

Като примерен проект за разработка на електронен възел е избрана схема на им-

пулсно захранване със специализираната интегрална схема TOP249.  

Схемното решение е базирано на препоръчителното от фирмата-производител, 

представено в техническата документация на интегралната схема от Power Integration 

на сайта: http://www.powerint.com/sites/default/files/PDFFiles/epr11.pdf. 

 

Фиг.9.2. Схема на импулсното захранване с TOP249. 
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Схемата е изпълнена по стандарта ANSI и не отговаря на БДС стандарта за из-

чертаване на символите на електронните елементи – фиг.9.2. За да се въведе схемата 

по БДС е необходимо да се създаде библиотека със символи на елементи, затова по-

надолу ще се изложи съвсем накратко по-важните моменти. 

4.2. Създаване на схемотехнична библиотека в Altium Designer. 

 За илюстрация на начина на създаване на елемент, по надолу са дадени основ-

ните стъпки при създаване на първия библиотечен елемент - мостовия изправител 

RS805. Както се вижда по-долу след създаване на библиотеката TOP249.LibPkg се 

създава нов елемент от Tools/New component. 

 

Фиг.9.3. Меню за създаване на нов компонент. 

 

Фиг.9.4. Задаване име на компонента. 
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Първата стъпка е да се даде име на елемента, в случая е Bridge, защото елемента 

е диоден мост по схема „Грец“ – фиг.9.4, а след което се изчертава и самия елемент с 

помощта на инструментите за чертане от меню Place или от набора инструменти 

означени с .  

 
Фиг.9.5. Създаване на символа на компонента. 

В случая е използван инструмента линия – Place/Line или , като се работи по 

растерната мрежа /Grid/, която предварително е настроена в Tools/Document options – 

metric, след което с натискане на G се избира растер Grid:1 mm. 

Изводите на елемента се поставят с или Place/Pin. Следващата стъпка е да се 

постави подходящ корпус footprint, с бутона  от съществуваща PCB 

библиотека. 
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Фиг.9.6. Поставяне на присъединителни изводи. 

 

Фиг.9.7. Поставяне на подходящ 3D модел. 

Ако няма подходящ корпус се създава нов, като се имат предвид геометричните 

размери на елемента, описани в техническата му документация от фирмата 

производител. Избира се и фирма доставчик от възможните дистрибутори на 

електронни компоненти – фиг.9.9 и 9.10. 
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Фиг.9.8. Търсене на доставчик. 

 

Фиг.9.9. Избиране на доставчик. 

Тъй като избрания доставчик  предлага компонента RS805 под името KBU, 

което е по-разпространено, елемента окончателно се преименува на KBU8J фиг.9.10-

9.11.  
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Фиг.9.10. Избиране на номенклатурен компонент. 

 

Фиг.9.11. Окончателен вид на компонента KBU8J. 

Останалите елементи от библиотеката необходими за проектирането на схемата 

се изчертават по подобен начин. 

4.3. Въвеждане на принципна електрическа схема и изработка на печатна 

платка в Altium Designer. 
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Въвеждането на схемата става като се използва предварително заредената 

библиотека с елементи за схемотехническо проектиране, както е показано на 

фиг.9.12. Елементите се опроводяват с инструмента  или place/wire.  След 

въвеждането на схемата се пристъпва към проектиране на печатната платка. Самото 

проектиране може да се извърши като се използва wizard от панела Files - 

или непосредствено, след което обаче е необходимо ръчно да се 

дефинира очертанието на платката, като се изчертаят границите в слоя keep-out layer, 

а след  това с помощта на Design/Board shape/Define from selected objects да се 

предефинират. След това се връщаме в схемата и изпълняваме командата 

Design/Update PCB или от редактора за проектиране на печатни платки изпълняваме 

 - Фиг. 9.13. В резултат на това се появява прозореца 

Engineering Change order – фиг. 9.14 след което се натиска бутона Validate changes – 

фиг. 9.15.  Протича проверка на чертожните правила, като се индицира в зелено или 

червено при грешка – фиг.9.16.  

 

Фиг.9.12. Схема на импулсното захранване с TOP249 изчертана по БДС. 
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Фиг.9.13. Прехвърляне на информацията за схемата към PCB частта. 

 

Фиг.9.14. Прозорец на Engineering Change order. 

 



 
ЛАБОРАТОРНО УПРАЖНЕНИЕ №9   Изработка на конструкторска документация в Altium designer         150 
 

 

 

Фиг.9.15. Прозорец на Validate changes. 

След края на проверката автоматично се стартира редактора на печатни платки 

като елементите от схемата под фолмата на отпечатъци на корпусите се разполагат 

около очертанията на платката. Ако библиотечните елементи имат и 3D модели се 

получава изгледа от фиг.9.17.  

 

Фиг.9.16. Прозорец от проверката за грешки. 
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Фиг.9.17. Печатна платка и елементи на импулсното захранване с TOP249 в 3D. 

След което елементите се разполагат - фиг. 9.19 и се опроводяват - фиг.9.19. В 

резултат се получава изглед на платката от произволен ъгъл в 3D – фиг.9.20-9.21. 

 

Фиг.9.18. Разполагане на елементи върху печатната платка в 3D. 
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Фиг.9.19. Опроводяване на печатната платка. 

 

Фиг.9.20. Изглед от страна спойки на печатната платка в 3D. 
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Фиг.9.21. Изглед от страна елементи на печатната платка в 3D. 

4.4. Изработка на конструкторска документация в Altium Designer. 

За разработката на конструкторска документация е необходимо да се използват 

предварително изчертаните шаблони, които са заредени в папката Templates -

C:\Users\Public\Documents\Altium\ADXX\Templates за формати A4 и A3, съответно 

A3_ISO.SchDot и A4_ISO.SchDot за схемотехническия редактор и A4 _ISO.PcbDoc, 

A3 _ISO.PcbDoc за редактора на печатни платки. 

 

Фиг.9.22. Изглед от Print preview за разпечатване на схемата. 
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Форматите са достъпни в папката BDS Templates от адреса: 

https://drive.google.com/drive/folders/1-EB9G5Ga6f2NElJrG-

IVHam_Cq9Wx_yy?usp=sharing 

При разработка на документацията на схемата се изпълнява командата File\Print 

preview и се появява прозореца от фиг.9.22. 

Преди самото разпечатване е необходимо да се конфигурира страницата за 

разпечатване като се избира формата на страницата за принтера и разпечатване в 

черно и бяло за по-голяма контрастност на схемата за документиране – фиг.9.23. При 

разпечатване на платката е необходимо предварително тя да се прехвърли в 

стандартния формат с настройки за разпечатване по слоеве. Друга важна особеност е 

да се избере мащабиране еднакво или близко, посочено на чертожния лист от 

подпрозореца Scaling. За да се прехвърли платката в стандартен формат е необходимо 

да се извършат следните стъпки: 

1. Копират се всички обекти от платката, включително олазмеряванията 

направени в слоя Mechanical1 – фиг.9.24 /копирането се извършва през клип борда но 

след командата Edit>Copy или Ctrl+C, трябва да се посочи някой от селектираните 

обекти с показателя на мишката. 

 

Фиг.9.23. Изглед от Page setup  преди разпечатване на схемата. 
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Фиг.9.24. Копиране на завършената платка с оразмерителните линии. 

2. Извиква се стандартната страница A4_ISO.PcbDoc – фиг.9.25 или 

A3_ISO.PcbDoc при по-големи размери на платката. 

 

Фиг.9.25. Изглед на стандартна страница от файла A4 _ISO.PcbDoc. 
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Фиг.9.26. Изглед на платката във файла A4 _ISO.PcbDoc. 

3. Копира се съдържанието на клипборда в стандартната страница с Edit>Paste 

/Ctrl+V/. Тъй като размерите на платката са различни от тези на стандартната 

страница е необходимо предифинирането им. Това става, като се селектира 

очертанието на платката в слоя Keep overlay и се изпълни командата Design>Board 

Shape>Define from selected object. За да остане файла шаблонен с командата 

File>Save as се записва файла с платката в директорията на проекта, след което се 

отваря отново и се вмъква в текущия проект. След което се пристъпва към попълване 

на таблицата на документа с примерната информацията показана на фиг.9.27. 

 

Фиг.9.27. Таблица на документа във файла A4 _ISO ТОР249.PcbDoc. 
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За да се генерират всички необходими документи е необходимо да се направят 

следните настройки в Altium Designer: 

1.Чертеж сборен се генерира от файла с платката като от конфигурационния 

прозорец на Final Artwork Prints – фиг.9.30 се настройва слоя Top Silkscreen Overlay, 

който трябва задължително да съдържа слоевете Top overlay, Keep out layer и 

Mechanical2. 

2. За схема принципна се разпечатва директно схемата със стандартен формат, 

при положение, че са използвани шаблоните A3_ISO.SchDot и A4_ISO.SchDot – 

фиг.9.22. 

3. За генериране на спесификацията се използва командата от схемотехничния 

редактор Report>Bill of material при положение че се зареди като шаблон файла спе-

сификация.xlt. При невъзможност за генериране на документа автоматично, от създа-

дената таблица се копира информацията във файла Specifikazia.doc от директорията 

BDS Template, която съдържа освен споменатите файлове, така и библиотека със 

стандартни елементи и може да се изтегли от moodle.tugab.bg след регистрация в кур-

са „Автоматизация на проектирането в електрониката“. 

4. Страна елементи се генерира от изгледа за Top layer – фиг.9.30, който трябва 

задължително да съдържа слоевете Top layer, Keep out layer и Mechanical4. Трябва да 

се направят отметки върху Holes за да може при ръчно изработване на платката, 

отворите да играят ролята на центрове при разпробиване на заготовката за платката. 

5. Страна спойки се генерира от изгледа за Bottom layer – фиг.9.30, който трябва 

задължително да съдържа слоевете Bottom layer, Keep out layer и Mechanical3. Трябва 

да се направят отметки върху Holes и Mirror, за да се обърне платката огледално за 

коректна изработка на фотошаблоните. 

6. Страна отвори се генерира от изгледа за Drill Drawing – фиг.9.30, който трябва 

задължително да съдържа слоевете Drill Drawing, Keep out layer и Mechanical5. Трябва 

да се има в предвид че съгласно инструкциите Drill Drawing. и .LEGEND автоматично 

се генерира таблица на отворите, която се появява на мястото на гореспоменатите 

инструкции, така че тяхното положение трябва да се съобрази с разположението на 

платката. 

След направените настройки може да се продължи генерирането на документите 

от конструкторската документация по два начина: при положение че нямаме 

инсталиран принтер се генерират *.pdf файлове, които могат да се разпечатат на 

произволен компютър – фиг.9.28 или при положение, че имаме инсталиран принтер, 

документите се пренасочват за разпечатване – фиг. 9.29. Преди самата разпечатка е 

хубаво да се прегледат всички формати чрез Print Preview функцията, както е 

показано на фиг.9.30.  
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Фиг.9.28. Конфигурационен прозорец за генериране на PDF файлове. 

 

 
Фиг.9.29. Конфигурационен прозорец за директен печат. 
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Фиг.9.30. Прозорец Print Preview на Final Artwork Prints. 

 

Новите версии на Altium Designer позволяват и генериране на видеоклип на 3D 

изгледа на платката. За целта трябва да се активира панела 3D Movie Editor System от 

бутона   -  най-отдолу вляво в 

прозореца на PCB редактора или с командата View » Workspace Panels » PCB » PCB 

3D Movie Editor. Задават се отделните части на клипа с изгледи - key frames: 

 
Продължителността на всеки изглед на платката може да се променя, като 

Altium Designer автоматично свързва изгледите при компилиране на видеоклипа – 

фиг.9.31. Предварително се правят настройки за: видеоформат, начин на компресия, 

резолюция, кадри в секунда и др., показани на фиг.9.32. 

 



 
ЛАБОРАТОРНО УПРАЖНЕНИЕ №9   Изработка на конструкторска документация в Altium designer         160 
 

 

 
Фиг.9.31. Прозорец за генериране на видеоклип. 

 

 
 

Фиг.9.32. Прозорец за настройка на видеоклип. 
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ЛАБОРАТОРНО УПРАЖНЕНИЕ №10 

ВРЪЗКА МЕЖДУ ДРУГ ECAD СОФТУЕР И ALTIUM DESIGNER 

1. Теоретична обосновка.  
1.1. Общи сведения за съветника за импортиране Import Wizard. 

Съветникът за импортиране бързо и лесно ще преобразува вашите файлове 

за проектиране от други доставчици във файлове на Altium Designer. Съветникът ви пре-

вежда през процеса на импортиране, като обработва както схемите, така и печатните 

платки на проекта, а също и управлява връзката между тях. 

За да използвате технологиите за импортиране, налични в Altium Designer, трябва 

да инсталирате съответната функционалност като част от самата платформа Altium 

Designer. Основната функционалност за проектиране за вашата инсталация може да бъде 

променена по всяко време след инсталацията и директно от изгледа Extensions & Updates 

(DXP\ Extensions and Updates). От страницата Инсталирани щракнете върху конт-

ролния бутон Конфигуриране в горния десен ъгъл на областта Платформа. По този на-

чин се получава достъп до страницата Configure Platform (Конфигуриране на платфор-

мата), която представя основния набор от функции за софтуера и е идентична по съдър-

жание с тази, която се намира на страницата Select Design Functionality (Избор на функ-

ционалност за проектиране) в инсталатора на Altium Designer. Активирайте необходима-

та функционалност в областта Importers и Export на тази страница. 

1.2. Използване на съветника за импортиране 

Съветникът за импортиране се стартира, като се щракне върху File\Import Wizart от 

главното меню. 

  
Навигация на съветника 

• Щракнете върху Cancel, за да затворите съветника за импортиране. 

• Щракнете върху Back, за да преминете към предишния екран. 

• Щракнете върху Next (Напред), за да преминете към следващия екран. 
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• Щракнете върху Finish (Завърши), за да затворите съветника за импортиране. Та-

зи опция е налична само на последната страница на съветника. 

Избор на типа на файловете за импортиране 

Използвайте тази страница на съветника, за да изберете типовете файлове, които 

искате да импортирате в Altium Designer. Съветникът за импортиране може да се използ-

ва за импортиране на следните типове файлове за проектиране: 

Типове файлове/Описание 

Protel 99SE DDB файлове/99SE DDB (*.ddb) 

Файлове за проектиране Cadence® Allegro®/Allegro binary PCB (*.brd), Allegro 

ASCII PCB (*.alg) 

Проекти и библиотеки на Zuken CADSTAR®/Архив на схеми CADSTAR (*.csa), 

Архив на печатни платки CADSTAR (*.cpa), Библиотека на части CADSTAR (*.lib) 

CircuitMaker 2000 Схеми и библиотеки 

Схемати на CircuitMaker (*.ckt), потребителски библиотеки на CircuitMaker (*.lib), библи-

отеки на устройства на CircuitMaker (*.lib) 

Проекти и библиотеки на Mentor Graphics® DxDesigner®/Проекти на DxDesigner, 

библиотеки на DxDesigner 

Проекти и библиотеки Mentor Graphics® Expedition® Designs and Libraries 

Файлове Mentor Expedition (*.pcb, *.lib). 

Проекти и библиотеки Cadence® OrCAD® Designs and Libraries 

Проекти на OrCAD Capture (*.dsn), документи на OrCAD Layout PCB (*.max), библиоте-

ки на OrCAD Capture (*.olb), библиотеки на OrCAD PCB (*.llb) 

Файлове за конфигурация и библиотеки на Cadence® OrCAD® CIS/ Конфигура-

ционен файл на OrCAD CIS (*.dbc) в двоичен формат, файлове на библиотеки на 

OrCAD (*.llb, *.olb) 

Mentor Graphics® PADS® Layout и PADS® Logic Designs and Libraries/PADS 

Layout ASCII Design files (*.asc), PADS Layout ASCII Decal Libraries (*.d), PADS Logic 

ASCII Design files (*.txt), PADS Logic ASCII CAE Decal Libraries (*.c), PADS Logic ASCII 

Part Type Libraries (*.p) 

Проекти и библиотеки на Cadence® OrCAD® и Mentor Graphics® PADS® 

Файлове OrCAD Capture (*.dsn), файлове OrCAD Schematic Library (*.olb), файлове 

PADS Logic ASCII Design (*.txt), библиотеки PADS Layout ASCII Decal Libraries (*.d), 

библиотеки PADS Logic ASCII CAE Decal Libraries (*.c), библиотеки PADS Logic ASCII 

Part Type Libraries (*.p) 

Проекти и библиотеки на P-CAD 

P-CAD V16 или V17 Бинарни файлове за проектиране на схеми (*.sch), P-CAD V16 или 

V17 ASCII файлове за проектиране на схеми (*.sch), P-CAD V15, V16 или V17 Бинарни 

файлове за проектиране на печатни платки (*.pcb), P-CAD V15, V16 или V17 ASCII 

файлове за проектиране на печатни платки (*.pcb), P-CAD V16 или V17 Бинарни фай-

лове за библиотеки (*.lib), P-CAD V16 или V17 ASCII файлове за библиотеки (*.lia) 

Файлове за проектиране на Autodesk® EAGLE™ - схеми, печатни платки и библи-

отеки EAGLE, записани с EAGLE версия 6.4.0 или по-нова. Тези файлове са във фор-
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мат XML - файловете за проектиране в двоичен формат на EAGLE не могат да бъдат 

импортирани с помощта на EAGLE Importer; те трябва първо да бъдат записани във 

формат XML в EAGLE. 

Файлове за проектиране на Zuken CR5000 

Файлове Zuken CR5000 PCF (*.PCF), файлове Zuken CR5000 FTF (*.FTF), файлове 

Zuken CR5000 EDS (*EDS). Двоичните файлове на Zuken трябва да бъдат конвертирани 

в ASCII файлове преди импортиране. 

Щракнете върху Get More Importers, за да отворите страницата Extensions & 

Updates (Разширения и актуализации), откъдето можете да добавите допълнителни раз-

ширения, ако е необходимо. 

Следващите страници на съветника се променят в зависимост от типа на файла, 

който сте избрали. Намерете вашия тип файл в следния списък и щракнете върху него. 

2. Цел на лабораторното упражнение. 
Да се осъществи импортиране на проекти и библиотеки изготвени с друг 

ECAD софтуер в средата на Altium Designer. 

 

3. Задачи на лабораторното упражнение. 
3.1. Да се запознаят студентите с основните правила при използване на вгра-

дения съветник за импортиране. 

3.2. Да се извърши импортиране на Protel 99SE DDB Files. 

3.3. Да се осъществи импортиране на Orcad Designs and Libraries Files..  

3.4. Да се направи импортиране на проекти и дизайни на EAGLE. 

 

 4. Указания за изпълнение. 
4.1. Запознаване с възможностите на за съветника за импортиране Import 

Wizard. 

Студентите се запознават самостоятелно с основните правила при използване на 

вградения съветник за импортиране. Ръководилят на упражнението предоставя на сту-

дентите предварително файлове и проекти, изготвени с ECAD софтуерните продукти 

Protel 99SE, Orcad и EAGLE. 

4.2. Импортиране на Protel 99SE DDB Files. 

Процесът на импортиране на 99SE DDB изисква всички файлове, проекти и ра-
ботни пространства за проектиране, отворени в момента в Altium Designer, да бъдат зат-
ворени. Ще се отвори диалогов прозорец с искане за потвърждение. 
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Щракнете върху Да, за да затворите всички отворени файлове и проекти; щракнете 

върху Не, за да излезете от съветника. 
Избор на файлове за импортиране.  
Използвайте тази страница на съветника, за да изберете папките 99 SE или файло-

вете, които искате да импортирате. Използвайте бутона Add (Добавяне) в областта 
Folders To Process (Папки за обработка), за да импортирате всички DDB файлове в по-
сочената папка. Използвайте бутона Add (Добавяне) в областта Files To Process (Файлове 
за обработка), за да импортирате отделни DDB файлове. Бутонът Remove (Премахване) 
под двата региона може да се използва за изтриване на избран запис от всеки регион. 

Задаване на опции за извличане на файлове 

 
Тази страница на съветника ви позволява да контролирате начина на извличане на 

файловете. Използвайте иконата Browse Folder (Преглед на папка), за да потърсите и из-
берете местоположението на изходната папка.  Всички файлове ще бъдат извлечени в 
подпапка със същото име като DDB. Използвайте тази страница, за да контролирате на-
чина на преобразуване на схемите.  

Активирайте опцията Convert Schematic documents to current file format (Конверти-
ране на схемните документи в текущия файлов формат), ако искате да се използва теку-
щият формат. Ако тази опция е разрешена, заключените (ръчни) съединения ще бъдат 
импортирани в настоящия си вид. Използвайте следните опции, за да изберете как да 
бъдат импортирани незаключените (автоматични) възли: 

    Lock All Auto-Junctions (Заключване на всички автоматични съединения) - избе-
рете тази опция, за да заключите всички автоматични съединения. 

    Lock X-Cross Junctions Only (Блокиране само на X-Cross възли) - изберете тази 
опция, за да блокирате само X-Cross възли. 



 
ЛАБОРАТОРНО УПРАЖНЕНИЕ №10   Връзка между друг ECAD софтуер и Altium Designer                    165 
 

 

    Convert X-Cross Junctions (Конвертиране на X-Cross възли) - изберете тази оп-
ция, за да конвертирате X-Cross възли. Областта за предварителен преглед вдясно се ак-
туализира динамично в зависимост от избора ви. Заключените кръстовища се показват в 
червено. 

Размер на скосяване (в DXP единици) - Ако е избрана опцията Convert X-Cross 
Junctions (Конвертиране на X-кръстосани съединения), въведете размера на скосяване в 
текстовото поле. 

Задаване на опции за импортиране 

 
Задаване на опции за преобразуване на схеми 

Използвайте опциите за картографиране на проекти на тази страница, за да конт-
ролирате как проектите ще бъдат картографирани във вашите файлове с бази данни. 

    Create one Altium Designer project for each DDB (Създаване на един проект на 
Altium Designer за всеки DDB) - изберете, ако обикновено използвате един DDB за всеки 
проект на платка. 

    Create one Altium Designer project for each DDB Folder (Създаване на един проект 
на Altium Designer за всяка папка DDB) - изберете, ако DDB съдържа повече от един ди-
зайн на платка. 

    Include non-Protel files (such as PDF or Word) in created Projects (Включете фай-
лове, които не са от Protela, например PDF или Word) - изберете, ако искате да включите 
и други типове файлове. 
Избиране на файловете за проектиране, които да импортирате. 

На тази страница на съветника се появява списък на DDB файловете, които Altium 
Designer е намерил в съответствие с вашите настройки за импортиране на предишните 
страници на съветника. Активирайте квадратчетата за отметка на файловете за проекти-
ране, които искате да импортирате. Ако искате да импортирате всички показани файло-
ве, можете също така да щракнете върху Import All (Импортиране на всички), за да пос-
тавите отметка на всички полета. Ако не искате да импортирате нито един от изброените 
файлове, щракнете върху Import None (Импортиране на никакви), за да премахнете от-
метката от всички полета. 
Преглед на структурата на проекта 
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Тази страница на съветника може да се използва за прецизиране на начина на съз-

даване на проектите. Тази страница показва предположенията, които съветникът е нап-
равил за това как трябва да създава проекти въз основа на съдържанието на DDB. Отде-
лете време за конфигуриране на тези опции, за да сте сигурни, че ще постигнете най-
добрия резултат при завършване на процеса на импортиране. Щракнете върху колоната 
Mapping (Картографиране), както е показано на следващото изображение, след което из-
берете от списъка с налични опции, за да промените начина на създаване на избраната 
папка/файл. Опциите включват: 

➢ Да не се създава проект - изберете да не се създава проект. 

➢ Create PCB project (Създаване на проект за печатни платки) - изберете, за да съз-
дадете проект. 

➢ Create Integrated Library package (Създаване на пакет с интегрирана библиотека) - 
изберете, за да създадете пакет с интегрирана библиотека. 

➢ Add files to parent project (Добавяне на файлове към родителския проект) - избе-
рете, за да добавите файловете към родителския проект. 

➢ Add files to all projects in DDB (Добавяне на файлове към всички проекти в DDB) 
- изберете, за да добавите файловете към всички проекти в DDB. 

Щракнете върху колоната Documents to Add (Документи за добавяне), за да избере-
те от списъка с налични документи за добавяне. 

Преглед на резюмето за импортиране 

  
Тази страница на съветника показва обобщение на импорта. Областта Source Files 

(Изходни файлове) показва броя на дизайните DDB, които ще бъдат импортирани. Ре-
гионът Output (Изходни файлове) изброява файловете, които ще бъдат създадени по 
време на процеса на импортиране. Тази страница е полезна, за да се уверите, че сте кон-
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фигурирали правилно настройките за импортиране. Можете да използвате бутона Back 
(Назад), ако са необходими някакви промени. 

Щракнете върху Next (Напред), за да стартирате процеса на импортиране. 
Изберете работното пространство. 
Процесът на импортиране е приключил и можете да изберете дали да отворите 

импортираните дизайни на тази страница. Изберете Open Selected Workspace (Отвори 
избрано работно пространство), след което изберете от изброените дизайни, за да отво-
рите работно пространство. Ако не искате да отваряте импортираните дизайни, изберете 
Don't Open Imported Designs (Не отваряй импортираните дизайни).  

Затваряне на съветника 
Съветникът е завършен успешно. Щракнете върху Завърши, за да затворите. 
99 Файловете SE CAM Manager (*.cam) и Power Print Configuration (*.ppc) не се раз-

познават от Altium Designer, така че изходите ще трябва да се конфигурират отново за 
импортираните проекти. 

  
 

4.3. Импортиране на Orcad Designs and Libraries Files. 

    
Импортиране на дизайни на Orcad 
Щракнете върху Add (Добавяне), за да изберете кои файлове с проекти на OrCAD 

да бъдат включени в процеса на импортиране. Можете да изтриете избран файл, като 
щракнете върху Remove (Премахване). 

Импортиране на библиотеки на Orcad 
Щракнете върху Добавяне, за да изберете кои файлове от библиотеката на OrCAD 

да бъдат включени в процеса на импортиране. Можете да изтриете избран файл, като 
щракнете върху Remove (Премахване). 
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Опции за отчитане 

  
Използвайте страницата Опции за отчитане, за да настроите общи опции за отчи-

тане на дневници.  
В раздел Общи настройки разрешете желаните опции: Log All Errors (Регистриране 

на всички грешки), Log All Warnings (Регистриране на всички предупреждения) и Log All 
Events (Регистриране на всички събития).   
Общи опции на схемите 

Използвайте тази страница на съветника, за да контролирате начина на импорти-
ране на правоъгълници на компоненти на OrCAD. Ако желаете, включете опцията 
Convert Orcad Component Rectangles to Altium Designer Rectangles.  
Опции на листа със схеми 

Използвайте тази страница на съветника, за да контролирате начина на импорти-
ране на страниците на OrCAD. 

Заглавни блокове - Заглавните блокове на OrCAD се импортират като компоненти 
на схемата. В Altium Designer заглавните блокове са ограничени до два типа: Стандартни 
и ANSI и графиките за тях не могат да се редактират. Ако желаете по-гъвкаво решение, 
могат да се използват шаблони. Шаблоните позволяват поставянето на всякакви гра-
фични данни върху схематичен лист. 

    Strip Orcad Title Blocks (Премахване на заглавните блокове на Orcad) - активира 
функцията за премахване на заглавните блокове на OrCAD. 

    Enable AdvSCH Title Blocks (Разрешаване на заглавните блокове AdvSCH) - пос-
тавете отметка, за да разрешите заглавните блокове AdvSCH. Използвайте падащия спи-
сък, за да изберете Standard (Стандартен) или ANSI (ANSI). 

Разстояние между изводите   
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Функцията на OrCAD за разстоянието между щифтовете в момента не е налична в 
Altium Designer. Използвайте следните опции, за да зададете желаното съотношение на 
разстоянието и промяна на размера на листа. 

    Pin-to-Pin Spacing (Разстояние между щифтовете) - въведете желаното съотноше-
ние на разстоянието. 

    Промяна на размера на листа - активирайте, за да промените размера на листа въз 
основа на разстоянието между щифтовете, въведено в горното текстово поле. 

  
Параметри на схемите и опции за свързване на мрежи 

Използвайте тази страница на съветника, за да контролирате начина, по който се 
импортират свойствата и връзките на OrCAD. 

Свойства - Свойствата на OrCAD обикновено се импортират като параметри на 
схемата, с изключение на свойствата на проводниците, които се импортират като тексто-
ве. Автоматично позициониране на параметрите - активирайте функцията за автоматич-
но поставяне на схемните параметри извън пътя след завъртане или други движения. 

 Деактивирайте "Маркиране на ръчни параметри" - ръчно позиционираните пара-
метри ще бъдат маркирани със сини точки. Поставете отметка в това поле, за да деакти-
вирате тази функция. 

Съединения - Двата вида съединения в Altium Designer са ръчни и автоматични съ-
единения. Автоматичните съединения се изчисляват автоматично в зависимост от конст-
рукцията и не могат да се поставят или премахват ръчно. Потребителите обаче могат да 
поставят и премахват ръчни възли и системата няма да се опита да ги премахне, дори ако 
проектът се е променил.  

    Импортиране на Orcad възли - използвайте падащия списък, за да изберете кои 
възли да бъдат импортирани. Изборът включва: Само кръстосани кръстовища и Всички. 
Опции за изходна библиотека 

Използвайте тази страница на съветника, за да контролирате начина на групиране 
на импортираните библиотеки. 

Опции за импортиране на библиотеки - изберете една от следните опции за начи-
на на групиране на изходните библиотеки. 

    Output Libraries as PCB Project (Извеждане на библиотеките като проект за пе-
чатни платки) - изберете, за да намалите до минимум интеграцията между библиотеките 
за печатни платки и схемите. Импортираните библиотеки ще бъдат групирани само като 
проект за печатни платки. Те могат да бъдат добавени към списъка с библиотеки в пане-
ла с библиотеки по-късно. Тази настройка е най-изгодна за тези, които желаят да работят 
в същата среда, както в OrCAD. 

    Output Libraries as Library Packages (Извеждане на библиотеките като библиотеч-
ни пакети) - изберете, за да групирате библиотеките в библиотечни пакети. След това 
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можете да изберете да компилирате библиотечните пакети като интегрирани библиоте-
ки, като включите Compile as Integrated Libraries (Компилиране като интегрирани биб-
лиотеки). Интегрираните библиотеки обединяват библиотеките за печатни платки, схе-
ми и PSpice, което позволява по-добро взаимодействие. Грешките при компилирането се 
показват в панела Messages (Съобщения).  

  
Изходни проекти за печатни платки 

Използвайте тази страница на съветника, за да прегледате структурата на изходния 
проект и да посочите изходната директория, в която да импортирате файловете. Използ-
вайте иконата Browse Folder (Преглед на папка), за да потърсите и изберете изходната 
директория на проекта. 

Всеки проект може да съдържа само един OrCAD DSN файл. 
Щракнете върху Меню, за да получите достъп до опциите за редактиране на струк-

турата на проекта. 
 

    Create Project (Създаване на проект) - щракнете, за да отворите диалоговия прозорец 
Create Project (Създаване на проект), за да добавите проект. 

    Преименуване на проект - щракнете, за да преименувате избрания проект. Тази 
опция е налична само когато е избран *.PrjPcb файл. 

    Remove Selected Projects (Премахване на избрани проекти) - щракнете, за да пре-
махнете избрания проект от структурата PCB Projects (Проекти за печатни платки). 

    Reset Structure to Default (Възстановяване на структурата по подразбиране) - 
щракнете, за да възстановите структурата на PCB Projects по подразбиране. 

    Add Designs to Project (Добавяне на проекти към проекта) - щракнете, за да доба-
вите проект(и) към проекта. Тази опция е налична само когато е избран *.PrjPcb файл. 

    Remove Selected Designs (Премахване на избрани дизайни) - щракнете, за да пре-
махнете избраните файлове с проекти. 
Щракването с десния бутон на мишката в областта PCB Projects (Проекти на печатни 
платки) дава достъп до същите менюта и подменюта, както щракването върху бутона 
Menu (Меню). 
Изходни библиотеки 

Изходната директория за импортираните библиотеки е показана на тази страница 
на съветника. Използвайте иконата Browse Folder (Преглед на папка), за да потърсите и 
изберете желаната изходна директория на библиотеката. 

 
Изпълнение на процеса на импортиране 
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На тази страница на съветника зелена лента за напредъка показва напредъка на 
процеса на импортиране, като също така изписва всеки файл, докато процесът продъл-
жава. 

 
Затваряне на съветника 

Съветникът за импортиране на OrCAD е завършен. Появява се панелът Messages 
(Съобщения) с всички съответни съобщения. Щракнете върху Finish (Завърши), за да 
затворите съветника. Ако по време на процеса на импортиране са били генерирани пре-
дупреждения, се отваря файл *.LOG, в който са показани предупрежденията. 

    
Импортираните OrCAD файлове се превеждат, както следва: 
    Файловете на OrCAD Layout (*.MAX) се превеждат във файлове на Altium 

Designer PCB (*.PcbDoc). 
    Файловете OrCAD Capture (*.DSN) се превеждат към файлове със схеми на 

Altium Designer. Всяка страница в рамките на .DSN файл ще бъде импортирана като 
единичен схематичен файл на Altium Designer (*.SchDoc). Проектните кешове в рамките 
на .DSN файл ще бъдат импортирани като схематична библиотека (*.SchLib). Йерархия-
та на проекта се запазва, включително сложната йерархия. 

    Файловете OrCAD .OLB (схематична библиотека) се преобразуват във файлове 
на схематична библиотека на Altium Designer (*.SchLib). 

    Файловете OrCAD .LLB (библиотека за печатни платки) се преобразуват във 
файлове на библиотеката за печатни платки на Altium Designer (*.PcbLib). 
    Преведените библиотеки на OrCAD се групират автоматично в един проект за печат-
ни платки. 

4.4. Импортиране на проекти и дизайни на EAGLE. 

Импортиране на проектни файлове EAGLE 
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Щракнете върху Add (Добавяне), за да изберете кои архиви за проектиране на 
EAGLE (BRD и/или SCH) да включите в процеса. Можете да изтриете избран файл, ка-
то щракнете върху Remove (Премахване). 
Импортиране на файлове от библиотеката EAGLE 

 
Щракнете върху Add (Добавяне), за да изберете кои библиотечни файлове EAGLE 

(LBR) да включите в процеса. Можете да изтриете избран файл, като щракнете върху 
Remove (Премахване). 

Ще се отвори прозорец за напредъка и ще се затвори бързо, преди да се появи 
следващата страница на съветника. 

Опции за отчитане 
Използвайте страницата Опции за отчети, за да конфигурирате мениджъра на от-

чети. В раздел Общи настройки разрешете желаните опции: Регистрирайте всички 
грешки, Регистрирайте всички предупреждения, Регистрирайте всички събития.   

Настройки на схемата 
Recognize powerports (Разпознаване на захранващи портове) - разрешете, за да раз-

познаете схемните захранващи портове. Уверете се, че стойностите по подразбиране в 
текстовото поле Power port designators (Дизайнери на захранващи портове) са правилни. 
Ако това не е така, въведете правилните обозначения директно в текстовото поле. 

Recognize ports (Разпознаване на портове) - разрешете, за да разпознаете стандарт-
ните портове. Уверете се, че стойностите по подразбиране в текстовото поле Дизайнери 
на портове са правилни. Ако не, въведете правилните обозначения директно в текстово-
то поле. 

Ако захранващите портове във вашите проекти на EAGLE са именувани с формата 
P+?, тогава приемането на настройката по подразбиране за разпознаване на стандартни 
портове (с Port designators (Дизайнери на портове), зададени на PORT?;P+?) ще доведе 
до неправилно преобразуване на тези захранващи портове като стандартни портове, кое-
то ще доведе до къси съединения в електрическата верига. В такъв случай променете нас-
тройката на Port designators на "PORT?". 

Игнориране на шаблони на документи - активирайте, за да игнорирате всички 
шаблони на документи. 

Hide default sheet template (Скриване на шаблона на листа по подразбиране) - раз-
решете, за да скриете шаблона на листа по подразбиране. 

Do not translate hidden net name (Не превеждай скритото име на мрежата) - разре-
шете да не се превеждат скритите имена на мрежи. 

Create bus entry (Създаване на запис на шина) - разрешете да се създаде запис на 
шина. 
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    Настройки на библиотеката  
    Add libraries to PCB project if one exists (Добавяне на библиотеки към проекта за пе-
чатни платки, ако съществува такава) - разрешете да се добавят библиотеки към проекта. 

   
Изпълнение на процеса на импортиране 
Имате пълен контрол върху това къде да бъдат разположени генерираните проекти 

на Altium Designer и свързаните с тях документи, като посочите директорията Output 
Directory. Използвайте иконата Browse Folder (Преглед на папка), за да потърсите и из-
берете желаното място за изходния файл.  

По подразбиране изходната директория ще бъде насочена към местоположението 
на оригиналния изходен проект/библиотечни файлове на EAGLE. 

Предложената Output Structure (Изходна структура) също се показва, така че можете 
да видите точно файловете и структурното дърво, които ще бъдат генерирани. Ако 
всичко е правилно, продължете с импорта, като щракнете върху Next (Напред).  

Изпълнение на процеса на импортиране 
На страницата Изпълнение на процеса на импортиране се показва документът, 

който се обработва в момента, със зелена лента, която показва напредъка на импортира-
нето. 

Затваряне на съветника 
Помощникът за импортиране на EAGLE е завършен. Щракнете върху Finish (За-

върши), за да затворите съветника. 
Импортирани EAGLE файлове: 
Резултатът от импорта може да се види в панела Projects (Проекти) и може да се 

обобщи по следния начин: 

➢ Създава се проект за печатна платка на Altium Designer (*.PrjPcb) за всеки 
EAGLE .sch, .pcb и .lbr, участващ в импорта. 

➢ Архив на схематичен проект EAGLE (*.sch) се импортира в документ на Altium 
Designer Schematic (*.SchDoc). 

➢ Архивът за проектиране на печатни платки EAGLE (*.pcb) се импортира в доку-
мент за печатни платки Altium Designer (*.PcbDoc). 

➢ Библиотека EAGLE (*.lbr) се импортира като библиотечни документи на Altium 
Designer Schematic (*.SchLib) и PCB (*.PcbLib). Освен това на базата на тези изходни 
библиотеки се компилира интегрирана библиотека (*.IntLib). 
    За всеки импортиран файл се генерира Log файл (*.log), който показва резултатите от 
анализа на оригиналния EAGLE файл, както и всички грешки и предупреждения (ако са 
разрешени за включване). 
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